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Welcome | 1

Congratulations on purchasing the Hewlett-Packard Jornada 600 Series
Handheld PC (H/PC), a mobile device powered by the Microsoft® Win-
dows® CE operating system. The HP Jornada 600 Series H/PC is available in
four models: the HP Jornada 680e, 680, 690e, and 690. This User’s Guide
includes instructions for all four models. The differences in specifications
are:

• Model 680e—no built-in modem, 16MB RAM.

• Model 680—built-in modem, 16MB RAM.

• Model 690e—no built-in modem, 32MB RAM.

• Model 690—built-in modem, 32MB RAM.
(Note that on models 690 and 690e, a maximum of 16MB can be allocated
for storage memory.)

If you are familiar with Microsoft Windows products and notebook PCs,
you will notice that your HP Jornada has many of the same characteristics,
making it easy for you to be productive quickly.

In this chapter, you will find:

• An overview of this User’s Guide and other sources of help
and information

• A list and brief descriptions of the built-in applications, including
Microsoft Windows CE, Handheld PC Professional Edition software and
special HP applications

• An introduction to HP Jornada features and a description of the
advantages of using the HP Jornada
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Using this guide
This User’s Guide will give you a quick and effective introduction to your
HP Jornada. Although great care has been taken to ensure the accuracy of
procedures and artwork, some of the screens displayed on your HP Jornada
may differ from the ones that appear in this User’s Guide.

Detailed, step-by-step instructions for using the programs on your
HP Jornada are also included in online Help, so you do not have to carry this
guide when you travel. (For more information on using online Help, see the
Using Help on your HP Jornada section in chapter 2.)

Conventions

This User’s Guide includes certain visual cues that will help you find the
information you want easily.

A shortcut, another way to do something, or expanded
information about the topic.

Caution or warning information about the topic. This is
important information that should be observed to prevent
loss of data or damage to your HP Jornada.

Helpful information related to the topic.

Finding information

This guide describes what is included with your HP Jornada, provides an
overview of the installed programs, and describes how to set up communica-
tions between your device and desktop PC and between your device and the
Internet. The following table lists the different types of information available
to help you use your HP Jornada. Note that although this book introduces the
programs on your device, it does not describe them completely. For more
information, see the comprehensive online Help for each program.
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Information Source

Programs This User�s Guide
�or�
Online Help on your device. On the
Start menu, tap Help.

Unfamiliar The glossary located at the end of
technical terms this User�s Guide.

Synchronizing and This User�s Guide
exchanging files with �or�
a desktop PC Online Help on your device. On the
(including information Start menu, tap Help.
on connecting while �or�
travelling Windows CE Services online Help on your

desktop PC. In the Mobile Devices
window, click Help, and then click
Windows CE Services Help Topics.

ToolTips Any toolbar button. Tap and hold the button
and the button name will appear. (To avoid
activating the toolbar button, drag off the
button before lifting the stylus.) For more
information, see the Using your HP Jornada
section in chapter 2.

Troubleshooting This User�s Guide
information on �or�
connections The Communications Troubleshooter on your

desktop PC. In the Mobile Devices window,
click Help, and then click Communications
Troubleshooter.

Software updates, The Hewlett-Packard Jornada
device drivers, Web site at www.hp.com/jornada.
and lists of com-
patible accessories

Up-to-date The Microsoft Windows CE Web site at
information on www.microsoft.com/windowsce.
Windows
CE�based devices

Information on Readme.doc file (located in the
this release of Windows CE Services folder on your
Windows CE desktop PC).

http://www.hp.com/jornada
http://www.microsoft.com/windowsce
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The complete text of this User�s Guide is available on the HP Web site at www.hp.com/
jornada. You can download the User�s Guide to your desktop PC and view it using the
Adobe� Acrobat Reader, available from the Adobe Web site at www.adobe.com.

Learning about HP Jornada
Hewlett-Packard has taken mobile computing to new levels of compatibility
and convenience. With HP Jornada, you’ll notice many benefits not found in
other, similar computers.  For example you can:

• Move the data you already have on an older palmtop or handheld PC to
your HP Jornada. You can transfer information from older Windows CE
devices and even some non–Windows CE devices. (See the Transferring
PIM data from older palmtop PCs section in chapter 3.)

• Use e-mail without a modem. Conveniently send e-mail automatically when
you synchronize with your desktop PC. (See the Synchronizing data
section in chapter 3.)

• Take more data with you. A desktop Microsoft Word file may take up to 85
percent less space on your HP Jornada. (See the Transferring files
section in chapter 3.)

• Send voice messages to friends and colleagues—even those who do not
have Windows CE devices. You can save voice messages in the compat-
ible Wave audio format.  (See the Recording voice memos section in
chapter 4.)

• Keep Word, Access, and Excel files stored at work and at home synchro-
nized. Update any file in any location, and once you synchronize, the file
will be updated in every place it is stored.  (See the Synchronizing data
section in chapter 3.)

• Read online news and information while offline, or download Web pages
for viewing later.  (See the Browsing the Web section in Chapter 6.)

• Work any time, any place, with up to 7 hours of battery life. (See the
Managing battery power section in chapter 3.)

• Synchronize mail messages, contacts, appointments, and tasks with your
desktop or notebook PC in just a few steps.  (See the Synchronizing data
section in chapter 3.)

• Carry your HP Jornada with you. The HP Jornada weighs only 510 g
(1.1 lb), including batteries.

http://www.hp.com/jornada
http://www.hp.com/jornada
http://www.adobe.com
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• Expand your functionality with PC Card accessories. (See the Accessories
section in chapter 7.)

• Get it all in one package. Your HP Jornada comes complete with a built-in
modem (models 680 and 690 only).

HP Jornada is your mobile computing companion. Several valuable features
allow you to stay organized and in touch while you’re on the road. For
instance:

• The HP Jornada viewer application displays PIM data (contacts, calendar,
and tasks) at a glance, allowing you to navigate to or view the data you
need immediately. You can even view notes attached to appointments.

• The HP Jornada dialup application leads you through the steps required
to configure a dial-up connection and to access your e-mail and the Web.
When you are ready to connect, just use the convenient dialup window
on your HP Jornada desktop.

• The HP Jornada quick pad provides a convenient place to jot down notes,
names, telephone numbers, and other data for short-term storage. Infor-
mation can be saved in quick pad for fast retrieval or sent to the appropri-
ate database for long-term storage.

• The HP Jornada backup application can back up and restore information
to/from an optional CompactFlash Card or PC Card, safeguarding against
loss of data while you are on the road—even if power is lost.

HP Jornada programs

Your HP Jornada already includes the full suite of software that you need to
function as a mobile professional. Detailed information can be found in later
chapters.

The programs listed below are pre-installed in ROM, so you will never need to
reinstall them.

Microsoft Pocket Office

On the Start menu, point to Programs, point to Office, and then tap one of
the following choices.

• Pocket Word—Take notes and compose documents, or transfer Mi-
crosoft Word files from your desktop PC to read and review while you are
away from your office.
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• Pocket Excel—View and edit price lists or financial forecasts on your
HP Jornada, or fill out your expense form before you even land at the
home office.

• Pocket Access—Take database information with you on the road, and fill
in custom forms to update Access databases when you return to your
office.

• Pocket PowerPoint—Create professional presentations on your desktop,
and then take them with you to show on your HP Jornada. Or, use a PC
Card VGA adapter (F1252A) to project them to an external monitor or VGA
projector.

Microsoft Pocket Outlook

On the Start menu, point to Programs, point to Pocket Outlook, and then tap
one of the following choices.

• Calendar—Never miss a meeting. Keep track of important dates and
events or manage your schedule.

• Contacts—Take your address book with you so that you always have
access to names, addresses, and telephone numbers. If you update your
HP Jornada contacts list, just synchronize with your desktop PC and your
contacts will always be up to date.

• Inbox—Send and receive e-mail messages and synchronize your

HP Jornada Inbox with Microsoft Outlook™ or Exchange™ on your
desktop PC partner in a matter of minutes.

• Tasks—Keep track of to-do lists. Set an alarm or a reminder and
HP Jornada will make sure you do not forget a task!

Microsoft Explorers

On the Start menu, point to Programs, and then tap Internet Explorer  or
Windows Explorer. Or, double-tap the Internet Explorer  or My Handheld PC
icons on the desktop.

• Pocket Internet Explorer—Browse the Web from your HP Jornada or
subscribe to channel content with this streamlined version of Microsoft
Internet Explorer 3.0.

• Windows Explorer—Browse the files and folders on your HP Jornada.
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Communication

On the Start menu, point to Programs, point to Communication, and then tap
one of the following choices.

• ActiveSync™—Synchronize your HP Jornada with your desktop or
notebook PC over a network or dial-up connection from a remote location.

• PC Link —Establish the connection between your HP Jornada and
desktop PC partner with a single tap.

• Remote Networking—Connect to a dial-up server, RAS account, or
Internet service provider.

• Terminal—Connect to online services that require VT-100 or TTY
terminal emulation.

• bFAX Pro—Send Word documents or typed notes and receive faxes with
bFAX Pro from bSquare.

Special HP Applications

On the Start menu, point to Programs, point to HP Applications, and then tap
one of the following choices.

• HP viewer—Display Calendar, Task, and Contact information (Pocket
Outlook) in as much detail as you need so that you are always in control
of your schedule. Month View, Week View, and Day View help you
manage your calendar even more efficiently. (HP viewer is also accessible
through a desktop icon and an HP hot key.)

• HP dialup—Configure connections to the Internet and e-mail accounts or
corporate network, and then dial in from a convenient pop-up window on
your HP Jornada desktop. (HP dialup is also accessible through a desktop
icon.)

• HP quick pad—Write simple notes and reminders on this electronic
notepad, and then move the important information to Pocket Outlook or a
Word document.

• HP backup—Protect your valuable data even when you are away from
your office by backing up your Pocket Outlook data or your entire device
to a CompactFlash or PC Card.
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On the Start menu, point to Programs, point to HP Utilities, and then tap one
of the following choices.

• HP settings—Adjust screen controls and sound volume to suit any work
environment. Or, choose from four preset profiles for different environ-
ments, and change all options with the touch of a button.

• HP hot keys—Open programs, files, or folders with a single keystroke.
The HP Jornada hot keys and hard icons are fully customizable, so you
can configure them for one-touch access to your favorite programs or
frequently used documents.

• HP macro—Automate common tasks using a powerful scripting lan-
guage. HP Macro allows you to create a set of recorded commands and
actions that you can repeat or play back by pressing a specific key
combination.

Accessories

On the Start menu, point to Accessories, and then tap one of the following
choices.

• Microsoft InkWriter ®—Jot quick notes or create sketches while in a
meeting.

• Microsoft Voice Recorder—Record voice memos or vital information.

• Calculator—Perform simple calculations in an on-screen calculator, and
then copy the results to any open document.

• World Clock —Keep track of the time anywhere in the world and display
useful travel information for both your home city and the city you are
visiting.

• bFIND®—Search for a word or text string in any database, file, file name,
or e-mail message stored on your HP Jornada.

• OmniSolve®—Perform complex mathematical and business calculations
with this full-featured calculator from Landware.

Games

• Solitaire—Pass the time at the airport, on the train, or during a not-so-
interesting meeting or lecture with this classic game.
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This section will help you start using your Hewlett-Packard Jornada 600
Series Handheld PC (H/PC). You will learn how to set up your HP Jornada,
discover how to customize the Microsoft Windows CE operating system to
work for you, and you will have a brief introduction to Windows CE. When
you have finished this chapter, you will have all the information you need to
begin working with your HP Jornada.

This chapter includes step-by-step instructions to help you:

• Identify the hardware features of your HP Jornada

• Install the main batteries

• Connect the AC adapter

• Activate the backup battery

• Run the Windows CE Welcome Wizard

• Put your HP Jornada to work for you
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HP Jornada hardware features
The views below will introduce you to the various connectors, ports, and
other features of your HP Jornada.

• Stylus and stylus slot—Keeps your stylus within easy reach. (For more
information, see the Using the stylus and touch screen section in this
chapter.)

• Appointment notification LED —Notifies you of scheduled appointments,
alarms, and reminders. (For more information on setting alarms and
reminders, see the Using Microsoft Pocket Outlook section in chapter 4.)

• Recording LED—Indicates that Voice Recorder is recording or playing a
voice memo.

• Audio buttons—Enable you to record and play voice memos without even
opening your HP Jornada. (For more information, see the Recording voice
memos section in chapter 4.)

• Telephone connector (RJ-11)—Enables you to connect a telephone line
to the built-in modem (models 680 and 690 only), keeping you in touch
with the world. (For more information, see the Connecting the telephone
line section in chapter 6.)

• DC jack and AC power adapter—Connect your HP Jornada to AC power
anywhere in the world to charge the main battery or to connect to your
desktop PC.

• Battery charging LED—Indicates the charging status of the main battery
while connected to AC power.
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• HP hard icons—Scroll through documents, switch applications, or open
programs and files with the touch of a button. (See the Customizing the
HP hot keys and hard icons section in chapter 7.)

• Microphone—Allows you to record voice memos.

• Reset button—Quickly reinitializes the Windows CE operating system.
(Warning: When you reset your HP Jornada, you will lose all unsaved
data in any open documents. See the Resetting section in chapter 8.)

• Keyboard—Allows easy entry of extended and international characters
and includes an embedded numeric keypad.

• HP hot keys—Allow one-touch access to your favorite programs, folders,
documents, or frequently used settings. (See the Customizing the HP hot
keys and hard icons section in chapter 7.)

• Infrared port (SIR IrDA–compliant transceiver) —Enables you to send
and receive files by infrared beam between your HP Jornada and another
HP Jornada or palmtop PC, or between your HP Jornada and an infrared-
equipped printer or desktop PC.  (For more information, see the Connect-
ing by infrared  section in chapter 3 and the Infrared transfer  section in
chapter 8.)

• Stabilizer—Stabilizes the unit when the expansion module is extended
(while a PC Card is installed).

• CompactFlash Type I card slot—Enables you to add storage memory or
use accessories on CompactFlash cards. (For more information, see the
Using PC Cards and CompactFlash Cards section in chapter 7. For a list
of recommended accessory cards, go to the HP Web site at
www.hp.com/jornada.)

http://www.hp.com/jornada
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• PC Card Type II card slot—Enables you to use PC Cards (also called
PCMCIA Cards) to expand memory, connect to an external monitor, or add
other functionality to your HP Jornada. For information on how to use PC
Card accessories, see the Using PC Cards and CompactFlash Cards
section in chapter 7. (For a list of recommended PC Cards, go to the
Hewlett-Packard Web site at www.hp.com/jornada.)

• PC Card release tab—Ejects a PC Card from the slot.

• Backup Battery Compartment—Holds a 3-V CR2032 coin-cell backup
battery. (For information on replacing the backup battery, see chapter 7.)

• Audio speaker—Plays system sounds or voice memos.

• Security cable slot—Allows you to keep your HP Jornada safe with the
connection of an optional thin-wire security cable.

• Serial port (RS-232C)—Connect your HP Jornada to your desktop PC
to transfer files or synchronize Pocket Outlook data, or connect your
HP Jornada directly to a printer, external modem, or other device. (For
more information, see the Connecting for the first time section in
chapter 3.)

Setting up your HP Jornada
Follow the steps in this section to start using your HP Jornada for the first
time. As part of the setup process, you will install the main battery, activate
the backup battery, turn on the device, and complete the Windows CE
Welcome Wizard. To set up your HP Jornada, you will need to have your
HP Jornada, the HP Jornada Standard Battery, the AC adapter, and the power
cable.

Follow these steps in the order they are presented. Do not activate the backup battery
before installing and charging the main battery.

http://www.hp.com/jornada
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Installing the main battery

The HP Jornada Standard Battery provides power to your HP Jornada while
it is not connected to AC power. Under normal operating conditions, the
battery should provide power for up to 7 hours; however, battery life will
vary depending on how you use your HP Jornada.

The main battery fits into the bottom of your HP Jornada, as shown in the
following diagram.

This bottom view of the HP Jornada shows how to
install the main battery.

To install the main battery

1. Place the main battery in the battery slot on the bottom of your
HP Jornada and push firmly until it snaps into place.

After you install the main battery, your HP Jornada will turn on automatically. However,
you should connect the AC adapter and activate the backup battery before using your
device.

The main battery should be partially charged when removed from the box.
However, you should charge the main battery fully before operating your
HP Jornada on battery power. Charging the main battery takes approximately
3.5 hours. When the battery is fully charged, charging stops automatically;
the battery will not overcharge if left connected to AC power.
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Do not mutilate, puncture, or dispose of batteries in fire. The batteries can burst or
explode, releasing hazardous chemicals. Replace batteries only with the types
recommended in this User�s Guide. Discard used batteries according to the manufacturer�s
instructions.

Connecting the AC adapter

To avoid running out of battery power, you can operate your HP Jornada on
AC power using the supplied AC adapter. The AC adapter accepts 100 to
240 V, enabling you to connect to AC power anywhere in the world. When
you travel, you may need adapters to accommodate different electrical
outlets, but the HP Jornada AC adapter will safely convert AC line voltage to
the DC voltage required by your HP Jornada.

Use only the supplied AC adapter (model HP F1279A, input specifications
100-240 V AC, 50-60 Hz, 1.4 A).

While your HP Jornada is connected to AC power, the main battery is
charged automatically. The color of the LED indicates the status of the
battery: red indicates that battery is charging, and green indicates that the
battery is charged to full power.

The AC adapter includes two parts:
the power cable and the adapter.
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To connect to AC power

1. Connect the cable from the AC adapter to the DC jack on the right
side of your HP Jornada.

2. Connect the power cable to the AC adapter.

3. Plug the power cable into an AC power outlet.

Activating the backup battery

The backup battery protects your data when the main battery runs out of
power. The backup battery does not provide enough power to operate your
HP Jornada, but it will preserve your data while you replace the main battery
or while you connect to AC power to recharge. The  3-V CR2032 coin-cell
backup battery is preinstalled. When you begin using your HP Jornada, you
do not need to remove the cover plate or install the backup battery—simply
activate the backup battery by using the following procedure.

To prevent loss of data, replace the backup battery as soon as a warning message
appears on your screen indicating that backup battery power is low. (For detailed
instructions on replacing the backup battery, see the Managing battery power
section in chapter 7.)

To activate the backup battery

1. Remove the yellow sticker from the bottom of your HP Jornada.

2. Pull out the tape that protrudes from the battery compartment.

Using the stylus and touch screen

Use the stylus in much the same way you would use a mouse to navigate
and select objects on screen. You can also use your fingertip to tap the touch
screen, but the stylus provides the greatest accuracy.

For convenience, the stylus is stored in the stylus slot on the front of the
HP Jornada. To remove the stylus, push on the stylus to release the catch as
you slide it out of the slot.

The top of the stylus pops up to make it easy to remove the stylus. Pressing the top has no
effect on the stylus function.
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To navigate by using the stylus, follow these tips:

• Instead of clicking the mouse, simply tap the stylus on the touch screen
to select an icon or activate a button.

• Double-tap instead of double-clicking the mouse.

• Hold down the alt   key as you tap instead of right-clicking the mouse.

To replace the stylus, insert the pointed end of the stylus into the slot and
push until it clicks into place.

Following the Welcome Wizard

After you install the main battery, your HP Jornada will turn on automatically.
At startup, the Hewlett-Packard welcome screen appears. Then, after a few
moments, the Windows CE Welcome Wizard begins. The Welcome Wizard
presents a brief orientation that helps you to calibrate the touch screen and
configure device settings such as the World Clock and Owner Identification.

Before you begin working, you may need to adjust the brightness and
contrast of the display to compensate for different lighting conditions and
viewing angles. You can use the keyboard to adjust both contrast and
brightness.

To adjust screen brightness and contrast

1. To adjust the contrast, hold down the alt  key as you press  or  .

2. To adjust the brightness, hold down the alt  key as you
press  or  .

To maximize battery life, minimize the brightness setting and then adjust contrast to
achieve readability.

The following sections describe the Welcome Wizard. To complete the
Welcome Wizard, follow the instructions displayed in the taskbar area at the
bottom of your screen. After you complete the Welcome Wizard, you can
begin using your HP Jornada.
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If your HP Jornada freezes during operation, you may need to perform a soft reset. To
reset, use the stylus to press the reset button located on the left side of the HP Jornada
keyboard. Your HP Jornada will restart automatically. Unsaved data in any open
documents will be lost. For more information, see the Resetting section in chapter 8.

Calibrating the touch screen

Before you can use the stylus to navigate, you must calibrate the touch
screen to align the image on the screen with the touch-sensitive coating. The
first screen of the Welcome Wizard prompts you to calibrate the touch screen
by tapping a series of targets at different locations on the screen.

From time to time, you might notice that the accuracy of your stylus tap
diminishes. When this happens, you can return to this screen to calibrate
your touch screen.

To calibrate the touch screen

1. On the Start menu, point to Settings, tap Control  Panel, and then
double-tap the Stylus icon.
–or–
Press num lk

ctrl  alt  

You can also use the Stylus control panel to set options for double-tap rate
and physical distance between taps.
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Selecting your Home City

Windows CE displays current time and regional information for the city you
designate as your “Home City.” Tap the city nearest your home from the
drop-down list on the Home City tab. If your city is not listed, you can use
the World Clock control panel to add it later. (See the World Clock  topic in
online Help.)

Setting the World Clock

Windows CE uses the system clock to monitor your alarms and appoint-
ments as well as to ensure proper synchronization of the most current files
and appointments with your desktop PC. So make sure you set the correct
time and date. To set the time, type the current time in the box below the
clock face, or drag the hands on one of the clocks to the correct time. To set
the date, tap the current date on the calendar. (Tap  or  to change
month or tap the month or year.)

You can set the clock settings again later using the World Clock control
panel. (See the World Clock  topic in online Help or tap the clock in the
status area of the taskbar.)
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Adding owner information

You can set Windows CE to display owner information, such as your name,
address, and telephone number. You can also type a note to be displayed; for
example, offering a reward for the safe return of your HP Jornada. To display
your owner information each time you start your HP Jornada, select the
Display Owner Identification check box under At Power On.

You can change the information you type here at any time using the Owner
control panel. (See the Settings topic in online Help.)

Configure the built-in modem

Your HP Jornada and the built-in modem (models 680 and 690 only) are
designed to meet the regulatory requirements within the country of purchase
only. To use the modem, you must first set the modem configuration using
the HP country selector application.

The HP country selector starts automatically after you have completed the
Welcome Wizard. (You can also start this application at any time by double-
tapping the HP country selector icon in the Control Panel.)

In the HP country selector application, select the country where you pur-
chased your HP Jornada. Do not select another country, and do not use the
HP Jornada built-in modem in a country other than the country of purchase.
If you travel to another country, it is recommended that you use a PC Card
modem that has been approved for use in that country to ensure that the
regulatory requirements are met. For a list of approved PC Card modems, go
to the HP Jornada Accessories page on the Hewlett-Packard Web site at
www.hp.com/jornada.

http://www.hp.com/jornada


20  |  HP Jornada 600 Series User�s Guide

Using your HP Jornada
After you complete the Welcome Wizard, you can begin using your
HP Jornada and its built-in programs.

Welcome to Microsoft Windows CE

Congratulations on purchasing a mobile device powered by the Microsoft
Windows CE operating system. The size and capabilities of your HP Jornada
let you keep your most important business and personal information up to
date and close at hand. Windows CE Services with ActiveSync™ increases
the power of your HP Jornada by letting you synchronize the information on
your desktop or notebook PC with your device.

Using the Start menu and Taskbar

Use the Start menu to open settings, online Help, recently used documents,
and programs such as the HP Applications. Just tap Start, and then tap the
program or item you want to open. In addition to the Start menu, the taskbar
contains buttons for the programs you have running, a status area, and a
desktop icon.

Using the command bars

Each program has a command bar located at the top of the program window.
The command bar displays both menu names and toolbar buttons. Tap the
slider and drag to switch between displaying toolbar buttons only or menu
names and toolbar buttons. You can drag the slider to display only the
buttons and menu names you want. You can also drag the slider down to
move the toolbar buttons under the menus.
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Using Help on your HP Jornada

You can get Help for specific programs, including Windows CE, as follows:

• For detailed procedures and overview information about a program, on
the Start menu, tap Help, and then tap the program name.

• For Windows CE Help, tap the  button in any program or dialog box
where it appears.

• To learn the function of a specific button or control, tap and hold on a
toolbar button and its name will appear in a ToolTip. Drag the stylus off
the toolbar button before lifting to avoid activating the button.

Online Help uses the same font setting as Pocket Internet Explorer. Changing the font size
in Pocket Internet Explorer will also change the font size in Help.

Turning your HP Jornada on and off

One of the most convenient features of Windows CE and HP Jornada is
“instant on.” With instant on, there is no waiting for HP Jornada to start up
or shut down; you can start working immediately by pressing the On/Off key
on the upper right corner of the keyboard. When you are finished, turn off
your HP Jornada by pressing the On/Off key or by tapping Suspend on the
Start menu. Turning off your HP Jornada simply suspends operation. When
you turn it on again, you can resume working.

You can also set options in the Power control panel to turn your HP Jornada
on and off automatically. For example, you can set your HP Jornada to turn
on when you tap the touch screen or when you open the cover. To conserve
battery power, you can set HP Jornada to auto-suspend or to turn itself off
after a preset period of continuous idle time. By default, your HP Jornada will
auto-suspend after 3 minutes while running on battery power. (For more
information on these options and tips for conserving battery power, see the
Managing battery power section in chapter 7.)
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Using the HP Jornada keyboard

To provide full functionality in a smaller size, the HP Jornada keyboard lets
you accomplish common tasks with a few convenient key combinations:

• To turn the caps lock on or off, press and hold the Fn/AltGr key as you
press the left caps lk

shift  key. While caps lock is on, the  symbol appears in the
status area of the taskbar.

• To activate (or deactivate) the numeric keypad, press and hold the Fn/
AltGr key as you press the num lk

ctrl  key. While the numeric keypad is acti-
vated, the  symbol appears in the status area of the taskbar.

Be sure the numeric keypad is deactivated while you set your password and before you
turn off your HP Jornada.

• To type accented or international characters, press and hold the Fn/AltGr
key as you press the key combination corresponding to the character
(international versions only). International versions of the HP Jornada
have slightly different keyboard layouts.

• To generate extended characters or keyboard commands, hold down the
Fn/AltGr key or alt  as you press a key. Holding down the Fn/AltGr key
will activate the character or command printed in black, while pressing alt

will activate the character or command printed in yellow.

You can also use the Keyboard control panel to adjust how quickly characters repeat when
you hold down a key. To open the Keyboard control panel, press K .

Using HP Jornada settings

The HP Jornada settings application gives you access to many useful
controls. Use the HP Jornada settings control panel to:

• Adjust your screen brightness and contrast in different lighting conditions

• Adjust speaker volume or quickly mute all sounds

• Check the remaining battery power

• Check the amount of system memory available

• Activate the password delay timer
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HP Jornada settings also enable you to save your preferred sound, contrast,
and brightness settings in a custom profile, so you can change all your
options with a single tap.

To open HP settings

1. On the Start menu, point to Programs, point to HP Utilities, and
then tap HP settings.
–or–
Tap the HP Jornada settings hard icon on the left side of the screen.

For more information about the HP Jornada settings application, refer to the
Using the HP settings application section in chapter 7 or the HP settings
topic in online Help.

Using the audio buttons

The audio buttons on the front of your HP Jornada enable you to record and
play voice memos without even opening the cover. For more information on
recording voice memos, see the Recording and playing voice memos section
in chapter 4.

The red recording LED indicates that your HP Jornada is recording. Simply
speak into the microphone to record your notes.

When you use the audio buttons to play or record voice memos, your
HP Jornada will turn on. The device will turn off automatically (auto-
suspend) according to the options you set in the Power control panel
(the default time is 3 minutes).
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Connecting to your | 3

Your HP Jornada 600 Series Handheld PC works perfectly as a standalone
computer. But to get the most out of your HP Jornada, you will want to connect
to your desktop or notebook PC. This chapter describes how to establish a
connection between your HP Jornada and a desktop PC, and how to use your
HP Jornada with a desktop PC—or with any PC that has Microsoft Windows CE
Services installed. You will learn to:

• Connect to your desktop PC

• Set up Windows CE Services

• Establish a partnership between your HP Jornada and your desktop PC

• Use Windows CE Services to browse the contents of your HP Jornada

• Synchronize Microsoft Pocket Outlook data and e-mail messages with
Microsoft Outlook or Schedule+ and Exchange

• Transfer files between your HP Jornada and a desktop PC

• Connect to and transfer files between your HP Jornada and a corporate
network or home desktop PC over the Internet or by telephone line

Connecting for the first time
You can connect your HP Jornada to a desktop PC using a serial connection
(with either the docking cradle or the sync cable) or a network connection (with
an optional PC Card network interface card), or you can connect to an infrared-
equipped desktop or notebook PC (using the infrared port). Before you connect,
you must install Windows CE Services on the desktop PC. Then, you can
connect your HP Jornada and establish a partnership.

desktop PC
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Setting up Windows CE Services and establishing
a partnership

Microsoft Windows CE Services with ActiveSync enables you to synchronize
the information on your desktop PC with the information on your HP Jornada.
Synchronization compares the data on your device with your desktop PC and
updates both computers with the most recent information. For example:

• Keep your Pocket Outlook data current by synchronizing your
HP Jornada with your choice of Microsoft Outlook, Microsoft Schedule+,
or Microsoft Exchange on your desktop PC.  (Inbox synchronization with
Schedule+ and Outlook Express are not currently supported.)

• Synchronize Word and Excel documents, Access and other ODBC
databases and tables, Mobile channels, and InkWriter documents
between your HP Jornada and desktop PC. Your files are automatically
converted to the correct format.

With Windows CE Services, you can:

• Back up and restore your HP Jornada data

• Add and remove programs on your HP Jornada

• Move and copy files (rather than synchronize files) between your device
and your desktop PC

Windows CE Services includes several components. The Windows CE
Services Setup Wizard detects which software components are needed and
prompts you to set up only the necessary components. For instance:

• If you do not already have Outlook or Schedule+ installed, the Setup
Wizard will attempt to install Schedule+ version 7.0a

• The Setup Wizard can add Inbox extensions to enable you to transfer
messages to your desktop mail client—Exchange or Outlook

You may need to restart your PC after installing each component.
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The Desktop Software for Microsoft Windows CE compact disc includes the
following software options for your desktop PC.

• Windows CE Services—Enables you to connect your HP Jornada to a
desktop or notebook PC running Windows 95 or Windows NT.

• Microsoft Exchange Update—Adds an option to the Tools menu in
Exchange, allowing you to synchronize your HP Jornada Inbox with your
Windows Inbox.

• Microsoft Schedule+ 7.0a—A schedule management program for Win-
dows 95 or NT.

• Ethernet Components—Network drivers for Windows CE.

• Microsoft Pocket Streets—A maps-and-navigation program for
Windows CE.

• Mobile Channels Viewer—A Web content viewer that enables you to
view Web content from selected sites while you are offline.

• Windows 95 infrared drivers version 2.0—Enables you to install an
infrared port on a desktop PC.

• Windows 95 Dial-Up Networking version 1.2 upgrade—Enables you to
establish a remote connection to your desktop PC by modem.

• Microsoft Internet Explorer version 4.01—The most recent version of
the Internet browser for Windows 95 or Windows NT from Microsoft.

• Windows NT Service Pack 3—System updates for Windows NT.



28  |  HP Jornada 600 Series User�s Guide

There are many Windows CE programs available, including freeware and shareware. Go to
www.microsoft.com/windowsce, or try searching the Web on the keyword �Windows CE� to
find additional programs for your HP Jornada. Be sure to install only programs that are
compiled for SH3 processors.

Installing Windows CE Services

The minimum PC requirements for running Windows CE Services are as
follows:

• Desktop PC with a 486/33DX or higher processor (Pentium® P90 recom-
mended)

• Microsoft Windows NT Workstation 4.0 or Windows 95 (or later)

• 8 MB of memory (12 MB recommended) for Windows 95 (or later), and 16
MB of memory (32 MB recommended) for Windows NT Workstation

• Hard disk drive with 10 to 50 MB of available hard disk space (actual
requirements will vary, based on selection of features and current system
configuration)

• Available 9-pin serial communications port

• CD-ROM drive

• VGA or higher resolution graphics card (SVGA 256-color recommended)

To install Windows CE Services

1. Insert the Desktop Software for Microsoft Windows CE compact
disc into the CD-ROM drive on your desktop PC.

2. The Windows CE Services Setup Wizard should start automatically.
If it does not start, click Run on the Start menu, and then type
d:\setup, where d is the letter assigned to your CD-ROM drive.

3. Follow the instructions that appear on your screen to set up Win-
dows CE Services, and then restart your desktop PC.

4. After you restart your PC, the Windows CE Services Get Connected
dialog box appears, prompting you to connect your HP Jornada.

•  If you connect using the docking cradle or sync cable, connect
your device as described in the next section, Connecting by serial
connection, and then click Start.

•  If you connect by infrared, click Cancel, and then skip to the
section Connecting by infrared, later in this chapter.

http://www.microsoft.com/windowsce
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Connecting by serial connection

The HP Jornada uses a serial connection to communicate with a desktop PC.
Use the sync cable that was included with your HP Jornada to connect the
docking cradle or the device to a 9-pin serial communications port on your
desktop PC. If the 9-pin serial port on your PC is in use by another device, or
if your computer has no 9-pin serial port, you can obtain an adapter from your
computer’s manufacturer.

Be sure that your desktop PC is on before placing your HP Jornada in the docking cradle
or connecting the sync cable. If the desktop PC is off, your HP Jornada or desktop PC may
freeze, forcing you to reset or restart. For information on resetting your HP Jornada, see
the Resetting section in chapter 8.

To connect using the docking cradle

1. Connect the 9-pin end of the sync cable to a serial port on your
desktop PC.

2. Fully insert the flat end of the sync cable, arrow side up, into the
serial port on the back of the docking cradle.

3. Turn off your HP Jornada and disconnect any cables (telephone
cable, AC adapter, sync cable, etc.) from your HP Jornada.

4. Connect the AC adapter to the DC jack on the back of the docking
cradle, and then plug in the power cable.

Do not connect your HP Jornada to more than one source of AC power. You must disconnect
the AC adapter from your HP Jornada before placing in it in the docking cradle to avoid
damaging your HP Jornada.

5. Align your HP Jornada in the docking cradle, and push down firmly
until the HP Jornada snaps into place.

Your HP Jornada should start automatically and establish a connection to the
desktop computer. To remove your HP Jornada from the docking cradle, push
the release button on the cradle, and carefully lift your HP Jornada from the
cradle.



30  |  HP Jornada 600 Series User�s Guide

If you are traveling without your docking cradle or you need to synchronize
files with your home computer while the docking cradle is connected to your
office PC, you can connect your HP Jornada directly to a desktop PC using
only the sync cable. (You can also connect and synchronize by infrared. For
more information, see the Connecting by infrared section in this chapter.)

To connect directly (without the docking cradle)

1. If it is attached, disconnect the telephone cable from your
HP Jornada.

2. Connect the AC adapter to the DC jack on the right side of the
HP Jornada, and then plug in the power cable.

3. Insert the 9-pin end of the sync cable into a serial port on your
desktop PC.

4. Fully insert the flat end of the sync cable, arrow side up, into the
serial port on your HP Jornada.
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Establishing a partnership

After you set up Windows CE Services on your desktop PC, you are
prompted to establish a partnership between your desktop PC and your
HP Jornada. The partnership enables your desktop PC to recognize your
HP Jornada when transferring files or synchronizing data.

You can establish partnerships between your HP Jornada and up to two
desktop PCs, for example, your home PC and your office PC. If you regularly
synchronize your HP Jornada with both desktop PCs, you can ensure that
important files, contacts, and calendar information are always up-to-date and
identical on both desktop PCs, as well as on your HP Jornada.

If your HP Jornada has more than one desktop PC partner, you cannot synchronize e-mail
messages.

A single desktop PC can partner with any number of H/PCs or palmtop PCs.
This is useful if you have more than one  Windows CE device, or if several
mobile professionals share a single desktop PC.

Following the New Partnership Wizard

The New Partnership Wizard will help you create a partnership and offer you
options for synchronizing Pocket Outlook data, e-mail messages, and files
between your HP Jornada and desktop PC. When the New Mobile Device
Detected dialog box appears on your desktop PC, click Synchronize, and
then follow the instructions on the screen of your desktop PC to complete
the New Partnership Wizard.

The wizard prompts you to type a name and a description for your
HP Jornada. The name can be anything you choose (up to 15 alphanumeric
characters, no spaces) and should provide an easy way for you to identify
your HP Jornada. The description could be the make and model of the device
(for example, HP Jornada 680 H/PC) or a property control number.

You can later change the device name and description by using the Communications
control panel on your HP Jornada. On the Start menu, point to Settings, tap Control
Panel, and then double-tap the Communications icon.



32  |  HP Jornada 600 Series User�s Guide

The wizard also prompts you to choose settings for synchronization. If you
enable synchronization, you can set ActiveSync either to synchronize
automatically each time you connect your HP Jornada to your desktop PC,
or to synchronize continuously, whenever the synchronized information
changes, for as long as the computers are connected.

Regardless of the options you choose while completing the wizard, you can also
synchronize at any moment by choosing the Synchronize Now command from the
Tools menu of the Mobile Devices window. For more information, see the
Synchronizing data section in this chapter.

Troubleshooting partnerships

If you are unable to establish a connection between your HP Jornada and
your desktop PC, double-tap the connection icon  in the status area of the
taskbar on your HP Jornada. The Connection Status dialog box may provide
information about the problem.

You should also confirm that both the desktop PC and the HP Jornada are
communicating at the same baud rate. To check the baud rate on your
desktop PC, click Communications on the File menu of the Mobile Devices
window. You can check and change the baud rate on your HP Jornada by
using the Communications control panel. On the Start menu, point to
Settings, tap Control Panel, and then double-tap the Communications icon.

Verify that the sync cable from your docking cradle or HP Jornada is con-
nected to the port listed on the Communications tab of the Windows CE
Services Properties dialog box (this is the port you selected when setting
up Windows CE Services).
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Finally, on the Communications tab of the Windows CE Services Properties
dialog box, clear the Enabled check box under Enable mobile device connec-
tion, and then click Apply . After the connection is disabled, re-select the
Enabled check box and click Apply to enable the connection again.

If these steps fail to correct the problem, use the Windows CE Services
Communications Troubleshooter. The Communications Troubleshooter
provides detailed diagnostic steps to identify and correct common problems.

To start the Communications Troubleshooter

1. On the desktop PC Start menu, point to Programs, point to
Microsoft Windows CE Services, and then click Mobile Devices.

2. On the Help menu in the Mobile Devices window, click
Communications Troubleshooter.

Connecting to your desktop partner
After you have established a partnership, you have several options for
connecting your device to your desktop partner in the future. You can set
Windows CE Services to automatically detect your HP Jornada and establish a
connection whenever you connect the sync cable. Using the COM port on
your desktop PC is the easiest way for you to connect, unless you use that
port for other peripherals.
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To enable automatic connection

1. On the desktop PC Start menu, point to Programs, point to
Microsoft Windows CE Services, and click Mobile Devices.

2. On the File menu in the Mobile Devices window, click
Communications.

3. Under Device Connections via Serial Port, click Enable Auto
Connect.

If you use the COM port of your desktop PC for other devices, or if you have
disconnected your HP Jornada and need to re-establish the connection, you
can establish a manual connection using the PC Link program on your
HP Jornada.

To connect manually

1. On the HP Jornada Start menu, point to Programs, point to Commu-
nications, and then tap PC Link . The Connection Status dialog box
appears. After a few moments a sound indicates that the connection
has been established.

To close the connection

1. On your HP Jornada, double-tap the connection icon in the status
area of the task bar.

2. In the Connection Status dialog box, tap Disconnect.

Connecting by infrared

You can use the infrared port on your HP Jornada to connect to a desktop or
notebook PC that is running Windows 95 (or later). Once connected, you can
transfer files and synchronize Pocket Outlook data and e-mail messages just
as if you had connected using a sync cable or a docking cradle.

Before you can connect by infrared, you must set up and configure an
infrared port on your desktop or notebook PC. Many notebook PCs have a
built-in infrared port; however, you may need to install a third-party infrared
transceiver on your desktop PC. For more information about installing and
configuring that device for use with your desktop PC, refer to the instruc-
tions that came with your infrared port.

The Desktop Software for Microsoft Windows CE compact disc also includes
infrared device drivers for Windows 95.
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To configure Windows CE Services for infrared connection

1. Insert the Desktop Software for Microsoft Windows CE compact
disc into the CD-ROM drive on your desktop PC, and then run
Setup.exe.

2. Click Optional Components, and then select the Windows 95
Communications Driver setup program.

3. When the setup program prompts you to specify a communications
port, select a virtual port (typically COM3).

4. When setup is complete, restart your desktop PC, and then open the
Mobile Devices window.

5. In the Mobile Devices window, click Communications on the File
menu.

6. Under Port, select the infrared port you installed when you set up
the infrared device.
–or–
Click New to install the port. (If you install a new port, you may need
to reinstall Windows CE Services.)

To configure your HP Jornada for infrared connection

1. On your HP Jornada Start menu, point to Settings, tap Control
Panel, and then double-tap the Communications icon.

2. On the PC Connection tab, if it does not say Connect using Infrared
Port, tap Change, and then select Infrared Port from the list of
available connections.

To establish an infrared connection

1. Line up the infrared port on your HP Jornada with the infrared device
on your notebook or desktop PC.

2. On your HP Jornada Start menu, point to Programs, point to
Communications, and then tap PC Link .

Connecting to another PC
In some cases, you may need to connect your HP Jornada to a desktop PC
other than your partner. Or, if you have logged on to your desktop PC under
a different user name or performed a full reset of your H/PC, your desktop PC
will not recognize your HP Jornada as its partner.
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In these cases, when you connect your HP Jornada to the desktop PC, the
New Mobile Device Detected dialog box appears, offering you the option to
synchronize, browse, or to restore data from an existing backup file.

If you choose Synchronize, the New Partnership Wizard will begin, and your
HP Jornada will be designated as a partner of the desktop PC. Contacts,
Calendar, and Task information and information from any other services you
choose to synchronize will be copied from the desktop PC to your HP
Jornada.

If you choose Browse, your HP Jornada will be connected as a guest. As a
guest, you can view files and folders on the HP Jornada, transfer files and
folders, and manually back up or restore; however, you cannot synchronize
data or automatically back up and restore data.

If you choose Restore, you are given the option to restore data from an
existing backup file on the desktop PC. Restoring data in this way will replace
all existing data on the HP Jornada with the data in the backup file on your PC.

If you have lost your HP Jornada or replaced it with another HP Jornada, you can use the
Restore function to set up a new device with the exact same data and settings as the old
one, provided you had previously performed a full backup to the desktop PC. When you
connect the new device to your desktop PC for the first time, choose Restore rather than
Synchronize or Browse. For more information, see the Backing up and restoring
data section in chapter 5.

Browsing your HP Jornada desktop
While your HP Jornada is connected to a desktop PC, you can use Windows
CE Services to browse the contents of your HP Jornada from your desktop.
Your HP Jornada appears as an icon in the Mobile Devices window on your
desktop PC. When you double-click the HP Jornada icon, the contents of
your HP Jornada are displayed as any other folder on your desktop PC. You
can cut, paste, and copy files between folders on your HP Jornada or transfer
files between your HP Jornada and your desktop PC simply by dragging the
file icons between the appropriate folders.

For more information about transferring files, including details on converting file types
between Pocket Office and Office 97 programs, see the Transferring files section later
in this chapter.
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You cannot open files or start programs stored on your HP Jornada by
double-clicking their icons in the Mobile Devices window on your desktop
PC. When you double-click the icon for a file or program that is stored on
your HP Jornada, Windows CE Services displays the properties for that file
or program, as if you had clicked Properties on the File menu.

The Mobile Devices window on your desktop PC displays
the contents of your HP Jornada (shown here with

Internet Explorer 4.0 and Active Desktop).

Synchronizing data
Windows CE Services with ActiveSync enables you to synchronize data
between your HP Jornada and desktop PC, so the names you add to your
Contacts database and the appointments you add to your Calendar while
traveling can be automatically updated on your desktop PC when you return.
You can also synchronize messages in your HP Jornada Inbox with Mi-
crosoft Outlook or Microsoft Exchange on your desktop PC. And, you can
synchronize files in the Synchronized Files folder on your HP Jornada with
files in the My Documents folder (Windows 95) or Personal folder
(Windows NT) on your desktop PC.
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You can set ActiveSync either to synchronize automatically each time you
connect your HP Jornada to your desktop PC or to synchronize continu-
ously whenever the synchronized information changes, for as long as the
computers are connected. You can also synchronize at any moment by
choosing Synchronize Now from the Tools menu in the Mobile Devices
window.

Do not remove your HP Jornada from the docking cradle, disconnect the sync cable, or
turn off your HP Jornada while synchronization is in progress.

Synchronizing selected data

You can synchronize some or all of the following items:

• Pocket Outlook data—Synchronize the Calendar, Contacts, or Tasks
information on your HP Jornada with information stored in Outlook or
Schedule+ on your desktop PC.

• E-mail messages—Share messages between selected folders in your
HP Jornada Inbox and Microsoft Exchange or Outlook on your desktop
PC. For more information, see the Synchronizing e-mail messages
section in this chapter.

• Files—Synchronize the contents of the Synchronized Files folder (inside
My Documents) on your HP Jornada with files stored in your My
Documents folder (Windows 95) or in your Personal folder (Windows NT)
on your desktop PC.

To specify data to synchronize

1. On your desktop PC, open the Mobile Devices window, and then
select your HP Jornada icon.

2. On the Tools menu, click ActiveSync Options.

3. On the General tab of the ActiveSync Options dialog box, select the
check boxes beside the services you want to synchronize.

4. To set specific options (for example, to indicate how many weeks of
Calendar data to synchronize, or to synchronize only active tasks),
select the appropriate service, and then click Options.

Reducing the amount of data to synchronize, for example, by synchronizing only 1 or 2
weeks of Calendar data, can significantly speed up the synchronization process. If you use
Microsoft Outlook, Windows CE Services synchronizes only 2 weeks of calendar data by
default.
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Resolving synchronization conflicts

If the same item (for example, an appointment or a task) has been modified on
both the desktop PC and on the HP Jornada, ActiveSync will indicate that a
Synchronization conflict has occurred. When the Resolve Conflicts dialog
box appears, you can either resolve the conflict by selecting one of the items
to replace or you can ignore the conflict, leaving the data on both computers
unchanged.

You can resolve each conflict manually, at the time of synchronization, or
you can resolve conflicts automatically by setting a default option for
conflict resolution.

To set a default option for conflict resolution

1. Open the Mobile Devices window, and then select your HP Jornada
icon.

2. On the Tools menu, click ActiveSync Options.

3. On the General tab of the ActiveSync Options dialog box, click
Advanced.

4. Select the option you prefer to resolve conflicts.
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Synchronizing e-mail messages

You can synchronize your HP Jornada Inbox with the e-mail program
(Microsoft Outlook or Exchange) on your desktop PC partner. By synchro-
nizing, you can take important messages with you when you travel, or you
can use your desktop PC to send messages that you create on your
HP Jornada.

When you synchronize:

• Messages are copied from the Inbox folder on your desktop computer to
the Inbox folder on your HP Jornada (by default, only the messages
received in the past 3 days are synchronized, and no attachments are
copied).

• Messages on the two computers are linked. So, for instance, if you delete
a message on your HP Jornada, it will also be deleted on your desktop PC
the next time you synchronize.

• Messages in the Outbox folder on your HP Jornada are transferred to the
Outbox on your desktop PC and then sent from that program.

Synchronizing from a remote location

The ActiveSync program on your HP Jornada enables you to synchronize
files, e-mail messages, and Pocket Outlook data with your desktop PC, even
when you are away from the office. You can do this by remote dial-up
connection or LAN connection to your desktop PC. You can also connect to
a computer not on a network (such as your home computer) and synchronize
using a modem.

Before you can synchronize remotely, the desktop PC or network server must
be configured for Remote Access Services (Windows NT) or Dial-Up
Networking (Windows 95 or later), and you must create a connection on your
HP Jornada by using either the HP Jornada dialup application or the Remote
Networking program. For information about setting up connections with HP
dialup, see the Setting up a remote connection to your network section in
chapter 6. For Remote Networking information, see the Accessing a com-
puter not on a network section in this chapter. After you have set up for
either type of connection, you can synchronize data. See the To start remote
synchronization procedure later in this chapter.
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Accessing a computer on your corporate network

To access a PC on your corporate network from a remote location, you must
have an account provided by your network administrator, and you must set
up a connection to your network server using HP dialup (see chapter 6). In
addition, you must set up the target PC to receive your calls as follows.

• The target PC must be turned on.

• Windows CE Services must be set up on the target PC. (See the Installing
Windows CE Services section earlier in this chapter.) Also, the Auto
Connect option should be set to At all times.

• Windows CE Services must be running, and the Waiting for mobile device
to connect status message must be shown in the Mobile Devices window.

• In the Windows CE Services Properties dialog box, Enable a network
connection must be selected.

• Any folders or drives you want to access must be shared.

If you will be dialing in to a desktop PC running Windows 95, you must also have Dial-
up Networking components set up on the target desktop PC.

Accessing a computer not on a network

If you want to dial in to a computer that is not on a network (such as your
home PC with Windows 95 and Microsoft Plus! pack), you must set up the
target PC to receive your calls as follows.

• The target desktop PC must be turned on.

• The target desktop PC must have a modem installed and configured and
must be set to receive incoming calls. (Refer to the instructions from the
manufacturer of your desktop PC modem.)

• Dial-up Networking (Windows 95) or Remote Access Service (Windows
NT) must be set up and configured so that your target PC can act as a
server. (See your Windows documentation for further instructions.)

• Windows CE Services must be set up on the target PC (for instructions,
see the Installing Windows CE Services section in this chapter). The
Auto Connect option should be set to At all times.

• Windows CE Services must be running, and the Waiting for mobile device
to connect status message should appear in the Mobile Devices window.

• In the Windows CE Services Properties dialog box, Device connection via
network must be enabled.

• Any folders or drives you want to access must be shared.
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You need the following information to establish a Remote Networking
connection:

• Your Windows user name and password, if you are required to log on to
your computer

• Telephone number of the modem

To create a connection to a computer not on a network (such as a home
computer), you will need to create a new connection using Remote Network-
ing on your HP Jornada.

To create a Remote Networking connection

1. On the Start menu, point to Programs, point to Communication, and
then tap Remote Networking.

2. In the Remote Networking folder, double-tap Make New Connection.

3. In the Make New Connection dialog box, tap Dial-up, and then tap
Next.

4. If you have the HP Jornada 680 or 690, select Built-In Modem  from
the list of modems. If you have the HP Jornada 680e or 690e, select
the appropriate option for the modem you have installed.

5. Tap TCP/IP Settings, and then tap the General tab. Make sure the
Use Server-assigned IP Address check box is selected.

6. On the Name Servers tab, tap Server-assigned addresses, and then
tap OK .

7. Tap Next, and then fill in the telephone number you wish to dial. Tap
Finish. A new icon appears, labeled with the name you chose, in
your Remote Networking folder. This connection will also appear in
your remote synchronization dialog box.

To set a dialing location for a Remote Networking connection, double-tap the icon for the
connection in the Remote Networking folder. In the Dial-up Connection dialog box,
tap Dial Properties, and then fill in the information as you would for a network or ISP
connection using the HP Jornada dialup application.

To start remote synchronization

1. On your HP Jornada Start menu, point to Programs, point to
Communication, and then tap ActiveSync.
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2. If you are connecting using a modem or dial-up connection, select
the connection you will use from the list. All connections you have
created either with the HP Jornada dialup application or Remote
Networking will appear in this list.
–or–
If you are connecting over a network, tap Network Connection.

3. In the Connect to list, select the name of the desktop PC to which
you will connect. The Connect to list displays only the PCs with
which you have already established a partnership.

4. In the User Logon dialog box, type your user name, password, and
domain if necessary, and then tap Connect.

Transferring files
You can copy files between your HP Jornada and desktop PC by dragging
icons to or from the HP Jornada icon in the Mobile Devices window, or by
using the Cut, Copy, and Paste commands on the Edit  menu.

Some files may need to be converted before you can use them on your
HP Jornada. By default, Windows CE Services automatically converts files to
the appropriate file type. However, you can choose not to convert files, or
you can specify the conversions for each file type by changing options in the
File Conversion Properties dialog box.

 To set file conversion options

1. Open the Mobile Devices window.

2. On the Tools menu, click File Conversion.

3. Click either the Device to Desktop or Desktop to Device tab.

4. Select the file type, and then click Edit  to change conversion
options. In most cases, you will be offered a single conversion
option or no conversion at all.

When Office 97 files are converted to their corresponding Pocket Office
formats, the Pocket Office files are compressed, so they require much less
storage memory than they do on your desktop PC. During conversion,
certain formatting or attributes may also be removed from the Pocket Office
version; however, all formatting should be restored when the file is returned
to the desktop PC. For specific details, see the sections on Microsoft Office
programs in chapter 5 or refer to online Help for that program on your
HP Jornada. Only Microsoft PowerPoint® 97 files can be converted to
Pocket PowerPoint.
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Transferring PIM data from older palmtop PCs and
handheld PCs
If you have an older palmtop PC or handheld PC, you can transfer personal
information manager (PIM) data  (Contacts, Calendar, and Tasks data) to
your HP Jornada, saving you the task of re-entering entire lists of contacts or
tasks. You can also copy all files, folders, and programs you have added from
an older model Windows CE device to your HP Jornada.

The transfer process you follow and the type of data that can be migrated
depends on the make and model of the palmtop or handheld PC, and whether
it uses Windows CE Services to connect to your desktop PC.

Migrating data from older Windows CE palmtop PCs

If your data is stored on a palmtop or handheld PC that uses an older version
of Windows CE, you must first back up the data to your desktop PC by using
the version of Windows CE Services or H/PC Explorer that came with the
device. Then, upgrade to Windows CE Services 2.2 on your desktop PC, and
restore the data to your HP Jornada. Use the following procedure to migrate
files, appointments, and other personal data stored on your old palmtop PC.

The following procedure will replace all files, programs, and Pocket Outlook data you have
added to your HP Jornada with the information stored on the palmtop PC.

To migrate data from an older Windows CE device to your
HP Jornada

1. Connect the older Windows CE palmtop PC to the desktop PC and
establish a partnership between the two.

2. Synchronize the palmtop PC with the desktop PC using H/PC
Explorer 1.0 or Windows CE Services.

3. Perform a full backup of your data:

• In the Mobile Devices window on your desktop PC, click
Backup/Restore on the Tools menu.

• In the window that appears, on the Backup tab, select the
options you prefer.

• Click Backup Now to initiate the process.

• Note the directory in which your data has been saved.
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4. Note the Communications, Owner, and World Clock alarm settings on
your palmtop PC. Also note Options and User Preferences settings
for third-party programs. (These settings are not restored automati-
cally.)

5. Disconnect the palmtop PC.

6. If H/PC Explorer version 1.0 is set up on your desktop, uninstall it
using the Remove Programs control panel. (For more information,
refer to online Help on your desktop PC.)

7. Insert the Desktop Software for Microsoft Windows CE compact
disc that came with your HP Jornada and set up Windows CE
Services 2.2. (For more information, see the Installing Windows CE
Services section in this chapter.)

8. Connect your HP Jornada to the desktop PC.

9. On your desktop PC, in the New Mobile Device Detected dialog box,
click Restore to restore data to your HP Jornada from the backup file
created in step 3.

10. Disconnect the sync cable from your HP Jornada or remove your
device from the docking cradle, and then press the reset button on
your HP Jornada to complete the restoration operation.

11. Reconnect the sync cable to your HP Jornada or place it in the
docking cradle to reconnect to the desktop PC. In the New Mobile
Device Detected dialog box, click Synchronize to establish a
partnership and synchronize your data.

Migrating data from non�Windows CE palmtops

If your data is stored on an HP 100/200LX Palmtop PC or an HP OmniGo
Organizer, you must first transfer the data to your desktop PC. Use the
Hewlett-Packard PIM Translation Utility (for HP devices only) to import the
data into Schedule+ 7.0a on your desktop PC. After you have imported the
data into Schedule+, you can update the information on your HP Jornada by
synchronizing with Schedule+ using Windows CE Services 2.2.

The HP PIM Translation Utility is available on the HP Jornada Handheld PC
compact disc included with your HP Jornada. This procedure migrates only
Phone Book and Appointment Book data.
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Before translating PIM data files, you must install the version of Schedule+ 7.0a found
on the Desktop Software for Microsoft Windows CE compact disc on your desktop PC.

To install the HP PIM Translation Utility onto the desktop PC

1. Insert the HP Jornada Handheld PC compact disc into the CD-ROM
drive on your desktop PC.

2. On the main menu of the HP Jornada Handheld PC compact disc
installation screen, click HP PIM Translation Utility .

PIM data translation

You can translate only one file at a time. To translate multiple PIM data files,
you need to repeat the Translation operation for each file separately.

To translate appointment data

1. Double-click the HP PIM Translation Utility icon to start the
program.

2. In the Welcome screen, click Appointments.

3. Specify the appointment data file to translate in the Open File dialog
box that appears, and then click OK . If the file you specify is not a
PIM database file of the appropriate type, you will get an error
message.

4. In the Appointment Book Translation Note screen, click OK . The
Data Translation Progress screen appears, showing the progress of
current translation activity.

5. When the translation is complete, a message appears. Click OK  to
return to the Welcome screen.

Limitation on appointment translation

Although the Appointment Book applications on the HP 100LX/200LX
palmtop PCs and HP OmniGo 100/120 organizers and the Calendar application
on the HP Palmtop PC support daily, weekly, monthly, and yearly repeated
events, the Schedule+ application supports only daily and yearly repeated
events. Because all translation goes through Schedule+, there is no direct
mapping from earlier HP Palmtop products to Schedule+ for repeating weekly
and monthly events. As long as you do not edit imported repeating weekly or
monthly events in Schedule+ before you synchronize them with the HP
Palmtop PC, they will translate correctly into repeating events on the palmtop
PC. If, however, you edit them in Schedule+, they lose their weekly/monthly
attribute and are treated as single events.
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To translate a Phone Book data file

1. Double-click the HP PIM Translation Utility icon to start the
program.

2. In the Welcome screen, click Phone Book.

3. In the Open File dialog box, specify the Phone Book data file to
translate, and then click OK .

4. In the Phone Book Translation Field Map window, select mapping
options. For more information, see the following sections.

5. When translation is complete, a message appears. Click OK  to return
to the Welcome screen.

Phone Book field mapping

The HP PIM Translation Utility attempts to map the fields in your Phone Book
data file to standard fields in a Schedule+ record. As long as your Phone Book
fields have standard names (that is, you have not modified the Phone Book
database field structure), the translation is straightforward. The suggested
mapping appears in a table in the Phone Book Translation Field Map screen:

• The left column shows the names of fields extracted from the Phone Book
data file. (Only the fields that have data are included.)

• The right column shows the names of Schedule+ fields.

• An arrow in the center column indicates that the data in a Phone Book
field in the left column will be copied to the corresponding Schedule+ field
in the right column. Note that multiple Phone Book fields (for example,
Address1 and Address2) can be mapped to the same Schedule+ field (for
example, Business address). No arrow in the center column indicates that
there is no mapping and, therefore, the data will not be copied. You can
add or modify the suggested mappings before translating the data. For
example, if you have customized the name of a Phone Book field so that
the HP PIM Translation Utility does not know how to map it, you can
define a mapping for it yourself.

Name mapping

The Name field in the Phone Book data file can be mapped in three ways in
Schedule+:
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• If the name in the Phone Book data file is entered as Name1, Name2
[Name3] (that is, with a comma after the first word), it is always mapped to
the two name fields in Schedule+ with Name1 = Last Name and Name2
[Name3] = First Name.

• If the name in the Phone Book data file does not have a comma after the
first word, you can choose one of two options for its mapping:

• Last name/First name— (default) Name1 [Name3]
Name2 maps to Name1  = Last Name and [Name3]
Name2 = First Name.

• First name/Last name—Name1 [Name3] Name2 maps to Name1
[Name3] = First Name and Name2 = Last Name.

In all cases, Last name is mapped to a single word, with any additional words
such as [Name3] becoming part of First name.)

Mapping additions

If a field appears in the left column with no mapping (that is, no arrow in the
center column) select a field name from the drop-down list of the Schedule+
field immediately to the right of the field whose mapping you want to define.
The field name appears in the appropriate cell in the right column and a
mapping arrow appears in the center column.

Mapping changes

If a field in the left column is mapped to the wrong field in the right column,
change the mapping by selecting a different Schedule+ field name from the
drop-down list for the corresponding cell in the right column.

Mapping removal

If a field in the left column should not be mapped to anything, click None
from the drop-down list for the corresponding cell in the right column. The
None option is not available for the Name field.

Translation status review

After each translation is finished, whether it completed successfully or was
interrupted, the results are written onto the Status screen. Click the Status
button on the Welcome screen to see the history of any translations begun
during the current execution of the HP PIM Translation Utility.
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Your Hewlett-Packard Jornada 600 Series Handheld PC comes with a variety of
programs designed to help you stay organized. Use Microsoft Pocket Outlook
and HP Jornada viewer to manage your contacts, tasks, and calendar while
you are away from your office. When you return, you can synchronize your
HP Jornada with your desktop or notebook PC to ensure that the Pocket
Outlook databases on your HP Jornada are always up to date with the
Microsoft Outlook or Schedule+ data on your desktop.

Pocket Outlook also lets you set alarms and reminders so that you never
forget an appointment or meeting. And, if you want a personal reminder, you
can record voice memos to yourself with Microsoft Voice Recorder.

In this chapter you will find information about and basic procedures for:

• Pocket Outlook

• HP viewer

• HP quick pad

• Voice Recorder

For more information on these and other programs that come with your
HP Jornada, see online Help.

Using Microsoft Pocket Outlook
Your HP Jornada comes with Microsoft Pocket Outlook, which includes
Calendar, Contacts, Tasks, and Inbox. Using Microsoft Windows CE Services,
you can synchronize information on your HP Jornada with information in
Microsoft Outlook, Microsoft Schedule+, or Microsoft Exchange on your
desktop computer. Each time you synchronize, Windows CE Services com-
pares the changes you made to data on your device and desktop PC and
updates both computers.
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With Inbox, you can send and receive e-mail messages, either by synchroniz-
ing with the mail program on your desktop PC (either Outlook or Exchange) or
by connecting directly to your mail server through an Internet or network
account.

To start Pocket Outlook

1. On the Start menu, point to Programs, point to Pocket Outlook, and
tap either Calendar, Contacts, Inbox, or Tasks.
–or–
Tap one of the Calendar, Contacts, Inbox, or Tasks hot keys.

To switch quickly from one Pocket Outlook applications to another, tap the Go menu on
the toolbar of the current Pocket Outlook application.

Keeping appointments with Calendar

Use Calendar to schedule appointments, meetings, and other events. Quickly
check your appointments in one of several views (Day, Week, Month, Year,
and Agenda).

To create a new appointment

1. On the Start menu, point to Programs, point to Pocket Outlook, and
tap Calendar.
–or–
Tap the Calendar hot key.

2. On the File menu, tap New Appointment.

3. Type a description and the location of your appointment.

4. Select the time and date of your appointment.

5. To add notes, tap the Notes button, and then tap once in the notes
area. Type your notes.

6. To assign the appointment to a category, tap the Categories button,
and then select a category from the list.

7. Select other desired options, and when you are finished tap OK .

If you need to schedule a meeting with people who use Outlook, Pocket
Outlook, or Schedule+, you can use Calendar to schedule the meeting. When
attendees receive a meeting request, they can choose to accept or decline
the meeting. If they accept, the meeting is automatically placed in their
schedule. In addition, their response is automatically sent back to you, and
your calendar is updated.



Chapter 4  |  Staying organized  |  51

Before you can send a meeting request, you must enter e-mail addresses in
Contacts and set up Inbox to send and receive messages (see the Using Inbox
section in chapter 6).

To create a meeting request

1. On the Start menu, point to Programs, point to Pocket Outlook, and
then tap Calendar.
–or–
Tap the Calendar hot key.

2. On the Tools menu, tap Options, and then choose a mail transport:

• If you send and receive messages using synchroniza-

tion, select ActiveSync.

• If you connect to an ISP or network, select the service

you set up in Inbox or the HP Jornada dialup application.

3. Tap OK .

4. On the File menu, tap Make Meeting.

5. Enter the meeting information.

6. Select the contacts you want to invite.

7. Select other desired options, and then tap OK .

Inbox automatically creates a meeting request and sends it to the attendees
the next time you connect to your mail server or synchronize with your
desktop PC.

Your HP Jornada will remind you about your appointments and meetings by playing a
sound, flashing the notification light, and/or displaying a message on the screen. To
choose the way you prefer to be notified, tap Options on the Tools menu. Tap Alarm,
and then tap Reminder Options.

Managing names and addresses with Contacts

The Contacts program maintains a list of your friends and colleagues so that
you can easily find the information you are looking for, whether you are at
home or on the road. Using the infrared port, you can also quickly share
Contacts information with other Windows CE–based mobile device users.
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To create a new contact

1. On the Start menu, point to Programs, point to Pocket Outlook,
and tap Contacts.
–or–
Tap the Contacts hot key.

2. On the File menu, tap New Contact.

3. Type a name.

4. Tap Business or Personal and type information in the appropriate
fields. Supply an e-mail address to send meeting requests and e-mail
messages to this contact.

5. To add a note or assign the contact to a category, tap Notes/
Categories. Then, select the notes area and enter your notes, or
select a category from the list.

6. When you are finished, tap OK .

You can send up to 25 contact cards at a time to another Windows CE�based device. To
do this, line up the infrared ports on the two devices so that they are within 1 meter
(3 feet) of one another. On the Contacts list, select the item(s) you want to send, and
then on the File menu, tap Send. If you are receiving items, tap Receive. Category
information and notes are not transmitted with the contact.

Keeping track of your workload with Tasks

The Tasks program helps you keep track of what you need to do. Enter the
details for a task on the task card, and then assign a category. You can even
associate a date with the task and then set a reminder for yourself.

You can sort the list on any column by tapping the column heading (the
column used for sorting the list displays a triangle in the heading). If you sort
by status, active tasks are listed before completed tasks. Or, you can filter
your list to show only a specific status of a task or tasks belonging to a
specific category. When your list is filtered, the filter button is selected.
Overdue tasks are displayed in red, bold text.
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To create a new task

1. On the Start menu, point to Programs, point to Pocket Outlook,
and tap Tasks.
–or–
Tap the Tasks hot key.

2. On the File menu, tap New Task.

3. Type a description of the task.

4. Select the start date, due date, and other information.

5. To add a note to a task, tap the Notes button, and then tap once in
the note-taking area. Type your note, and then tap OK .

6. When you are finished, tap OK .

Managing your e-mail with Inbox

Use Inbox to send and receive e-mail messages. You can access your e-mail
by synchronizing with your desktop PC or by connecting to a mail server
through an Internet or network account. (For more information, see the Using
Inbox section in chapter 6 and the Synchronizing e-mail messages section
in chapter 3.)

Using HP viewer
HP viewer gives you a quick and versatile way to view the information in
your Pocket Outlook Calendar, Contacts, and Tasks databases. HP viewer
displays the information you choose in as much detail as you want, includ-
ing detailed contact information, tasks and notes on a single screen, or all the
appointments and tasks scheduled for a single day, a week, or up to 6
months at a time.  HP viewer also enables you to view a single field for any
record or to switch instantly to Pocket Outlook for editing.

By default, the HP viewer icon is displayed on the Windows CE desktop.

To start HP viewer

1. On the Start menu, point to Programs, point to HP Applications,
and then tap HP viewer.
–or–
Press the HP viewer hot key.
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HP viewer shows your Pocket Outlook information quickly.

HP viewer uses the same font settings as Pocket Internet Explorer. Changing the font or
font size in Pocket Internet Explorer will also change the way information is displayed in
HP viewer.

You can quickly switch from HP viewer to Pocket Outlook to look at the
selected date in all Calendar views.

To switch to Pocket Outlook

1. On the Go menu, tap the appropriate program or view.

HP viewer displays the current date and your next scheduled appointment
below the toolbar in the Today Banner of the HP viewer window. To quickly
view detailed information about the appointment, tap the appointment title in
the Today Banner.

To switch between Calendar, Contacts, and Task information

1. Tap the appropriate icon on the left side of the HP viewer window.

Viewing Calendar information

HP viewer lets you view your calendar in Day, Week, Month, or n-Month
view.

• Tap the Calendar icon on the left side of the HP viewer window to
display Calendar information.

• Tap a View button on the toolbar to change views.

• Tap the Go to Date button on the toolbar to view information for a
specific date.
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n-month (displays 3 months)

Month

Week

Day

Today (GoTo Today command)

Date (GoTo Date command)

Day View offers a fast way to browse your schedule for the current day or
up to 7 days that you select.

To enable Day Zoom in n-Month View, Month View, or Week View, press the
spacebar to display appointments and tasks for the selected date(s). Tap an
icon next to an appointment or event to expand a note or to display more
information about that appointment or event.

You can set HP viewer to always display Day Zoom for the date you select by tapping
 on the toolbar.

Week View enables you to display 1, 2, or 3 weeks of your calendar at a time.
Press num lk

ctrl  as you tap  or  on the scroll bar to increase or decrease the
number of weeks displayed. Tap an event to display detailed information
about that event.

Use Month View to display 5 weeks of data on a single screen, or use n-
Month View to display calendars for several months at a time. Tap a day to
display detailed information about appointments or events scheduled on
that day.

Viewing Contacts information

HP viewer lets you view all information for a particular contact on a single
screen.
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• Type in the Find File As box to display only contacts matching the
letter(s) you type.

• Tap a tab on the left side of the contact list to jump to contacts that begin
with a letter on the tab. To jump to contacts that begin with the second
letter on the tab, tap the tab again.

• To change the field on which the contact list is sorted, tap the field name
at the top of the list, and then choose a field from the Select Primary Key
dialog box.

Viewing Tasks information

You can also use HP viewer to view task information for any field, including
Notes.

• Type in the Find Task box to display only tasks that match the letter(s)
you type.

Capturing data with HP quick pad
Use HP quick pad to enter all the notes and information you acquire during
your day. Quickly record names, telephone numbers, quick notes to yourself.
You can save this information in HP quickpad or create appointments, tasks,
e-mail messages, even Pocket Word documents from a single application.

With quick pad, you can check the date and time at a glance, review your
current appointments and tasks, and quickly find a telephone number or
address from your contact list.
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Quickly jot notes and reminders or new contact information on the notepad.
Then, save your notes in quick pad or send them to the appropriate database,
such as your Contacts or Tasks list.

To start HP quick pad

1. On the Start menu, point to Programs, point to HP Applications,
and tap HP quick pad.
–or–
Press the HP quick pad hot key.

To save information in HP quick pad

1. On the File menu, tap New Page to create a blank notepad page.

2. Tap once in the notepad area, and then type the information you
want to save.

3. On the File menu, tap Rename Page, and then type a descriptive
name for the information.

4. On the File menu, tap Save.

You can create as many pages as you like. Retrieve information by selecting
the page title from the drop-down list, or by tapping Find in Page on the Edit
menu, and then typing a word or words to search for.

To organize information for use in other programs

1. In HP quick pad, open the page containing the information, and
select the text you want to export.

2. On the Send menu, select the program in which you want to use the
information:

• Tap As E-mail Message to create an e-mail message

containing the selected text.

• Tap To Calendar, To Contacts, or To Tasks to create an
entry in one of the Pocket Outlook databases.

• Tap As New Pocket Word Document to create a Pocket

Word document containing the selected text.
3. In the dialog box that appears, add any necessary information (for

example, the start or end date of a task or appointment, or addressees
for an e-mail message), and then tap OK .
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Recording and playing voice memos
You can use Microsoft Voice Recorder to quickly capture thoughts, remind-
ers, and ideas. Since your recordings are captured in the compatible Wave
(.wav) format, you can send personalized voice messages to friends and
colleagues as e-mail attachments that can be opened in most Web browsers
on a desktop PC.

Use the audio buttons on the front of your HP Jornada to record and play
voice memos without even opening the cover. To avoid inadvertently
pressing one of the audio buttons, slide the audio lock to the left. When the
buttons are unlocked, the green dot is visible.

Voice Recorder is intended for recording personal voice memos and is not suitable for
recording presentations, music, or lectures. Some static or electrical noise may be heard
during playback.

To record a voice memo without opening your HP Jornada

1. Press and hold the record button on the front panel of the
HP Jornada. If the speaker is not muted, a beep sounds when
recording begins. The red recording LED indicates that recording is
in progress.

2. Speak into the microphone to record your voice memo.

3. To stop recording, release the record button. Two beeps indicate that
recording has stopped.

After you have finished recording, your HP Jornada remains on until
it auto-suspends according to the options you set in the Power
control panel.
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If you have enabled password protection for your HP Jornada, you cannot play voice
memos using the audio buttons. You must either play back voice memos using the Voice
Recorder program, or disable password protection (see the Security section in chapter 7).

To play a voice memo without opening your HP Jornada

1. Slide the audio lock to the right. (The green dot indicates that the
audio buttons are unlocked.)

2. Press either the play next button or the play previous button on the
front panel of the HP Jornada.

Voice recorder begins playing all recordings in sequence.

•  To fast forward in the current recording, press and

holdthe play next button.

•  To rewind in the current recording, press and hold the
play previous button.

•  To skip to the next recording, press play next.

•  To replay the previous recording, press play previous.

•  To pause playback, press record.

•  To resume playback, press either play next or play
previous within 10 seconds of pausing.

To record and to play a voice memo from within Voice Recorder

1. On the Start menu, point to Programs, point to Accessories, and
then tap Voice Recorder.
–or–
Press the Voice Recorder hot key.

2. Tap the Record button on the toolbar. A beep sounds when record-
ing begins, and the red recording LED indicates that recording is in
progress.

3. Speak into the microphone to record your voice memo.

4. To stop recording, tap the Stop button on the toolbar. The new
recording appears in the recording list.

5. To play a recording, double-tap it in the recording list. To pause
playback, tap Play/Pause. Tap Play/Pause again to resume playback.
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You can play all of your recordings, one after another. Select the recording you want to
play first, tap Control and then tap Play Sequential. The selected recording and
following recordings will be played. A short beep will sound between recordings.

Conserving memory

Voice memos may consume large amounts of storage memory on your
HP Jornada. If you record or store lots of voice memos, you may need to take
steps to conserve memory.

• Delete voice memos you no longer need. Select the recording in the list,
and then tap Delete on the File menu. Note that voice memos are deleted
immediately; they are not moved to the Recycle Bin and cannot be
recovered.

• Adjust the amount of storage memory available on your HP Jornada using
the Memory tab in the System control panel.

• Add more memory to your device with a CompactFlash Card or PC Card.
(For a list of recommended cards, go to the Hewlett-Packard Web site at
www.hp.com/jornada.)

• Use HP Mobile Voice to store your voice memos in a compressed format.
You can choose Mobile Voice format from the list of recording formats (on
the Tools menu, tap Recording Format). This saves space, but lowers the
quality of the recording, so try to speak close to the microphone to
increase clarity.

http://www.hp.com/jornada
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Getting down | 5

Your Hewlett-Packard Jornada 600 Series Handheld PC can help you stay
productive and be efficient, even when you are away from your desktop or
notebook PC. You have access to Microsoft Pocket Office and other pre-
installed programs to help you calculate expenses and conduct searches.
Your HP Jornada also includes the HP Jornada backup application, which
keeps things running smoothly.

In this chapter, you will learn more about:

• Microsoft Pocket Office, which includes:

- Microsoft Pocket Word

- Microsoft Pocket PowerPoint

- Microsoft Pocket Excel

- Microsoft Pocket Access

• Microsoft InkWriter

• HP Jornada backup application

• OmniSolve from Landware

• bFAX from bSquare

• bFIND from bSquare

to business
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Working with Microsoft Pocket Office
Microsoft Pocket Office makes it easy to work in the familiar Office environ-
ment, even when you are away from your desktop or notebook PC. You can
start any of the Pocket Office programs by double-tapping the appropriate
icon on the desktop or by pressing the appropriate HP hot key. For more
detailed information about these programs, see the Microsoft Pocket Office
topic in online Help.

Using Microsoft Pocket Word

You can create and edit documents or templates in Pocket Word just as you
do in Microsoft Word on your desktop computer. Begin by placing the
cursor in the document page and start typing in either Outline or Normal
view. A spelling checker is provided to verify spelling accuracy, and you can
quickly format text using buttons and menu commands similar to those found
in Microsoft Word on your desktop PC. You can access international
characters and symbols for currencies from the Tools menu.

Pocket Word allows you to save documents in several file formats so that
your files can be opened by other users or other programs. If you transfer
documents between your HP Jornada and desktop PC, Windows CE Services
automatically converts the files to the appropriate file type. If you send files
by e-mail, be sure you save your document in a format that can be opened by
the recipient:

file type extension open with

Pocket Word document .pwd Pocket Word

Pocket Word template .pwt Pocket Word

Word 6.0/95/97 document .doc Microsoft Word 97

Word 6.0/95/97 template .dot Microsoft Word 97

Rich Text Format .rtf most word
processing programs

ASCII text .txt any text editor

To start Pocket Word

1. On the Start menu, point to Programs, point to Office, and then tap
Microsoft Pocket Word.
–or–
Press the Microsoft Pocket Word hot key.
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To create a document using Pocket Word

1. On the File menu, point to New, and then tap Document.

2. Type the document.

3. On the File menu, tap Save.

4. Type a name for your file, and then tap OK.

To see more of your document, on the View menu, tap Full Screen.

Using Microsoft Pocket PowerPoint

You can deliver professional online presentations with Pocket PowerPoint.
Simply create the presentation in Microsoft PowerPoint 97 on your desktop
PC and transfer the presentation to your device. You cannot create slides on
your HP Jornada; however, you can customize the title slide in the presenta-
tion and change the order of the subsequent slides to suit a particular client
or audience.

You can show the presentation directly on your HP Jornada, or you can use
an HP VGA out card to connect an external monitor or a projector and show
the presentation to a large group. This option allows you to view PowerPoint
speaker notes on the HP Jornada display while your presentation is showing
on the external monitor. Your Pocket PowerPoint file will include the text,
pictures, notes, and layout position of the original Microsoft PowerPoint
presentation, but will not include animations or slide transitions. Animations
are displayed as a single, still frame.

To start Pocket PowerPoint

1. On the Start menu, point to Programs, point to Office, and tap
Microsoft Pocket PowerPoint.
–or–
Double-tap the Microsoft Pocket PowerPoint icon on the desktop.

To show a presentation

1. Using Windows CE Services, copy the presentation from your
desktop PC to your HP Jornada.

2. On the Start menu, point to Programs, point to Office, and tap
Microsoft Pocket PowerPoint.
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3. In the Open Presentation dialog box, select the presentation you
want to show, and then tap OK .

4. To change the presentation display and slide-advance options, on
the Tools menu, tap Set Up Show.

5. To show the presentation, tap View Show on the View menu. If you
chose Manual under Presentation Display in step 4, use the
Previous and Next buttons to control the slides.

You can tailor a presentation by adding a new title slide to your presentation. To do so,
tap Title Slide on the Tools menu.

To show a slide presentation on a VGA-compatible monitor

1. Insert an HP VGA out card into your HP Jornada, and then connect
the card to a monitor or projector according to the instructions that
came with the card.

2. Start PowerPoint, and open the presentation (see To show a presen-
tation earlier in this chapter).

3. On the Tools menu, tap Set Up Show.

4. From the View Show On list, select one of the VGA out options.

5. To start the show, tap View Show on the View menu.

You can make the display fade to black during a presentation. To do so, press B . To
make the screen fade to white, press W . Press B  or W  again to resume the
presentation.

Using Microsoft Pocket Excel

You can use Pocket Excel to create workbooks, such as expense reports and
mileage logs. Pocket Excel provides fundamental spreadsheet tools, such as
formulas, functions, sorting, and filtering. You can split panes to easily view
different areas of a large worksheet. You can also “freeze” the top and
leftmost panes in a worksheet to keep row and column labels or other data
visible as you scroll through a sheet.

Pocket Excel allows you to save workbooks in several file formats so that your
files can be opened by other users or other programs. If you transfer work-
books between your HP Jornada and desktop PC, Windows CE Services
automatically converts the files to the appropriate file type. If you send files
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by e-mail, be sure you save your workbook in a format that can be opened by
the recipient.

To start Pocket Excel

1. On the Start menu, point to Programs, point to Office, and then tap
Microsoft Pocket Excel.
–or–
Double-tap the Microsoft Pocket Excel icon on the desktop.

To create a workbook using Pocket Excel

1. On the File menu, point to New, and then tap Workbook .

2. Create your worksheet.

3. On the File menu, tap Save.

4. Type a name for your file, and then tap OK .

If your workbook contains sensitive information, you can protect it with a password. To do
so, open the workbook and tap Password on the File menu. Password-protected
workbooks cannot be synchronized.

Using Microsoft Pocket Access

You can use Pocket Access to view and update data derived from Microsoft
Access, Microsoft SQL Server, and other ODBC databases on your
HP Jornada. You can open the database and update data in the correspond-
ing tables or you can fill out electronic forms. Eventually, you should
synchronize the new information with a larger database on your desktop PC
or your corporate network. You can also use Pocket Access to create new
databases, tables, and SQL procedures directly on your device.

Programmers can use Microsoft ActiveX� Data Objects for Windows CE (ADOCE) and
Microsoft Visual Basic� or Microsoft Visual C++� to develop custom database
solutions. For more information on creating custom database solutions, go to the Microsoft
Web site at www.microsoft.com/windowsce.

To create a new database and table

1. On the Start menu, point to Programs, point to Office, and then tap
Microsoft Pocket Access.
–or–
Double-tap the Microsoft Pocket Access icon on the desktop.

http://www.microsoft.com/windowsce
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2. On the View menu, tap Database View, and then tap Open/New
Database on the File menu.

3. Type a name for the database and tap OK .

4. Double-tap the Create a New Table icon.

5. In the Field Name box, type a name.

6. From the Data Type list, select a data type.

• The data type of a field cannot be changed after the table
is saved.

• Text boxes have a size limit of 255 characters. To enter
longer notes, select the Memo data type.

• To enter numbers with decimal points, select the Float
data type.

• To enter numbers between -32,768 and +32,767, select the
Integer data type.

• To enter smaller numbers, select the Small Integer data
type.

7. To set the size limit of a field, enter an amount in the Field Size box.
You cannot change field sizes after the table is saved.

8. To index the field, select Yes from the Indexed list. Indexing a field
allows Pocket Access to find and sort information faster for that
field.

9. Repeat these steps until you have created all the fields you want for
your table.

10. On the File menu, tap Save Table.

If you have tables that you do not want to keep updated on the device (such as product
catalogs), mark them as read-only when transferring them from the desktop to the device
to save time during future synchronization sessions. Windows CE Services will not check for
updates the next time you synchronize.

Printing your Pocket Office documents

You can print your Pocket Office and other documents from your HP Jornada
in three different ways:
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• By connecting directly to a PCL printer using the optional HP parallel printer
cable (F1274A). For a list of compatible printers, refer to the HP parallel
printer cable User’s Guide that came with your HP Jornada.

• By connecting via infrared port (only with an infrared-equipped PCL printer).

• By transferring the file to your desktop PC and printing it from within a
program on the desktop PC.

For instructions on printing directly to a printer using the HP parallel printer
cable, see the HP parallel printer cable User’s Guide.

To print directly to a printer via infrared

1. Open the file or document you want to print.

2. On the File menu, tap Print . The Print  dialog box appears.

3. Choose the PCL printer you will be printing to and select the IrDA port
option.

4. Set other print options as necessary.

5. Tap OK, and then line up the infrared port on your HP Jornada with the
infrared port on the printer.

Using Microsoft InkWriter
InkWriter, a text, graphics, and ink processor with Rich Ink technology, makes it
easy to write and draw the way you do on paper, but with the benefit of being
able to edit and format your writings and drawings. With InkWriter, you can enter
information in the way that is easiest for you: type using the keyboard or write or
draw on screen using the stylus.

To create an InkWriter document

1. On the Start menu, point to Programs, point to Accessories, and then
tap InkWriter .

2. Create your document:

• To type, tap Writing  on the View menu, and then use the
keyboard.

• To draw, tap Drawing on the View menu, and then drag  the
stylus to draw on the touch screen. You can also create a
drawing in Writing view by crossing three of the ruled lines
on the first stroke of the drawing.

3. When you are finished, tap Save on the File menu.
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Backing up and restoring data
To prevent loss of data, you should back up your HP Jornada data frequently.
You can back up your HP Jornada two convenient ways:

• Use Windows CE Services to back up all data to your desktop PC.

• Use the HP Jornada backup application to back up all data or only PIM
data (HP quick pad, Contacts, Calendar, and Tasks databases) to a PC
Card or CompactFlash Card or to internal memory.

Using Windows CE Services Backup at your PC

The Windows CE Services Backup feature creates a complete duplicate of all
data stored on your HP Jornada. If you routinely connect to your desktop
PC, this is the best method of data backup. The backup file is saved on the
hard disk of your desktop PC.

When you restore data from a backup file created by Windows CE Services,
all data on your HP Jornada is replaced by the data in the backup file,
including files you have created, programs you have installed, and any
system settings and options you have set.

To access the Windows CE Services Backup feature, tap Backup on the
Tools menu in the Mobile Devices window. For more information about
Windows CE Services Backup, see online Help.

Using the HP Jornada backup application

To ensure the complete safety of your data, use the HP Jornada backup
application to back up to an optional CompactFlash Card (such as the HP
CompactFlash Card, model F1233A). By backing up to a CompactFlash Card,
you can safeguard your data even while you are traveling or while you are
away from your desktop PC. HP backup lets you choose to back up all data
or only PIM data (Calendar, Contacts, and Tasks, and HP quick pad notes).
For information on using CompactFlash Card accessories with your HP
Jornada, see the Using PC Cards and CompactFlash Cards section in
chapter 7.

If you have both a CompactFlash Card and a PC Card installed, two folders appear in the
My Handheld PC folder. The folder called Storage card2 represents the CompactFlash Card.
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You can also back up data to a folder on your HP Jornada; however, this will
not preserve the information in case you lose power or need to perform a full
reset. (See the Resetting section in chapter 8.)

To back up data

1. On the Start menu, point to Programs, point to HP Applications,
and then tap HP backup.

2. Tap Backup.

3. Choose one of the backup options:

• Select Back up all data to back up all information stored
in RAM, including files you have created and programs
you have installed. (Certain system settings and
passwords are not backed up.)

• Select Back up PIM databases to back up only your
Contacts, Tasks, and Calendar databases and HP quick
pad notes.

4. Follow the instructions on your screen to complete the backup
process.

For additional protection, you can copy the backup file (*.dbe or *.dbb) from your
HP Jornada to your desktop PC.

To restore from a backup file

1. On the Start menu, point to Programs, point to HP Applications,
and then tap HP backup.

2. Tap Restore all data or Restore PIM databases.

3. Select the backup file you want to restore, and then tap Restore.

When you restore, your HP Jornada must have the same regional settings as when you
completed the backup. Otherwise, you will not be able to restore the files. To change
regional settings, on the Start menu, point to Settings, tap Control Panel, and then
double-tap the Regional Settings icon. Select your region from the drop-down list.

Using OmniSolve from Landware
OmniSolve is a financial application that offers the same features as the HP
business calculator. It is designed specifically for real estate, retail, and
business professionals who use Handheld PCs to make financial decisions



70  |  HP Jornada 600 Series User�s Guide

quickly and accurately. OmniSolve employs a “form filling” metaphor to
provide you with a rich problem-solving environment that is unparalleled in
its ease of use, power, and flexibility.

To start OmniSolve

1. On the Start menu, point to Programs, point to Accessories, and
then tap OmniSolve.

For detailed procedures about using OmniSolve, refer to online Help.

Using bFAX Pro from bSquare
You can send and receive faxes with your HP Jornada by using bFAX Pro.
bFAX Pro allows you to send documents you have created in other pro-
grams, receive faxes and view them as graphic files, and manage fax docu-
ments stored on your HP Jornada. bFAX includes bVIEW, which enables
you to preview faxes before you send them. For detailed procedures about
using bFAX Pro and bVIEW, see online Help.

Before you can send and receive faxes, you will need to connect a telephone
line to your HP Jornada and configure your modem. If you are using an
external or PC Card modem, follow the instructions included with the modem
to install and configure it for use with your HP Jornada.

For more information on connecting a telephone line to your HP Jornada and
setting dialing options, see the Connect the telephone line section in chapter 6.

To start bFAX Pro

1. On the Start menu, point to Programs, point to Communication,
and then tap bFAX Pro.

If you need to send several faxes, send them one at a time rather than all at once. The
internal modem (models 680 or 690 only) might interrupt the transmission when several
faxes are sent at one time. To send faxes one at a time, select a fax, and then on the
Fax menu, tap Send Fax. Do not click Send all Faxes in Outbox. If sending is
interrupted, you will need to perform a soft reset to disconnect the modem. For more
information, see the Resetting section in chapter 8.
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Using bFIND from bSquare
With bFIND you can search for a word or text string in any database, file,
filename, or e-mail message stored on your HP Jornada. Simply enter the
characters you want to search for in the initial bFIND dialog box, and bFIND
retrieves all occurrences of that string. bFIND is integrated with existing
programs, so, double-tapping one of the search results within bFIND
launches the program in which the string was found and opens the document
containing that search string.

bFIND includes default script files for the standard Windows CE programs,
databases, and file types. These script files help bFIND interpret search
results and drive other applications to complete the searches that are started
within bFIND. You can search any or all of the following areas:

• E-mail messages

• Contacts, Appointments, and Tasks databases

• Other databases (Pocket Access databases, for example)

• File contents (including Pocket Word and Pocket Excel files)

• File names (searches files and folders)

• bFAX packages

To start bFIND

1. On the Start menu, point to Programs, point to Accessories, and
then tap bFIND .

For detailed procedures about using bFIND, see online Help.
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Accessing e-mail | 6

With your Hewlett Packard Jornada 600 Series Handheld PC (H/PC), you can
keep in touch with your office, home, and clients through e-mail and the
Internet. You can connect in many ways using your HP Jornada and various
accessories. This chapter will guide you through the options best suited to
your needs.

This chapter provides information that allows you to:

• Decide why and how you want to connect

• Set up your HP Jornada to access personal e-mail and the Internet

• Set up your HP Jornada to access corporate e-mail and your network or
PC when you are away from the office (offsite)

• Set up your HP Jornada to access corporate e-mail and network resources
when you are in the office (onsite)

• Set up additional connections with the HP Jornada dialup application or
Remote Networking

• Use your connections with Inbox and Microsoft Pocket Internet Explorer

Deciding how and why you want to connect
The method you use for sending and receiving your e-mail, browsing the
Internet, and accessing other remote resources depends on your goals and
situation. Do you:

• Need access to personal (non-corporate) e-mail and the Internet?

• Need access to corporate e-mail and network services when you are on
the road or out of the office?

• Need access to corporate e-mail and network services when you are
onsite at your company?

• Have more than one e-mail account (for example, personal and business)?

• Want access to your CompuServe™ mail?

and the Web
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Your answers to these questions will help you determine which equipment
you can use in combination with your HP Jornada to keep in touch online.
The following illustration depicts the different solutions to your online
needs.

Which connection options are right for you?

For explanation of some of the terms used in the descriptions that follow or in the HP
dialup application, check the glossary at the end of this User�s Guide.

Accessing personal e-mail and the Internet

If you want e-mail and Internet service only (with no access to a company
network), you will need:

• An installed modem—If you have the HP Jornada 680 or 690, you have an
internal modem, so you are ready to go. If you have the HP Jornada 680e
or 690e, you can choose from a variety of available PC Card modems. (For
more information about compatible PC Card modems, go to the
HP Jornada Accessories page on the Hewlett-Packard Web site at
www.hp.com/jornada.)

http://www.hp.com/jornada
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• A PPP (Point-to-Point Protocol) or SLIP (Serial Line Internet Protocol)
account—An Internet service provider (ISP) will provide you with
important information, such as a user name, password, dial-up telephone
number, server names, and so on.

• A dial-up connection set up on your HP Jornada—HP dialup makes this
step easy.

• Access to a telephone line—You can connect to an analog telephone
line with your HP Jornada 680 or 690. Or, if you have the HP Jornada 680e
or 690e, you can connect to the telephone line supported by your PC
Card modem.

If you use the HP Jornada 680 or 690, you must use an analog telephone line to
connect your modem. Connecting to a digital telephone line can damage your modem.

Installing and configuring a modem

The HP Jornada 680 and 690 have a built-in 56K V.90 modem for easy
communication, so no installation is required. Note that the UK version of
the built-in modem does not support certain dialing properties. The built-in
modem on this model does not detect a dial tone before dialing. By default,
the Wait for dial tone before dialing box is checked. The modem will dial
even if there is no dial tone. It also does not support the pulse dial option.
The modem dials using tone dial only. By default, tone dialing is selected.

The HP Jornada 680e and 690e support a variety of available PC Card
modems.  (For more information about compatible PC Card modems, go to
the HP Jornada Accessories page on the Hewlett-Packard Web site at
www.hp.com/jornada.) Follow the manufacturer’s instructions included with
the PC Card modem to install and configure it for use with your HP Jornada.

Getting an account with an Internet service provider

To access the Internet and e-mail, you will need to contact an ISP to set up
a PPP account. SLIP accounts are offered by some ISPs instead of PPP
accounts. Your HP Jornada supports the use of SLIP as well as PPP.

Your ISP will be able to give you all the configuration information you need
to connect your HP Jornada to the Internet and e-mail service. Be sure to
note the following:

• Your account user name.

• Your account password.

http://www.hp.com/jornada
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• Telephone number of your ISP modem.

• IP and DNS addresses, if necessary.

• Your e-mail user name or ID. (This may be the same as the user name for
your ISP account.)

• Your e-mail password. (This may be the same as the password for your
ISP account.)

• The POP3 or IMAP4 host name of your ISP.

• The SMTP host name of your ISP (if required by your ISP).

Setting up a dial-up connection to your ISP

After you have established an account with an ISP, you can set up a connec-
tion on your HP Jornada and connect to the Internet and your e-mail when-
ever you want. To make this configuration process easier, use the HP Jornada
dialup application. HP dialup leads you through the process of configuring
your connections, including:

• Setting up a connection to your ISP.

• Setting up an e-mail service (if you choose E-mail service as an option).

• Setting up a Web service (if you choose Web service as an option).

• Setting up a dialing location.

The following sections describe the process that HP dialup will lead you
through and the type of information you will need to provide.

ISP connection

The first section of the setup program allows you to save and name your ISP
connection. You can create more than one connection (for example, one
connection to your corporate network and one to your personal ISP). Choose
a connection name that will make it easy to determine which connection you
want when you are ready to dial up. At this point, you will also complete the
following tasks:

Choose E-mail and/or Web service—You can choose one or both options.
Most ISPs offer both e-mail and Web services.

Choose Typical or Advanced setup—Typical setup will automate most of the
connection configuration by using default settings. Advanced setup allows
you more control over setup options. Typical and Advanced setup options
are offered at the beginning of each stage of the setup process: ISP service
setup, E-mail service setup, and Web service setup.
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Input ISP information— This includes the information you collected from
your ISP, such as the dial-up telephone number and IP, DNS, and WINS
address settings. Many ISPs automatically or dynamically assign both IP
and DNS addresses. If your ISP does not assign these automatically, you
should clear the Server-assigned addresses option and type the addresses.

When you enter the IP address, you can also choose to use SLIP if your ISP
uses this protocol. PPP is the default protocol, but SLIP is supported as well.

You also have the option to choose software and IP header compression options. Ask your
ISP if these options are recommended for your account.

E-mail service

If you choose to configure an e-mail service, HP dialup will prompt you to
enter the following information:

UserID and password—The user name (UserID) and password you use to
access your e-mail account may be the same as the user name and password
you use to connect to your ISP. However, some ISPs assign a different name
and password for this service.

Service type—Your ISP may use POP3 or IMAP4 for receiving mail. In
addition, some ISPs use SMTP (Simple Mail Transfer Protocol) for sending
messages. This is an optional setting; refer to your ISP to find out if this
applies to your configuration.

Settings—You can choose a variety of E-mail service settings. If your ISP
supports MIME (Multipurpose Internet Mail Extensions) encoding (POP3
servers only), you can select an option to allow binary files, such as graphics
and audio files, to be sent as attachments to e-mail messages. You can also
set e-mail services to:

• Disconnect after actions are performed

• Check for new mail at specified intervals

• Display a message or sound an alarm when new mail arrives

• Only display messages from a specified number of recent days

• Download only message headers (you can review headers and decide
whether to download message bodies the next time you connect)

• Download full copies of all messages (you can review messages and
decide whether to download attachments the next time you connect)
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The default options represent the settings used by many ISPs. If you are not sure, or you
do not have guidance from your ISP, try the default settings.

Fill in your E-mail service information.

Web service information

If you choose to configure Web services, HP dialup prompts you to set
options such as your Home and Search pages, AutoDial and Auto Discon-
nect, plus Advanced options. Advanced options include enabling cookies,
caching (and cache size), and security settings.

Proxy Server—Typically, a proxy server is only necessary if you are
connecting to the Internet over a network. When establishing a dial-up
connection to your ISP, you should clear the Use Proxy Server check box.

Home and Search pages—Set addresses for your Home and Search pages
using this option.

AutoDial and AutoDisconnect—These options allow HP Jornada to connect
and disconnect automatically from your ISP when an application (such as
Inbox or Pocket Internet Explorer) requires access. Remember that your
device must be connected to the telephone line before a connection is
possible.

Pocket Internet Explorer appearance—Select the appropriate check box to
show pictures, play sounds, or make the Web page fit in your device screen.
Turning off pictures and sounds can increase the speed with which Web
pages are displayed.

Advanced settings—Control some advanced Web service features with HP
dialup. You can enable cookies and caching (up to 10 percent of available
memory) and set security levels with this option.
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Advanced security settings include the option to select from two versions of
SSL (Secure Socket Layer) or PCT (Private Communication Technology).
These protocols maintain the security and integrity of the transmission
channel by using encryption, authentication, and message-authentication
codes.

When you use HP dialup to connect to your ISP, the Web options you set in HP dialup
take precedence over any options you may have set in Pocket Internet Explorer.

Location information

Your location settings set your dialing options with respect to your dialing
location. These settings include the city and state/province you are dialing
from, country code, area code, plus other dialing options. You will also be
able to save and name this group of settings as a profile, so that you can
choose among more than one profile when you dial up. For instance, you can
create one connection profile for dialing from your office and another profile
for dialing from your home.

After you collect the necessary information, you are ready to start the
HP Jornada dialup application.

To create your connection profile

1. Double-tap the HP dialup icon on your HP Jornada desktop.
The first dialog box appears.

2. Fill in the information requested in each screen.

3. When you are finished, tap Done.

After you complete this configuration process, you can select the connection
profile from the drop-down list in the HP dialup window.

If you have created one connection profile using HP dialup, you can create another by
tapping the Edit button next to the Connection box in the HP dialup window. Then,
tap Create New Connection.
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Connecting the telephone line

After you have configured your connection to your ISP, you are ready to
connect your telephone line to your built-in modem or PC Card modem and
then dial in. Use this procedure to connect to an analog telephone line.
Follow the instructions provided by your modem manufacturer to connect to
the telephone line supported by your modem.

To connect an analog telephone line to your HP Jornada

1. Connect the telephone cord to the telephone jack.

2. Connect the other end of the telephone cord to the telephone
connector on the side of your HP Jornada or to your PC Card modem
(following the instructions provided by your modem manufacturer).

If your HP Jornada has an internal modem (models 680 or 690), use the HP country
selector application to configure the modem for use with your country�s telephone system
before you connect. For more information, see the Traveling with your HP Jornada
section in chapter 7.

Dialing in

When you are ready to dial in to your ISP, use the HP dialup window.

To connect to your ISP

1. Double-tap the HP dialup icon on your desktop. The HP dialup
window appears.

2. Select a location and a connection from the drop-down boxes, and
then tap Continue.
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3. In the HP dialup dialog box, confirm the user name and password
you use to connect to your ISP, and then select the modem you will
use to dial the call.

4. Check the telephone number, and then tap Dial. A progress message
appears to tell you when you are connected to your ISP, and then
an icon appears in the taskbar while you remain connected.

After you are connected to your ISP, use the Inbox program to send and
receive e-mail or use Pocket Internet Explorer to browse the Web. (For more
information, see the Sending, receiving, and processing your e-mail and
Browsing the Web or your intranet with Pocket Internet Explorer sections
in this chapter.)

To disconnect from your ISP

1. Double-tap the HP connection icon in the status area of the taskbar.

2. In the HP dialup window, tap Disconnect.

When the HP connection icon is displayed in the status area of the taskbar,
your HP Jornada is connected to your service provider. Be sure to discon-
nect from your service provider and to unplug the phone line from your
HP Jornada when it is not in use.

Connecting to corporate e-mail and network from offsite

If you want dial-up access to corporate e-mail and Internet services when
you are offsite, you will need:

• An installed modem—If you have the HP Jornada 680 or 690, you have
an internal modem, so you are ready to go. If you have the HP Jornada
680e or 690e, you can choose from a variety of available PC Card mo-
dems. (For more information about compatible PC Card modems, go to the
HP Jornada Accessories page on the Hewlett-Packard Web site at
www.hp.com/jornada.)

http://www.hp.com/jornada
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• An account with your corporate network set for dialing in to your
network server—Your network administrator can provide you with
important information, such as a user name, password, dial-up telephone
number(s), server names, and so on.

• A dial-up connection set up on your HP Jornada—HP dialup makes this
step easy.

• Access to a telephone line—You can connect to an analog telephone line
with your HP Jornada 680 or 690. Or, connect to the telephone line
supported by your PC Card modem if you have the HP Jornada 680e or 690e.

If you use the HP Jornada 680 or 690, you must use an analog telephone line to connect
your modem. Connecting to a digital telephone line can damage your modem.

Installing and configuring a modem

The HP Jornada 680 and 690 have a built-in 56K V.90 modem for easy
communication, so no installation is required. The HP Jornada 680e and 690e
support a variety of available PC Card modems. (For more information about
compatible PC Card modems, go to the HP Jornada Accessories page on the
Hewlett-Packard Web site at www.hp.com/jornada.) Follow the
manufacturer’s instructions included with the PC Card modem to install and
configure it for use with your HP Jornada.

Establishing a network dial-up account

Before you can log on to your network using a modem, you must establish a
network account with your network administrator. Most likely, you will dial in
to a server that has a modem installed to receive your call. The information
you need for this connection is similar to the information needed to connect
to the Internet through an ISP:

• Your account user name.

• Your account password.

• Telephone number of the network server modem.

• IP, DNS, and WINS addresses, if necessary.

• Your e-mail user name or ID. (This may be the same as your network user
name.)

• Your e-mail password. (This may be the same as your network password.)

• The network POP3 or IMAP4 host name.

• The network SMTP host name (if required).

http://www.hp.com/jornada
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Setting up a remote connection to your network

After your network administrator has set up your account, you need to create
a connection on your HP Jornada so that you can connect to your network,
e-mail, and intranet (possibly including the Internet) easily whenever you want
to. Use HP dialup to create the connection on your HP Jornada. HP dialup
leads you through the process of configuring for your connections, including:

• Setting up a connection to your network.

• Setting up an e-mail service (if you choose E-mail Service as an option).

• Setting up a Web service (if you choose Web Service as an option). In this
case, the Web may be your corporate intranet or the Worldwide Web.

• Setting up a dialing location.

You will have the opportunity to set the following options during the dial-up
configuration process.

Service provider connection

This portion of the program allows you to name and save your network
connection. You can create more than one connection (for example, one
connection to your corporate network and one to your personal ISP). Choose
a connection name that will make it easy to determine which connection you
want when you are ready to dial up. At this point, you will also complete the
following tasks:

Choose E-mail and/or Web service—You can choose one or both options.
Your network administrator can tell you which options are available to you.

Choose Typical or Advanced setup—Typical setup will automate most of the
connection configuration by using default settings. Advanced setup allows
you more control over setup options. Typical and Advanced setup options
are offered at the beginning of each stage of the setup process: Service
Provider (in this case, your network administrator), E-mail Service, and Web
Service.

Input Service Provider information—This includes information provided by
your network administrator, such as the dial-up telephone number and IP,
DNS, and WINS address settings. Many networks automatically (or, dynami-
cally) assign both IP and DNS addresses. If your network does not assign
these automatically, you should clear the Server-assigned addresses option
and type the addresses.
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When you enter the IP address, you can also choose to use SLIP (Serial Line
Internet Protocol) if your network uses this protocol. PPP (Point-to-Point
Protocol) is the default protocol for this option, but SLIP is supported as
well. If you have a SLIP account, select the Use SLIP check box during the
IP setup portion of the HP Jornada dialup configuration process.

You also have the option to choose software and IP header compression options. Ask your
network administrator if these options are recommended for your account.

E-mail service

If you choose to configure an e-mail service, HP dialup will prompt you to
enter the following information:

UserID and password— The user name (UserID) and password you use to
access your e-mail account may be the same as the user name and password
you use to log on to your network. However, sometimes another name and
password are used for this service.

Service types—Your network may use POP3 or IMAP4 protocol for receiving
mail. In addition, some networks use SMTP for sending messages. Refer to
your network administrator to find out if this applies to your configuration.

Settings—You can choose a variety of E-mail service settings. If your mail
server supports MIME formatting (Multipurpose Internet Mail Extensions)
encoding (POP3 servers only), you can select an option to allow binary files to
be sent as attachments to e-mail messages. You can also set e-mail services to:

• Disconnect after actions are performed.

• Check for new mail at specified intervals.
• Display a message or sound an alarm when new mail arrives.

• Only display messages from a specified number of recent days.

• Download only message headers. (You can review headers and decide
whether to download message bodies the next time you connect.)

• Download full copies of all messages. (You can review messages and
decide whether to download attachments the next time you connect.)

The default options offer the settings used by many service providers. If you are not sure,
or you do not have guidance from your network administrator, try the default settings.
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Web service information

If you choose to configure Web services, HP dialup prompts you to set
options such as your Home and Search pages, AutoDial and Auto Discon-
nect, and Advanced options. Advanced options include enabling cookies,
caching (and cache size), and security settings.

Proxy Server—Typically, you must specify a proxy server if you are con-
necting to the Internet over a network. Check with your network administrator
to find out if you need to use a proxy server, and if so, the address of the server.

Home and Search pages—Set addresses for your Home and Search pages
using this option.

AutoDial and Auto Disconnect—These options allow HP Jornada to connect
and disconnect automatically from your Web service when an application
(such as Inbox or Pocket Internet Explorer) requires access. Remember that
your device needs to be connected to the telephone line before a connection
is possible.

Pocket Internet Explorer appearance—Select the appropriate check box to
show pictures, play sounds, or make the Web page fit in your device screen.
Turning off pictures and sounds can increase the speed with which Web
pages are displayed.

Advanced settings—Control some advanced Web service features with HP
dialup. You can enable cookies and caching (up to 10 percent of available
memory) and set security levels with this option.

Advanced security settings include the option to select from two versions of
SSL (Secure Socket Layer) or PCT (Private Communication Technology).
These protocols maintain the security and integrity of the transmission
channel by using encryption, authentication, and message-authentication
codes.
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When you use HP dialup to connect to your ISP, the Web options you set in HP dialup
take precedence over any options you may have set in Pocket Internet Explorer.

Location information

Your location settings set your dialing options with respect to your dialing
location. These settings include the city and state/province you are dialing
from, country code, area code, plus other dialing options. You will also be
able to save and name this group of settings as a profile, so you can choose
among more than one profile when you dial up. For instance, you can create
one connection profile for dialing from your office and another profile for
dialing from your home.

After you collect the necessary information, you are ready to start HP dialup.

To create your connection profile

1. Double-tap the HP dialup icon on your HP Jornada desktop.

2. Fill in the information requested in each screen.

3. When you are finished, tap Done.

After you complete this configuration process, you can select the connec-
tion profile from the drop-down list in the HP dialup window.

If you have already created one connection profile using HP dialup, you can add another
by tapping the Edit button next to the Connection box in the HP dialup window,
and then tapping Create New Connection.

Connecting the telephone line

After you have configured a connection to your network, you are ready to
connect the telephone line to your built-in modem or PC Card modem and
then to dial in. Use this procedure to connect to an analog telephone line.
Follow the instructions provided by your modem manufacturer to connect to
other types of telephone lines that may be supported by your modem.

To connect the telephone line to your HP Jornada

1. Connect the telephone cord to the telephone jack.

2. Connect the other end of the telephone cord to the telephone
connector on the side of your HP Jornada or to your PC Card modem
(following the instructions provided by your modem manufacturer).
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If your HP Jornada has an internal modem (models 680 and 690), use the HP country
selector application to configure the modem for use with your country�s telephone system
before you connect. For more information, see the Traveling with your HP Jornada
section in chapter 7.

Dialing in

Use HP dialup to dial in to your network.

To connect to your network

1. Double-tap the HP dialup icon on your desktop. The HP dialup
window appears.

2. Select a location and a connection from the drop-down boxes, and
then tap Continue.

3. In the HP dialup window, confirm the user name and password you
use to log on to your network, and then select the modem you will
use to dial the call.

4. Check the telephone number, and then tap Dial. A progress message
appears to tell you when you are connected to your network, and
then an icon appears in the taskbar while you remain connected.

After you are connected to your network, use the Inbox program to send and
receive e-mail or use Pocket Internet Explorer to browse your corporate
intranet or the Web. For more information, refer to the Sending, receiving, and
processing your e-mail and Browsing the Web or your intranet with Pocket
Internet Explorer  sections in this chapter.
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To disconnect from the network

1. Double-tap the HP connection icon in the status area of the taskbar.

2. In the HP dialup window, tap Disconnect.

Connecting to corporate e-mail and network resources
onsite

If you want corporate e-mail and Internet service only (with no access
offsite), you will need:

• An installed network interface card (NIC)—that is properly configured
with the IP address of your DNS and WINS servers. (Your network
administrator can give you this information.)

• An account with your corporate network—including an IP address for
your HP Jornada, if it is not dynamically assigned.

• A network (LAN) connection—a network cable with the appropriate
connector for your NIC.

Installing the network interface card (NIC)

Before you can connect directly to a network, you must install an NIC and
properly configure it with the IP address of your DNS and WINS servers.
(Check with your network administrator for this information.)

You must use an NIC to connect your HP Jornada directly to a LAN. NICs
are available from several manufacturers as PC Card accessories. (For a list of
recommended PC Card NICs, go to the Hewlett-Packard Web site at
www.hp.com/jornada.) Install the PC Card NIC in the PC Card slot on your
HP Jornada, and then attach the network cable according to the instructions
provided by your card manufacturer.

In addition to the PC Card NIC, you will need to install the appropriate driver
software to configure the NIC. Drivers for Proxim 7400 and Socket LP-E LAN

http://www.hp.com/jornada
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cards are included on the HP Jornada. Drivers for other cards must be
obtained from the card manufacturer. Install software drivers as you would
any other third-party program. (For more information, see the Installing
programs section in chapter 7.)

Establishing an account or guest privileges on the network

Contact your network administrator to set up an account or guest privileges
on the network. The network administrator will give you the information you
need to log on to the network just as you do with your desktop PC, including
user name, password, domain name, and IP address (if applicable).

Use the Network control panel to configure the NIC with the information
your network administrator has provided.

To configure the NIC

1. On the Start menu, point to Settings, and then tap Control Panel.

2. Double-tap the Network icon. The Network Configuration  dialog
box appears.

3. On the Adapters tab, select the driver or adapter, and then tap
Properties. Check with your network administrator if you do not
know which settings to use.

4. On the Identification  tab, enter your user name, password, and
domain name. This information will be saved, so you will not have to
type it every time you connect to a network resource.

Connecting the network cable and logging on

The final step before you can log on to the network is to connect your NIC
to the network cable. Follow the manufacturer’s instructions included with
your PC Card and contact your network administrator for further assistance.
Now, you can log on just as you do from your desktop PC.

To log on to the network with your HP Jornada

1. Insert the NIC into the PC Card slot on your HP Jornada. The
network will establish a connection automatically; once you are
connected a connection icon will appear in the status area of the
taskbar. (For more information, see the Inserting a PC Card section
in chapter 7.)



90  |  HP Jornada 600 Series User�s Guide

After you have connected your HP Jornada to the network, you can access a
file on a network file server by typing the complete path to the file in the
Windows CE address bar.

To access a file on a network

1. On the Start menu, point to Programs, and then tap Windows
Explorer.

2. Be sure the address bar is visible—on the View menu, be sure a
check mark appears next to Address Bar.

3. In the address bar, type the full network path to the file you want to
open, using the format file:///servername/share/filename.

Windows Explorer keeps a list of the most recently used Internet and network resources, so
you will not have to type the path each time. Select a network path or URL from the
drop-down list.

Creating and modifying connections

You may set up more than one connection using HP dialup; for example, you
may create separate connections for access to your personal e-mail and for
network access. After you have set up the first e-mail/Internet or network
connection, use HP dialup to create another connection. You can also use HP
dialup to modify existing connections; for instance, you may want to change
the dial-up telephone number or the dialing location.



Chapter 6  |  Accessing e-mail and the Web  |  91

To create an additional connection or location

1. Double-tap the HP dialup icon on your desktop. The HP dialup
window appears.

2. Select the location or connection that you want to modify from the
drop-down lists, and then tap Edit .

3. In the Connections or Locations dialog box, tap Create New Connec-
tion or Create New Location. The dialog boxes will appear just as
they did when you created the first connection.

4. Fill in the necessary information, according to the type of connection
you wish to make. (Refer to sections earlier in this chapter.)

5. When you are finished, tap Done. Your new connection or location
will appear in the drop-down list in the HP dialup window.

To modify an existing connection or location

1. Double-tap the HP dialup icon on your desktop.

2. Select the connection or location that you want to modify from the
drop-down lists.

3. Tap Edit .

4. In the Connection or Location dialog box, tap Modify .

5. Make the modifications you want, and then tap Done to save your
changes.

Creating connections without the HP Jornada dialup application

You can also create connections to your ISP or network by configuring the
necessary programs manually. Before you can dial up, you will need to:

• Install and configure a PC Card modem (models 680e and 690e only).
Follow the instructions provided by your modem manufacturer.

• Establish an account with an Internet Service Provider (ISP) or your
corporate network administrator (for remote access to your corporate
network). Note the same information that is presented in the previous
sections in this chapter.

• Set up a Remote Networking connection.

• Set dialing patterns and dialing locations.
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• Set up an e-mail service in Inbox and/or a Web service in Pocket Internet
Explorer. For more information, see the Using Inbox and Browsing the
Web or your intranet with Pocket Internet Explorer  sections later in this
chapter.

• Connect your HP Jornada to a telephone line.

To set up a Remote Networking connection

1. If your HP Jornada does not have a built-in modem, install a PC Card
modem.

2. Get the following information from your service provider (ISP or
network administrator): dial-up access telephone number, user name,
password, and domain name.

3. On the Start menu, point to Programs, point to Communication, and
then tap Remote Networking.

4. Double-tap the Make New Connection icon. The Make New Connec-
tion dialog box appears.

5. Enter a name for the connection, such as “Corporate Dial-Up,” tap
Dial-Up Connection, and then tap Next.

6. Select your modem type from the list. You should not need to change
settings in the Configure or TCP/IP Settings dialog boxes (if you
are not sure, check with your network administrator). When you are
finished, tap Next.

7. Enter the access telephone number and tap Finish.

Once you have created the dial-up connection, simply double-tap the
connection, enter your user name, password, and domain, and tap Connect
any time you want to connect. Once connected, you can use Pocket Internet
Explorer to visit Web pages and use Inbox to send and receive e-mail. Before
you can use Inbox, you need to set up an e-mail service. See the Using Inbox
section later in this chapter.

To set a dialing location for a Remote Networking connection, double-tap the icon for the
connection in the Remote Networking folder. In the Dial-up Connection dialog box,
tap Dial Properties, and then fill in the information as you would for a network or ISP
connection using HP dialup.
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Using your connections
After you have set up for the connection that best meets your needs, you
are ready to use that connection for sending and receiving e-mail, browsing
the Web, or receiving your CompuServe mail.

Using Inbox

You can use the Inbox program to send and receive e-mail over the Internet
with your HP Jornada. You can also exchange e-mail over your company’s
intranet, either by remote dial-up (using your modem) or by direct connection
(with an NIC). Using Windows CE Services, you can synchronize information
in Microsoft Outlook, Microsoft Schedule+, or Microsoft Exchange on your
desktop computer with your HP Jornada. Each time you synchronize,
Windows CE Services compares the changes you made on your HP Jornada
and desktop PC and updates both computers, including changes to the
messages in your Inbox. For more information, see chapter 3, Connecting to
your desktop or refer to online Help.

HP dialup automatically sets up an Inbox service for you. However, you can also set up
Inbox services from within the Inbox program.

To set up e-mail service (Internet Mail)

1. Get the following information from your ISP or network administrator:
POP3 or IMAP4 server name, SMTP host name, user name, pass-
word, and domain name (for network connections only).

2. On the Start menu, point to Programs, point to Pocket Outlook,
and then tap Inbox.

3. In Inbox, on the Services menu, tap Options.

4. On the Services tab, tap Add.

5. Choose IMAP4 Mail  or POP3 Mail, enter a name for the connection,
and then tap OK .

6. In the Mail Service Definition dialog box, enter the information from
step 1. Select the remote connection you want to use from the
Connection list, and then tap Next. (If you are receiving e-mail
through a network connection, tap Network Connection.)
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7. If you have not created a connection, tap Create new connection,
double-tap the Make New Connection icon, and follow the instruc-
tions in the wizard. When finished, tap Inbox in the taskbar and
continue setting up the Inbox. For more information, refer to the
Remote Networking topic in online Help.

8. If this is the first time you have created an e-mail service, click No in
the Enable Address Issue dialog box.

9. In the Mail General Preferences dialog box, select the desired
options, and then tap Next.

10. In the Mail Inbox Preferences dialog box, select the desired
options:

• Under When Getting Messages, choose how you want mes-
sages downloaded by default. Choosing Get full copy of
messages will take up more storage space on your HP Jornada.
Choosing Only synchronize Inbox folder hierarchy (IMAP4
only) will speed up the time it takes to download your messages.

• Under When Getting Full Copy, choose whether you want to
download file attachments and meeting requests when you get
full copies of messages. This setting applies whether you have
chosen to download full copies of messages by default, or if you
selectively download full copies of messages by opening the
message and tapping the Get Full Copy button. In addition, if
you want to receive meeting requests, your Exchange Server
administrator must enable support for Rich Text Format for your
account.

For more information about Inbox settings, see the Inbox settings
section later in this chapter.

Sending, receiving, and processing your e-mail

You can use a dial-up connection to send messages directly from your
HP Jornada, or you can use Inbox synchronization to send the messages
you compose on your HP Jornada from your desktop computer (see the
Synchronizing data section in chapter 3).

If you send messages directly from your HP Jornada, you will first need to
configure a connection to your ISP or network, and then set up an e-mail
service. You can use the HP dialup application to set up both the connec-
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tion and the e-mail service, or you can create a connection using Remote
Networking, and then set up the e-mail service in Inbox.

After you have created the connection and e-mail service, use Inbox to
connect to your service provider and retrieve your mail.

To connect to your service provider from Inbox

1. On the Services menu, tap the connection you would like to dial.

2. Type your user name, password, and domain name, if necessary.

3. Tap Dial Properties if you need to modify a location or choose a
different one.

4. Tap Connect. A message will appear to show you the status of your
connection. When your connection is established, you can send and
receive mail.

You can connect to your e-mail account and download messages to your HP Jornada even
if your desktop PC (partner) e-mail service is not Outlook or Exchange (for instance, if your
e-mail service is Lotus Notes). However, you can only synchronize with your desktop PC
mail if your desktop PC uses Outlook or Exchange as its mail client.

Inbox settings

When you connect to a mail server, the messages on your device and mail
server are synchronized: new messages or message headers are downloaded
to the HP Jornada Inbox folder, messages in the HP Jornada Outbox folder
are sent, and messages that have been deleted from your Inbox are removed
from the server.

You can set Inbox to download all your messages or only new message
headers to the Inbox folder. By default, only messages from the last 3 days
will be downloaded.

Downloading only message headers saves storage space and requires less
connect time. By default, only message headers and the first 100 lines of text
are downloaded, and the original messages remain on the mail server. If you
read a message header and decide that you want the full copy, tap the Get
Full Copy button on the Inbox toolbar. The full text of the message will be
retrieved the next time you connect.
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To change the default settings, or to set options for retrieving file attach-
ments and meeting requests, tap Options on the Services menu, select the
service you want to modify, and then tap Properties. Inbox displays three
tabs with options for the selected service.

Attachments

When you send an attached file, such as a Pocket Word file, be sure the
recipient can read the file type you are sending. Pocket Word files (.pwd) can
only be read by other Windows CE devices such as the HP Jornada. You can
choose to save the file as .txt or .rtf if you are unsure, or you can choose to
save the file as a Word file (.doc). For information about the file types
associated with a particular program, refer to the Pocket Office section in
chapter 5.

MIME settings

By default, Inbox uses MIME encoding when sending attachments from
 e-mail services that use the POP3 protocol. If you experience problems
sending or receiving file attachments, try disabling the MIME encoding.

To disable MIME encoding

1. In Inbox, on the Services menu, tap Options, and then select the e-
mail service from the Installed services list.

2. Tap Properties, and then tap Next.

3. In the General Preferences dialog box, clear the Send using MIME
format check box.

For detailed descriptions of the settings related to reading and sending e-
mail attachments, see the Inbox topic in online Help.

If you choose to download attachments along with your messages, you can
save them on your HP Jornada or storage device. To save memory, you can
save attachments automatically to a storage card.

To save attachments automatically to a storage card

1. On the Services menu, tap Options.

2. On the Storage tab, select the External Storage Card radio button.
Tap OK .
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Message deletion

When you delete messages from your HP Jornada while you are still con-
nected to your service provider, the messages will be deleted from the server
as well. If you delete the message after you disconnect, the message will be
deleted from the server the next time you connect.

Message deletion is permanent. Deleted messages are not moved to the
Recycle Bin, and they cannot be recovered.

When you delete a message, any files attached to the message are also
deleted. To save a file attachment before you delete the message, open the
file attachment in the program that created it (for example, Pocket Word), and
then tap Save As on the File menu. See online Help for more information.

Browsing the Web or your intranet with Pocket
Internet Explorer

You can use Pocket Internet Explorer to browse the Web or your corporate
intranet with your HP Jornada. Pocket Internet Explorer allows you to view
Web sites in their entirety directly on your HP Jornada. Download forms from
your corporate intranet and save them for later use, or save your favorite
online news page to read later when you are offline.

After you have set up an online connection with your ISP or your network
account, you are ready to dial up and start browsing the Web or your
intranet. You can set Pocket Internet Explorer to automatically dial a connec-
tion you create whenever you use Pocket Internet Explorer.

If you did not use HP dialup to create your ISP or network connection, you must set up a
Remote Networking account first. (See the Creating connections without HP dialup section
in this chapter.)

If you set up the Web service using HP dialup, you can set different Web
browsing options and preferences for each connection; the options you set in
HP dialup determine the way Web pages are displayed. If you change options
in Pocket Internet Explorer, the settings remain in effect only for the current
Web session; the changes are not saved. If you use Remote Networking to
connect, you must set options in Pocket Internet Explorer, and these settings
will be used each time you connect.
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To edit or set connection information in Pocket Internet Explorer

1. In Pocket Internet Explorer, on the View menu, tap Options.

2. In the Options dialog box, on the AutoDial  tab, tap AutoDial .

3. Choose the remote dial-up connection to be used.

4. Tap Auto Disconnect if you wish to disconnect automatically from
the Internet after a specified period of idle time.

5. Use the other Options tabs to set information such as Appearance,
Default Pages, Proxy Server, and Advanced features.

6. When you are finished, tap OK  to save the changes.

If you set up AutoDial in Pocket Internet Explorer, you can connect to the
Internet simply by starting the program and entering the address of a Web
site. (Be sure your telephone line is connected properly first.) If you prefer to
dial up independently of Pocket Internet Explorer, you may want to clear the
AutoDial option. To connect using HP dialup, use the following procedure.

To browse the Web or your intranet

1. Double-tap the HP dialup icon on your desktop.

2. In the HP dialup window, select a location and a connection from the
drop-down boxes, and then tap Continue.

3. In the Dial dialog box, confirm the user name and password you use
to connect to your ISP or network and select the modem you will use
to dial the call.
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4. Check the telephone number, and then tap Dial. A progress message
appears to tell you when you are connected to your ISP or network.

5. After you connect to your ISP or network account, you may use
Pocket Internet Explorer to browse.

If you did not use the HP Jornada dialup application to create your connection, you will
need to activate the connection you want in Remote Networking. On the Start menu,
point to Programs, point to Communication, and then tap Remote
Networking. In the Remote Networking folder, double-tap the icon of the connection
you want. Tap Connect to begin dialing.

Although it includes most of the features of the Internet Explorer Web
browser, Pocket Internet Explorer has been streamlined to work efficiently on
the compact HP Jornada. Animations are not displayed on your HP Jornada.
Animated graphics may appear as a single still frame, or may not appear at all.
You may also have difficulty viewing Web pages that require ActiveX
controls or plug-ins. For more information about using Pocket Internet
Explorer, refer to online Help.

Retrieving your CompuServe mail

If you are a member of CompuServe, you can use Inbox to receive your
CompuServe e-mail on your HP Jornada. To do this, you will need to:

• Use the Web browser and Internet account on your desktop PC (partner)
to go to the CompuServe Web site at www.csi.com/communications.

• Follow the instructions that are provided at that site for creating a POP3
mailbox. Be sure to choose a mailbox password that your HP Jornada can
support; that is, use only letters and numbers in your password.

• Create a connection with HP dialup on your HP Jornada. You will have all
the account information you need when you finish creating your POP3
mailbox at the CompuServe site.

• Set up (and name) the Inbox mail service connection. See the Using Inbox
section in this chapter.

After you have completed these initial setup procedures, you will be able to
send and receive your CompuServe e-mail just as you would with any other
Internet e-mail account.

If you have an account with another online service, check with the service
provider to see if the service supports access via Windows CE.

http://www.csi.com/communications
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Optimizing your  | 7

This chapter details ways you can optimize your HP Jornada using Control
Panel and HP Utilities, and ways you can expand the features and functional-
ity of your HP Jornada by adding software and accessories. This chapter
also offers tips on traveling with your HP Jornada and keeping your
HP Jornada safe. These tips will help you become more efficient and make
working with your HP Jornada more comfortable and fun.

In the following pages, you will learn about:

• Adding to your HP Jornada—Add programs, fonts, sounds, and desktop
wallpaper.

• Using accessories—Use CompactFlash and PC Cards with the expansion
module.

• Managing memory—Learn how to allocate storage and program memory
for optimal performance.

• Managing battery power—Learn how to replace, and how to get the most
from your batteries.

• Fine-tuning performance—Use control panel to set various options,
including customizing the HP hot keys and setting general system
settings.

• Traveling with your HP Jornada—Follow simple guidelines for optimizing
your device for use while away from the office, including a check list of
everything you need to take with you.

• Protecting your HP Jornada—Safeguard your HP Jornada from theft and
data loss.

• Creating system macros—Automate common tasks with the HP macro
utility.

HP Jornada
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Adding programs, fonts, sounds, and images
This section describes how to add functionality to your HP Jornada by
installing software and how to customize the Windows CE desktop and
working environment.

Installing programs

You can add even more functionality to your HP Jornada by installing third-
party software. A wide variety of commercial software is available for the
Microsoft Windows CE operating system, ranging from custom business
applications and system utilities to games and entertainment. Some programs
are available on the HP Jornada Handheld PC compact disc and the Desktop
Software for Microsoft Windows CE compact disc included with your
HP Jornada. Other programs are available from software distributors and on
the Worldwide Web.

The only programs that will run on your HP Jornada are those designed specifically for
Windows CE.  You cannot run programs designed for Windows 95 or Windows NT on your
HP Jornada.

The HP Jornada Handheld PC compact disc includes many productivity-
enhancing programs such as:

• Inso® Outisde In® file viewer software for viewing popular desktop file
formats

• Pocket Quicken™ from On The Go Software (for U.S. only)

• TrueSync® CE 2.0 from Starfish Software for synchronizing your
HP Jornada with the REX™ Classic and REX Pro Cards

• Trio Phone Manager for sending/receiving SMS with a GSM phone (for
Europe and Asia Pacific only)

• WestTek™  JetCet™  color printing utilities ( 30-day trial)

• Image Expert CE from Sierra Imaging

• Java for Windows CE from Microsoft Corporation

• HP PIM Translation Utility

The minimum system requirements for installing programs from the
HP Jornada Handheld PC compact disc are as follows:

• Microsoft Windows 95, Windows 98, or Windows NT 4.0
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• Desktop PC with a 486/66 or higher processor

• 2X or faster CD-ROM drive

• VGA or higher resolution graphics card

• Web browser (Netscape Navigator 2.0 or higher or Microsoft Internet
Explorer 2.0 or higher)

Explore the HP Jornada Handheld PC compact disc to enjoy these free
software programs. For more information about a particular program, go to
the Web site of the manufacturer of that program.

Many other useful programs are available from the Hewlett-Packard Web site
at www.hp.com/jornada. Hewlett-Packard does not support the use of
programs that have not been certified by Microsoft.

Typically, you install software to your H/PC by first loading the installation
files onto your desktop PC, as described in the following procedure.

If a program is designed for direct installation, you may be able to download or install
the program from the Web to your HP Jornada. The Web site should provide instructions
for installing the program.

To install software

1. Download the software program or installer from the Web to your
desktop PC.
–or–
Insert the floppy disk or compact disc into the appropriate drive on
your desktop PC.

2. Connect your HP Jornada to your desktop PC using the docking
cradle or sync cable and establish a partnership. (For more informa-
tion, see chapter 4.).

3. If the program includes an installer program (typically named
Setup.exe or Install.exe), double-click the installer program on the
desktop PC. The installer program will copy the necessary files to
your HP Jornada.
–or–
If the program does not have an associated installer or setup
program, drag the program file (typically an *.exe file type) to the
HP Jornada icon in the Mobile Devices window. If the No converter
selected dialog box appears, click OK to copy the file without
conversion.

http://www.hp.com/jornada
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4. If prompted by the installer, perform a soft reset of your H/PC. For
more information, see the Resetting section in chapter 8.

Install software by dragging the program file to the Mobile Devices window only if no
installer program is available. Software installed in this way may not appear on the
Remove Programs list, and you may have to manually delete the program if you wish
to remove it from your HP Jornada.

After you have installed a program on your HP Jornada, you can use Win-
dows CE Application Manager to remove the program or to reinstall the
program after it has been removed. If you do not have enough storage
memory on your HP Jornada, you may want to use Application Manager to
temporarily remove programs you no longer use or programs that you use
infrequently.

To add or remove programs with Application Manager

1. Connect your HP Jornada to your desktop PC, and then open the
Mobile Devices window.

2. On the Tools menu in the Mobile Devices window, click Application
Manager.

3. In the list of programs, select the program you wish to install, and
then click Add.
–or–
Select the program you want to delete, and then click Remove.

Removing programs

You can use either Application Manager (on your desktop PC) or the Remove
Programs control panel (on your HP Jornada) to remove programs.

To remove a program from your HP Jornada with the Remove
Programs control panel

1. On the Start menu, point to Settings, and then tap Control  Panel.

2. Double-tap the Remove Programs icon.

3. In the Programs list, select the program you want to remove.

4. Tap Remove.

Programs stored in ROM cannot be removed. (For a list of these programs see the
HP Jornada programs section in chapter 1.)
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Adding fonts

Your HP Jornada comes with a selection of built-in fonts. You can add
Windows fonts (.fon files) or TrueType fonts (.ttf files) to your HP Jornada for
use in Pocket Word documents and Pocket Excel spreadsheets. Because fonts
take up a significant amount of storage memory, install only the fonts you
need, and delete those you do not need. (The built-in fonts cannot be
deleted.)

To add fonts

1. Connect your HP Jornada to a desktop PC, and then start Windows
CE Services.

2. In Windows Explorer on the desktop PC, select the font files you
want to copy.

3. Drag the font files to the Windows folder on your HP Jornada. If you
are copying a Windows font, you will be prompted to select the
point sizes and styles you want to copy.

Adding sounds

Your HP Jornada can play Wave sounds (.wav files). You can copy a sound
file from your desktop PC to your HP Jornada without converting the file. If
you want to use a sound as part of a sound scheme or to signal an alarm or a
reminder, copy the sound file to the Windows folder on your HP Jornada. For
more information, see the Setting Alarms topic in online Help.

Adding desktop wallpaper

Your HP Jornada can display 256-color bitmap images (.bmp files) or Windows
CE bitmaps (.2bp files). You can copy bitmap images from your desktop PC to
your HP Jornada without converting the files, and you can use these images
as desktop wallpaper on your Windows CE desktop.

To add desktop wallpaper

1. Connect your HP Jornada to a desktop PC and start Windows CE
Services.

2. Drag the bitmap image you want to copy from its location on your
desktop PC to the HP Jornada icon in the Mobile Devices window.

3. On your HP Jornada Start menu, point to Settings, and then tap
Control Panel.
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4. Double-tap the Display icon.

5. On the Background tab, tap Browse, and then select the bitmap file
to display as your background.

Accessories
The following optional accessories also are available
from Hewlett-Packard. (HP item numbers are listed in parentheses.) Check the
Hewlett-Packard Web site at www.hp.com/jornada for updates to this list.

• Extended Battery (HP F1282A)—Provides up to 24 hours of battery life
(depending on usage)

• External Keyboard (English US keyboard only; HP F1275A)—Highly
portable keyboard supports touch-typing and includes soft case

• Leather case (HP F1227A)—Protects your HP Jornada in style

• External Charger (HP F1284A)—Allows simultaneous charging of your
HP Jornada and an additional battery

• Parallel printer cable (HP F1274A)—Allows connection to PCL3 printers
(For a list of recommended printers, see the HP Web site.)

• HP VGA out card (HP F1252A)—Enables you to connect your HP Jornada
to an external monitor or projector for presentation

• Serial adapter (HP F1295A)—Provides a standard 9-pin mechanical
interface

Using PC Cards and CompactFlash Cards

PC Cards and CompactFlash Cards provide a wide range of additional
functionality, such as additional memory, removable storage, connection to
an external monitor, or connection to a network. Many cards have been
tested specifically for compatibility with the HP Jornada. For a list of recom-
mended compatible cards, go to the Hewlett-Packard Web site at
www.hp.com/jornada.

Before you can use a particular card, you may need to install the software
driver for that card. The software drivers for the Windows CE operating
system should be included with the card or be available from the card’s
manufacturer. Install software drivers as you would any other software or
program. For more information, see the Installing  programs section in this
chapter.

http://www.hp.com/jornada
http://www.hp.com/jornada
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Non-memory CompactFlash Cards that require a cable connection (for example, network
interface cards, pagers, or modem cards), must be inserted in the PC Card slot rather than
the CompactFlash Card slot. To insert a CompactFlash Card into the PC Card slot, you will
need a PC Card adapter. For a list of recommended PC Card adapters, go to the Hewlett-
Packard Web site at www.hp.com/jornada.

Installing a PC Card or CompactFlash Card

When you install expansion cards, the PC Card and CompactFlash memory
modules appear as folders in the My Handheld PC folder. If you have two
cards installed, the folder called Storage card1 represents the first card you
installed, and the folder called Storage card2 represents the second card. In
some cases, additional folders may appear; for example, Storage card3,
Storage card4, etc. You can eliminate unused folders by performing a soft
reset. (For more information, see the Resetting section in chapter 8.)

Many PC Cards use considerable power, and can quickly drain your battery. Connect to AC
power while using PC Cards.

The HP Jornada has a unique expansion module with two slots to accommo-
date both a PC card and a CompactFlash Card in a small, portable size. You
can install either a PC Card or CompactFlash Card, or install both at the same
time.

PC Card

The PC Card fits in the slot on the left side of the HP Jornada.

To install a PC Card

1. Carefully slide the card into the PC Card slot. The expansion module
will extend from the bottom of the unit.

http://www.hp.com/jornada
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To remove a PC Card

1. Press the PC Card release tab. Do not obstruct the slot opening or
hold down the expansion module. The PC Card will be pushed out of
the slot slightly.

2. Grasp the PC Card and pull it completely out of the slot. When using
thicker PC Cards (for instance PCMCIA I/O Cards), you may initially
feel some slight resistance when pulling out the card.

3. After you have removed the card, ensure that the expansion module
recedes back into the device. Gently push it into the device, if
necessary.

4. Fold the PC Card release tab back into the side of the device.

CompactFlash Card

The CompactFlash Card slot is located at the bottom of the unit, on top of
the PC Card slot. Pressing the latch-bar will flip open the slot door.

To install a CompactFlash Card

1. Press the latch-bar located at the opening of the slot with your finger
while holding down the opposite end of the expansion module with
your thumb, as shown in the diagram below.
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2. Slide the CompactFlash Card into the slot. The finger pull (raised
edge) on the CompactFlash Card should face up, and the main label
down.

3. Close the expansion module by pushing down until it clicks into
place.

To remove a CompactFlash Card

1. Press the latch-bar located at the opening of the expansion module
with your finger. The expansion module will spring open.

To open the expansion module when taking out an installed CompactFlash Card, you may
find it convenient to use the stylus instead of your finger to push down into the groove
between the CompactFlash Card and the latch-bar.

2. Remove the CompactFlash Card. Insert your fingernail into the notch
on the card to pull the card from the unit.

Do not use excessive force when opening the expansion module or when installing or
removing a PC Card or CompactFlash Card.

Using the auto run feature

Your HP Jornada includes an auto run feature, which enables you to automati-
cally start a program stored on a PC Card or CompactFlash Card simply by
inserting the card into your HP Jornada. This feature is designed for use by
advanced users.

To use the auto run feature, create a text file named Autorun.inf and copy the
file to the PC Card or CompactFlash Card. The Autorun.inf file contains the
command to start a single program that is also stored on the PC Card or
CompactFlash Card.
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To create an auto run file

1. Install the PC Card or CompactFlash Card containing the program you
want to run automatically. (See instructions earlier in this chapter.)

2. In Pocket Word, create a document containing the following text:

[autorun.sh3]
open=filename.exe

where filename.exe is the name of the program (.exe file) in the root
directory of the PC Card or CompactFlash Card.

3. On the File menu, tap Save As.

4. Under Name, type autorun.

5. Under Type, select Unicode Text Document.

6. Browse to the root folder of the PC Card or CompactFlash Card, and
then tap OK .

7. In Windows Explorer, browse to the root folder of the PC Card or
CompactFlash Card.

8. Select the file Autorun.txt, and then tap Rename on the File menu.

9. Rename the file Autorun.inf.

The next time you insert the PC Card or CompactFlash Card, the program you
named in the Autorun.inf file will start automatically.

To prevent the program on the PC Card from starting automatically, hold down the shift

key as you insert the PC Card or CompactFlash Card.

Managing memory
The memory on your HP Jornada is allocated between storage memory and
program memory. You can specify how much of the total memory is used for
storage and how much is used for running programs. If you notice that your
HP Jornada is running slowly or that your programs do not run consistently,
try increasing program memory. If you need more memory for files and docu-
ments, increase storage memory.

On models 690 and 690e, a maximum of 16MB can be designated as storage memory.
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To adjust memory allocation

1. Exit any applications that are running.

2. On the Start menu, point to Settings, and then tap Control  Panel.

3. Double-tap the System icon.

4. On the Memory tab, move the slider to the left to increase program
memory, or move the slider to the right to increase storage memory.

You may be able to make more memory available by refreshing your system
memory.

To refresh your system memory

1. Close all open documents and exit any applications that are running.

2. Use the stylus to press the reset button on the left side of the
keyboard, performing a soft reset.

For more information, see the Resetting section in chapter 8.

The Recycle Bin on your HP Jornada desktop works in the same way as the
Recycle Bin on your desktop PC. When you delete a file on your HP Jornada,
the file is moved to the Recycle Bin. It is not actually removed from memory
until you empty the Recycle Bin.

You can set options that limit the amount of memory reserved for the Recycle
Bin or to bypass the Recycle Bin and delete files immediately.

To set Recycle Bin options

1. Hold down alt  as you tap the Recycle Bin icon.

2. On the pop-up menu, tap Properties.

Tips for conserving memory

• Synchronize only one or two weeks of Calendar data and only selected
Contacts or Tasks. (For more information, see the Synchronizing selected
data section in chapter 3.)

• Set options in Inbox to download only message headers and not to
download attachments. (For more information, see the Using Inbox section
in chapter 6.)

• Use Application Manager to remove programs you do not need (see the
Installing programs section in this chapter).
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• Remove fonts, sounds, and wallpaper you do not need.

• Delete files and voice memos you do not need, or transfer them to your
desktop PC for storage and delete them from your HP Jornada.

You can increase the storage memory by adding a memory module on a CompactFlash or
PC card. For more information, see the Accessories section in this chapter.

Managing battery power
Because the data and files you save on your HP Jornada are stored in RAM,
it is extremely important that you maintain a continuous power supply to
your HP Jornada at all times. If your HP Jornada runs out of power, all informa-
tion you have entered will be lost. The Windows CE operating system and
programs are stored in ROM, and cannot be erased; however, any programs
you have added and custom settings in existing programs will be lost.

Data stored on a PC Card or CompactFlash Card will be saved, even if your H/PC loses
power. To protect your data, back up regularly to a PC Card or CompactFlash Card by
using HP backup.

HP Jornada uses two types of batteries. The main battery supplies power
whenever your HP Jornada is not connected to AC power. The backup
battery protects your data when the main battery is not installed (for in-
stance, while you exchange the main battery).

Main battery

The main battery is the HP Jornada Standard Battery, a rechargeable lithium
ion battery pack. Use only the HP Jornada Standard Battery (HP F1281A) or
the HP Jornada Extended Battery (HP F1282A) with your HP Jornada. These
batteries are designed only for use with the HP Jornada 600 series H/PC and
should not be used to power other devices.

Under normal circumstances, the main battery will provide up to 7 hours of
continuous use without recharging. Actual battery life will vary depending
on screen brightness, what applications you use, and operating conditions.
When the main battery runs very low, your HP Jornada will shut down, and
you will be unable to restart it until you replace the main battery, recharge
the battery, or connect to AC power.



Chapter 7  |  Optimizing your HP Jornada  |  113

When you replace the main battery, your new battery must be charged before
your HP Jornada will turn on. For information on charging the main battery,
refer to the Connecting the AC adapter section in chapter 2.

Ensure that the backup battery is in good condition before you remove the main battery. If
the backup battery is low or you are not sure, connect to AC power before you remove the
main battery.

To replace the main battery

1. Turn off your HP Jornada and disconnect the sync cable if it is
attached.

2. Slide the audio lock to the left if it is unlocked. (No green dot should
be visible. The green dot indicates that the audio buttons are un-
locked.)

3. Slide the battery release button on the bottom of the HP Jornada.

4. Pull the original battery pack away from the device.

5. Insert the new battery pack and push firmly until it clicks into place.

Backup battery

The coin-sized, lithium ion backup battery does not provide enough power to
operate your HP Jornada. It is intended only to protect your data until the
main battery is recharged.

Ensure that the main battery is charged before you remove the backup battery. If the main
battery is low or you are not sure, connect to AC power before you remove the backup
battery.

To replace the backup battery

1. Using a small, Philips screwdriver, unscrew the cover plate from the
backup battery compartment. Be careful not to misplace the small
screw.

2. Remove the backup battery.

3. Insert a new 3-V CR2032 coin cell battery into the backup battery
compartment with the positive (+) side facing up.

4. Replace the cover plate and the screw.
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Do not mutilate, puncture, or dispose of batteries in fire. The batteries can burst or
explode, releasing hazardous chemicals. Replace batteries with only the types
recommended in this User�s Guide. Discard used batteries according to the manufacturer�s
instructions.

Using the Power control panel

Use the Power control panel to check the status of your main and backup
batteries and to set options that can increase battery life. These include
setting options for power off or auto-suspend, setting options for power on,
and setting controls to automatically dim the backlight.

To open the Power control panel

1. On the Start menu, point to Settings, tap Control Panel, and then
double-tap the Power icon.
–or–
Double-tap the power status icon in the status area of the taskbar.

The power status icon appears in the taskbar only under certain conditions, such as when
battery power is low or when your HP Jornada is connected to external power.

Checking battery status

The power area in the Power control panel indicates whether your HP Jornada
is running on battery power or connected to AC power, and displays the
status of both the main and backup batteries. In addition, the battery icon in
the status area of the taskbar indicates whether the HP Jornada is operating
on AC or battery power and displays the status of the main battery:

Icon Indicates

Running on AC power

Main battery charging

Running on battery power, main battery low

Backup battery low

Backup battery very low
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It is important that you respond immediately when a message warning of low battery
power is displayed. When the main battery is low, simply connect the HP Jornada to AC
power to recharge. (You can use your HP Jornada while the battery is charging.) When the
backup battery is low, replace it as soon as possible. It is recommended that you back up
your data and run the HP Jornada only on AC power until you have replaced the backup
battery.

Conserving battery power

Under normal circumstances, the HP Jornada Standard Battery should provide
up to 7 hours of continuous use; however, certain tasks require more battery
power and deplete the main battery faster. Follow these tips to maximize
battery life.

Setting auto-suspend

To conserve battery power, Windows CE will automatically turn off or suspend
your HP Jornada after a period of continuous idle time.

To set or shorten auto-suspend time

1. On the Start menu, point to Settings, tap Control  Panel, and then
double-tap the Power icon.
–or–
Tap the HP settings hard icon, and then tap the battery icon on the
Settings tab.

2. On the Power Off tab, select Enable suspend while on battery power.

3. In the box that appears, set the time interval before auto-suspend.

The default idle time is 3 minutes. To change the idle time, select a
number from the list. Increasing the idle time may decrease your
battery life.

Select Enable suspend while on AC line power if you want to suspend your
HP Jornada when it is connected to AC power. You may suspend your HP Jornada while
the main battery is being recharged.
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Setting power on options

You can also set options to automatically turn on your HP Jornada when you
touch the screen or open the lid; however, these options will not cause your
HP Jornada to turn off (for example, when you close the lid).

To set power on options

1. On the Start menu, point to Settings, tap Control  Panel, and then
double-tap the Power icon.
–or–
Tap the HP settings hard icon, and then tap the battery icon on the
Settings tab.

2. On the Power On tab, select options for turning on your HP Jornada.

Setting the dimming control

Dimming the backlight on your HP Jornada display can conserve battery
power. Use the Dimming Control  tab to set options for automatically dimming
the backlight while on battery power or while connected to AC power.

To set automatic dimming

1. On the Start menu, point to Settings, tap Control  Panel, and then
double-tap the Power icon.

2. On the Dimming Control  tab, select Automatically dim while on
battery power and/or Automatically dim while on AC power.

3. Select a time interval from the list to set how long your HP Jornada
must be idle before the backlight is dimmed.

Other tips for conserving battery power

• Reduce the brightness of the display—Compensate for low light by
increasing the contrast. (See the Using the HP settings application
section in this chapter.) Use the Power control panel to set the auto-
dimming feature.

• Suspend frequently—Use the Power control panel to shorten the length
of continuous idle time before your HP Jornada auto-suspends. Press the
On/Off key or tap Suspend on the Start menu to turn off your HP Jornada
when it is not in use, even for a short time.

• Always use AC power when connecting your HP Jornada to your desktop
PC—Note that your HP Jornada will not auto-suspend while it is con-
nected.
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• Turn off sounds—Use the HP settings application to mute the HP Jornada
speaker, or use the Sound & Volume control panel to turn on only the
most necessary system sounds.

• Avoid using PC Cards while on battery power—Some PC Cards (espe-
cially PC Card modems) use considerable power and will quickly drain
your battery.

Use the AC adapter to plug your HP Jornada into external power whenever possible,
especially when connecting to a desktop PC, when using a PC Card modem, network
interface card (NIC), or other peripheral. Do not let the alarm notification LED flash for a
long time.

Fine-tuning performance
This section offers information that will help you  customize your HP Jornada
to match your working style.

Setting general options

As on your desktop PC, use Control Panel to change most of your
HP Jornada options.

To open Control Panel

1. On the Start menu, point to Settings, and then tap Control Panel.

Double-tap any of the icons in Control Panel to explore the options for that
feature. Specific Control Panel options are described below. For more informa-
tion about a particular control panel, see the Settings topic in online Help.

• Communications—Use the Communications control panel to set options
for establishing a connection between your HP Jornada and desktop PC.

• Dialing—Use the Dialing control panel to manually create dialing
locations and set dialing options for connecting to a service provider or
remote computer.

• Display—The Display control panel allows you to set the background
image and the appearance of your Windows CE desktop.

• Keyboard—The Keyboard control panel allows you to set options for
how quickly characters repeat when you hold down a key on your
HP Jornada keyboard.



118  |  HP Jornada 600 Series User�s Guide

• HP backup—Use the HP backup control panel to back up or restore data
when you are away from your desktop PC. For more information, see the
Backing up your data section in chapter 5.

• HP hot keys—Use the HP hot keys control panel to customize your
HP Jornada hot keys and hard icons. For more information, see the
Customizing the HP hot keys and hard icons section in this chapter.

• Owner—The Owner control panel allows you to store personal informa-
tion, such as your name and address, and to choose whether to display
this information each time you turn on your HP Jornada.

• Network—Use the Network control panel to configure your network
interface cards and drivers, and to type your user name and password for
connecting to a network.

• Password—The Password control panel allows you to protect data stored
on your HP Jornada with a password. You can choose to be prompted to
enter the password each time you turn on your HP Jornada.

• Power—The Power control panel is the place to check the condition of
your batteries and set options that can conserve battery power. For more
information, see the Managing battery power section in this chapter.

• Regional Settings—The Regional Settings control panel allows you to
set the format for time, date, numbers, and currency based on your
geographic region. Choose from preset schemes or set individual options.

• Remove Programs—The Remove Programs control panel is the best way
to delete or uninstall programs you no longer use.

• Stylus—The Stylus control panel enables you recalibrate the stylus or to
set options for double-tap speed and area.

• System—The System control panel displays information about the
hardware and software configuration and enables you to adjust the
allotment of program memory and storage memory.

• Volume & Sounds—The Volume & Sounds control panel allows you to
set the speaker volume and turn on and off the sounds associated with
different system events. You can save your options as a sound scheme,
just as you do on your desktop PC.

• World Clock —The World Clock control panel allows you to set the
system time, set alarms and reminders, and select your Home and Visiting
cities. World Clock also displays almanac information, such as the nearest
airport, sunrise and sunset times, and travel distance between selected
cities.
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To open the World Clock control panel quickly, double-tap the clock in the status area of
the taskbar.

Customizing the HP hot keys and hard icons

The HP hot keys (on the top row of the keyboard) and the HP hard icons
(along the right edge of the screen) give you one-touch access to your
favorite programs. Simply press a hot key or tap a hard icon to open the
corresponding program. Or, use the HP hot key application to assign any
program or file on your HP Jornada to one of the hot keys or hard icons.

Icon Indicates

Open HP settings

Page up

Page down

Switch applications

HP hard icons

To start the HP hot keys application

1. On the Start menu, point to Programs, point to HP Utilities , and
then tap HP hot keys.

When you start the HP hot keys application, the current hot key assignments
are displayed in a list on the Hot keys tab. The default key assignments
correspond to the program icons printed on the HP hot keys.

To assign a program or file to a hot key or hard icon

1. Start the HP hot keys application.

2. On the Hot keys tab or the Hard icons tab, select the key you want
to change.

3. Under Assign to, select a program from the drop-down list.
–or–
Tap Browse to select a program or file that is not displayed.
(Certain files or programs will not run when invoked by a hot
key or hard icon.)
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To see which programs are currently assigned to the HP hard icons, tap and hold any
hard icon. A pop-up window shows the current hard icon assignments.

To quickly restore the default hot keys or hard icons, which correspond to
the icons printed on the keys or the screen, tap Restore defaults on the Hot
keys tab or the Hard icons tab.

Using the HP settings application

The HP settings application allows you to change or adjust display and
sound settings and allows you to check the status of constantly changing
information about your HP Jornada at a glance, such as available memory and
battery power. It also enables you to set the password delay feature for added
security.

To open HP settings

1. On the Start menu, point to Programs, point to HP Utilities , and
then tap Settings.
–or–
Press the HP settings hard icon.

Setting brightness, contrast, and volume

The Settings tab includes slider controls for brightness, contrast, and
volume, and a check box that mutes all system sounds. Move the sliders to
adjust the settings to a comfortable level.
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Tap the speaker icon to switch to the Volume & Sounds control panel.

Changing HP settings profiles

Your HP Jornada has four preset HP settings profiles: My settings, Indoor,
Outdoor, and Power saving. You can launch any profile by selecting it. You
can also adjust any of the settings in any profile to suit your preference.

To change profiles

1. On the Start menu, point to Programs, point to HP Utilities, and
then tap Settings.
–or–
Press the HP settings hard icon.

2. On the Settings tab, select the profile you want to change.

3. Adjust sound, brightness, and contrast sliders to your preference.

4. Tap OK  to exit. Your new settings are saved automatically.

Displaying power and memory information

 The Settings tab also displays the power status of your main battery. The
System tab shows the available PC Card memory, the Program memory, and
the Storage memory.

Security
This section provides some tips to safeguard your HP Jornada—and the
data it holds—from theft or loss.

Adding owner information

If you lose your HP Jornada, owner properties can provide an easy way for
someone to identify you as the rightful owner and return your HP Jornada.
You may have entered your name and address as part of the Windows CE
Welcome Wizard. If you did not, or if you want to update your information
(for example, to include the address of the hotel or office you are visiting),
use the Owner control panel.
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To add or change Owner properties

1. On the Start menu, point to Settings, and tap Control  Panel.

2. Double-tap the Owner icon.

3. On the Identification  tab, type your name, address, and/or phone
number.

4. On the Notes tab, type any other information you want displayed
(for example a temporary address or to offer a reward for the safe
return of your HP Jornada).

To display your owner properties information each time you turn on your HP Jornada,
select the Display Owner Identification check box under At Power On on the
Identification tab.

Password control panel

You can set a password to prevent others from accessing the data on your
HP Jornada. If you enable password protection, you must type your pass-
word each time you turn on your HP Jornada. If you frequently turn your
HP Jornada on and off to avoid draining the batteries, you can use the
Password Delay Timer to set a short interval, so you will not need to retype
your password if you turn on your HP Jornada within the time period that you
specify.

To set a password

1. On the Start menu, point to Settings, and tap Control  Panel.

2. Double-tap the Password icon.

If you have already set a password, you must enter the current
password to open the Password control panel.

3. On the Password Settings tab, type your password.

4. Retype your password in the Confirm Password box.

 5. Under Power-On Protection, select the Enable Password Protection
check box.

If you forget your password, you must perform a full reset, erasing all data you have
stored on your HP Jornada. For more information, see the Resetting section in chapter 8.
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To set the Password Delay Timer

1. On the Start menu, point to HP Utilities, and then tap HP settings.

2. On the Password tab, select either Immediately after suspend or
After suspending for, and then select a time period from the list.

You must set a password before you can set the Password Delay Timer. If you have not set
a password, tap Set Password to switch to the Password control panel.

Traveling with your HP Jornada
The compact size and portability of the HP Jornada make it the perfect
traveling companion. With the synchronization and connectivity solutions of
the HP Jornada, the power of your desktop computer is always at your
fingertips, whether you are working from across town or from across the
country.

Follow the tips in the sections below to make sure your trip goes smoothly.

What to take with you

Be sure to pack everything you need to use your HP Jornada:

• AC adapter and power cable—If you are traveling to a foreign country, be
sure you also obtain an adapter for the plug on your power cable. Or, you
may be able to buy a power cable for the country you are visiting in a
local store or HP distributor.

• Modem card and cable—If you have HP Jornada model 680e or 690e,
you’ll need your PC Card modem to connect to the Internet or dial in to
your office.

• Access numbers—Check with your service provider or network adminis-
trator to find out if they provide local dial-up access. A local number can
save plenty in long-distance charges.

• Sync cable—If you will connect to a desktop PC at your destination, pack
the sync cable. You do not need to take the docking cradle.

• Extra main battery (F1281A)—Carry a spare in case you are stranded or
unable to connect to AC power for a long period of time.

• CompactFlash Card—Protect your data while you travel by backing up to
a CompactFlash Card.
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Before you leave

Before you put your HP Jornada in your briefcase, take a few minutes to
prepare, and your trip will run smoothly.

• Identify your HP Jornada—If you will be traveling for an extended period,
update the owner properties to include your address or contact informa-
tion at your destination.

• Ensure proper modem configuration— The built-in modem (models 680
and 690 only) is designed to meet the regulatory requirements within the
country of purchase only. If you travel to another country, it is recom-
mended that you use a PC Card modem that has been approved for use in
that country to ensure that the regulatory requirements are met. For a list
of approved PC Card modems, go to the HP Jornada accessories page on
the Hewlett-Packard Web site at www.hp.com/jornada.

• Synchronize—Make sure your calendar, contacts, and tasks databases
are up-to-date before you leave. Synchronize all items just before you
back up and disconnect.

• Back up your data—Perform a full backup to your desktop computer and
to a PC Card or CompactFlash Card. Carry the storage card with you—if
your HP Jornada loses power during the trip, you will be back up and
running in no time. For more info, see the Backing up section in chapter 5.

• Charge batteries—Make sure that your main battery is fully charged and
that your backup battery is good. Use the Power control panel to check
battery status, and connect to AC power if the main battery is low or
replace the backup battery if it is low. For more information, see the
Managing battery power section in this chapter.

• Lock the audio buttons to prevent inadvertent activation of the record
function—Slide the audio lock to the left, so the record or playback
functions will not be activated by accident.

• Set your desktop computer to allow dial-in—If you plan to dial in to your
desktop computer or synchronize from your destination, make sure you
prepare your desktop computer accordingly, and that no one will turn it
off while you’re away. For details on setting up your desktop computer
for remote synchronization, see the Synchronizing from a remote
location section in chapter 3.

http://www.hp.com/jornada
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About system macros
The HP Macro utility enables you to automate common tasks using a
powerful scripting language. A system macro is a set of recorded commands
and actions that you can repeat or play back by pressing a specific key
combination.

HP macro includes a list of system values or preprogrammed macros  that
automate common functions. You can use system values as simple macros,
or you can create more complex macros by nesting system values and
entering commands using the HP macro programming language.

For example, you could use the system value put date to insert the current
date into a Pocket Word document, or you could include this system value
in a complex macro that automatically opens a meeting notes template and
inserts the date and time at the top of the page. You could assign either
macro to a hot key (for example, num lk

ctrl shift )  or add it to the HP macro menu.

Starting HP macro

HP macro must be running before you can create, edit, or play a macro. By
default, HP macro starts when you start your HP Jornada. While HP macro is
running, the HP macro icon appears in the status area of the taskbar. If the
HP icon is not displayed, you can start HP macro manually.

To start HP macro

1. On the Start menu, point to HP Utilities, and tap HP macro. The
HP macro icon appears in the status area of the taskbar.

Using HP macro

The HP macro menu gives you access to the macro editing window, as well
as a convenient way to invoke macros you have created. To display the HP
macro menu, tap the HP macro icon in the status area of the taskbar.

• To create or edit a macro, tap Macro Control , and then tap Macro List
on the HP macro menu.

• To play a macro, tap the name of the macro on the HP macro menu.

For complete instructions on creating, editing, and playing macros, includ-
ing the HP macro command reference, refer to the HP macro topic in online
Help.
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Troubleshooting  | 8

If you encounter difficulties while using your HP Jornada 600 Series
Handheld PC, this chapter will help you find answers. If you need
information about troubleshooting Microsoft Windows CE Services,
click Windows CE Services Help Topics on the Help menu in the Mobile
Devices window.

The information in this chapter will help you:

• Maintain your HP Jornada in its best working order

• Troubleshoot basic problems

• Troubleshoot problems with remote connections

• Troubleshoot problems with the display

• Troubleshoot problems connecting by infrared

• Reset your HP Jornada

Maintaining your HP Jornada
When treated properly, your HP Jornada will be a reliable desktop PC
companion. Follow these tips to ensure long and trouble-free use:

Keep the unit clean

Touching the HP Jornada screen with your hand will leave a trace of natural
oil that may make it difficult to read the screen. To clean the screen, use a
commercial glass cleaner sprayed on a soft cloth. Avoid spraying the screen
directly.

Be sure to turn off your HP Jornada before cleaning the touch screen.

Be careful not to get sand and dirt inside the unit. If you think your
HP Jornada has sand or dirt inside the unit case, contact your authorized
Hewlett-Packard dealer.
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Follow general safety precautions

To keep your HP Jornada in good operating condition, follow these guidelines:

• Only open your HP Jornada case as far as the hinges allow.

• Do not use excessive force when inserting or removing CompactFlash
Cards or PC Cards or when opening or closing the expansion module.

• Always keep the sync cable attached while syncing with your partner PC.

• Only use a modem that has been approved for use with your HP Jornada
(Models 680e and 690e only). For a list of approved modems, go to the
Hewlett-Packard Web site at www.hp.com/jornada.

Avoid damage

Be careful to keep your HP Jornada from being dropped, bumped, or crushed.
Dropping or placing something heavy on top of your HP Jornada can cause
damage to delicate components such as the display. Accidental damage is
not covered under the Hewlett-Packard express warranty.

Avoid radiated interference

Radiated interference from other electronic equipment may affect the appear-
ance of the display and the modem function of the HP Jornada. Removing
the HP Jornada from the source of the interference will return the display and
the modem function to normal.

Avoid high temperatures

Your HP Jornada is designed to operate at temperatures between 0 to 40 ºC
(32 to 104 ºF) and to maintain data at temperatures between 0 to 55 ºC (32 to
131 ºF). Subjecting the device to temperatures outside this range may
damage the unit or result in loss of data. Be especially careful not to leave
your HP Jornada in direct sunlight or in a car where temperatures can rise to
harmful levels.

Troubleshooting basic problems
If you have a specific problem, review the information below to see if you
can quickly find the answer. Or, visit the HP Jornada Web site at
www.hp.com/jornada for current information about common difficulties.

http://www.hp.com/jornada
http://www.hp.com/jornada
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Problem Diagnosis/Remedy

HP Jornada does Battery power is too low to run device. Connect to
not turn on when AC power, and then turn on your HP Jornada.
not connected to (Charge the battery regularly to avoid running out
AC power. of battery power.) For information on charging the

main battery and checking battery status, refer to
the Installing the main battery section in chapter 2.

The HP Jornada Remove the main battery and disconnect the AC
does not display adapter, and then reinsert the main battery and
the Welcome screen reconnect to AC power. The unit will now start up
properly when you normally, and the Welcome screen will appear.
install the main
battery or connect
to AC power for the
first time or after
full reset.

Battery runs out of You are using your HP Jornada in ways that drain
power very quickly. the batteries quickly. See the Managing battery

power section in chapter 7.

Backup battery has Backup battery has not been activated. Check that
been installed or the tape has been completely removed from the
replaced recently, backup battery compartment. If necessary, remove
but backup battery the cover from the backup battery compartment,
warning still remove the tape, and reinstall the backup battery.
appears. For more information, see the Replacing the

backup battery section in chapter 7.

HP Jornada does The HP Jornada is designed to stay on while
not auto-suspend connected to a computer. This is the correct
when connected to behavior. No action is needed.
a desktop PC or
when using the
modem.

HP Jornada Main battery is too low to run device. When a
automatically critically low-battery condition is encountered, the
shuts down. HP Jornada initiates a safety shutdown. Connect to

AC power and charge the main battery. Do not
remove the backup battery.

HP Jornada does HP Jornada is locked up. Connect the HP Jornada
not turn on when to external power, and perform a soft reset.
connected to (See the Resetting section in this chapter.
AC power. Caution: You will lose any unsaved data when

performing a soft reset.)
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Problem Diagnosis/Remedy

HP Jornada Program memory is low. For detailed instructions on
locks up. making more program memory available, see the

Memory management section in chapter 7.

HP Jornada locks HP Jornada is locked up. Connect to AC
up when running power and perform a soft reset. (See the
applications. Resetting section in this chapter.)

Note: Check battery power level regularly to ensure
that the main battery is not running low on power.

HP Jornada does The display contrast is too light. Press alt

not turn on or to increase contrast. (For more information,
display appears to see the Using HP Settings section in chapter 2.)
be off, even though
power is on.

HP Jornada runs There is insufficient program memory or the memory
very slowly. needs to be refreshed. For detailed instructions on

making more memory available, see the Memory
management section in chapter 7.

You can add additional memory to your HP Jornada.
See the Accessories section in chapter 7 for a list of
accessories that will increase your HP Jornada
memory.

Insufficient memory HP Jornada has run out of program
error occurs when memory for the application.
running an
application. For detailed instructions on making more

program memory available, see the Memory
management section in chapter 7.

HP Jornada PC Card is not inserted properly or drivers are not
does not installed on your HP Jornada. Remove and re-insert
detect PC Card. the PC Card correctly. If this does not fix the

problem, check the documentation for the PC
Card for information on installing drivers on the
HP Jornada.

(For more information about compatible PC Card
modems, see the HP Jornada Accessories page at
www.hp.com/jornada.)

http://www.hp.com/jornada
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Problem Diagnosis/Remedy

HP Jornada will not The HP Jornada is not properly seated in the docking
establish a cradle, the sync cable is not connected properly to
connection with the PC or the HP Jornada, or communications are
a desktop PC. not configured correctly. Reconnect the cable

correctly or see Windows CE Services Help
for more information.

Serial port does Disconnecting from a dialup connection
not function. established using HP dialup can cause the

serial port to fail. Reset the serial port (see
the procedure in the Remote Connections
section later in this chapter).

Web pages are not If you set up the Web service using HP dialup, the
displayed according options you set in HP dialup determine the way
to the options you Web pages are displayed. Options you change
set in Pocket in Pocket Internet Explorer affect only the current
Internet Explorer. Web session; these changes are not saved.

The HP viewer Contacts, Calendar, and Tasks databases are very
seemsto launch big. Limit the size of your databases by
slowly. synchronizing only selected contacts, appointments,

and tasks. For more information, see the
Synchronizing selected data section in chapter 3.

Pressing the Pocket My Handheld PC or Windows Explorer may be
Internet Explorer open.  Pressing the Pocket Internet Explorer hot
hot key does not key will switch between any open folders (e.g.,

Control Panel, launch the program. My Documents,
or My Handheld PC) and Pocket Internet Explorer.
This is the correct behavior.

HP Jornada will Message header is too big. If your address
not send e-mail list exceeds 32 KB, Inbox cannot send
messages from the message.
Inbox.

Cannot retrieve Older messages are not being retrieved. By default,
e-mail messages, Inbox displays only messages sent in the last
or somee-mail 3 days. Change this setting, or set Inbox to
messages are display all messages. For more information, see
missing. the Inbox settings section in chapter 6.
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Problem Diagnosis/Remedy

File attachments to Sender�s or  recipients� mail server does not
e-mail messages supportMIME encoding.  Turn off MIME encoding.
are corrupted. If you created your e-mail service using HP dialup,

see Creating and modifying connections in chapter
6 for instructions on changing settings for the
e-mail service. If you created your e-mail service in
Inbox, tap Options on the Services menu to modify
properties for the e-mail service.

There is a clicking While your HP Jornada is connected to a
sound heard on the telephone line, it might cause a clicking sound
telephone line. that can be heard through any telephone handset

on the same extension. To eliminate the clicking
sound, disconnect the telephone line from your
HP Jornada. When not in use, always disconnect
your HP Jornada from the telephone line.

While printing There is insufficient program memory or the
multiple files, memory needs to be refreshed. For detailed
printing message instructions on making more memory available,
box does not see the Memory management section in chapter 7.
disappear after
printing the first You can add additional memory to your
file is finished. HP Jornada.  See the Accessories section in

chapter 7 for a list of accessories that will
increase your HP Jornada memory.

Some of the icons There is insufficient program memory or the
from the desktop memory needs to be refreshed. For detailed
disappear. instructions on making more memory available,

see the Memory management section in chapter 7.

You can add additional memory to your
HP Jornada.  See the Accessories section in
chapter 7 for a list of accessories that will
increase your HP Jornada memory.

Troubleshooting remote connections
This section offers troubleshooting help for trying to connect your
HP Jornada to other computers. For problems communicating with your
desktop, see Windows CE Services Help.
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Unable to dial out using the modem

• Verify that the modem is installed correctly (models 680e and 690e only)
and connected to the telephone line.

• If you are using the internal modem (models 680 and 690 only), verify that
you are using an analog telephone line. (Most home telephone lines are
analog, while most office telephone lines are digital.)

• Verify you have set dialing properties for this connection correctly.

• Check to see if the modem is waiting for a dial tone. To do this, on the
Start menu, point to Programs, point to Communication, and then tap
Remote Networking. Select your connection, and then tap Properties on
the File menu. In the Dial-Up Connection dialog box, tap Configure and
then tap the Call Options tab. Verify that Wait for dial tone before dialing
is selected.

• In certain countries you may have to clear the Wait for dial tone before
dialing check box.

• Allow more time for the call to go through if you are attempting to make
an international call. On the Call Options tab described in the previous
step, clear the Cancel the call if not connected within option or increase
the number of seconds allowed.

Able to dial out, but unable to make a proper connection

• Verify that the network you are attempting to connect with supports PPP
(Point-To-Point protocol) or SLIP (Serial Line Internet Protocol).

• Verify that you have the correct dialing location selected. On the Start
menu, point to Settings, tap Control Panel, and then double-tap the
Dialing icon. Make sure that the location settings reflect your current
location, that the dialing pattern for the location is appropriate, and that
the local country and area code are correct.

Connection is unreliable

• Make sure the modem is firmly seated and connected to both your
HP Jornada and the telephone jack.

• Disable call waiting. On the Start menu, point to Settings, tap Control
Panel, and then double-tap the Dialing icon. Select Disable call waiting
by dialing and enter the disable code specified by your telephone
company.
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Network connection is not listed in the ActiveSync dialog
box

• Close the dialog box, wait a few minutes, and try again.

• Reset your HP Jornada. (See the Resetting section in this chapter.)

Infrared transfer between Windows CE�based devices

If you are unable to transfer information between Windows CE–based devices
by infrared, try the following.

• Transfer only one file, or no more than 25 contact cards at a time.

• Position the infrared ports so that they line up and are less than 1 meter
(3 feet) but more than 5 centimeters (2 inches) apart.

• Make sure nothing is blocking the path between the two infrared ports.

• Adjust the room lighting. Some types of lighting interfere with infrared
communication. Try moving to a different location or turning off some
lights.

The HP Jornada cannot send files to or receive files from a Windows CE 1.0 device via
Infrared. Windows CE 1.0 does not support the FastIR file transfer protocol used by your
HP Jornada.

Display
If you are having trouble viewing your data, here are some suggestions.

Screen is blank

If your HP Jornada fails to respond when you briefly press the On/Off button,
be sure you have pressed the button firmly. If that does not work:

• Make sure the main battery is installed properly.

• Adjust the display contrast. On some devices, the screen can darken or
lighten to the point that it appears to be turned off.

• Reset your HP Jornada. (See the Resetting section in this chapter.)

• Recharge the main battery.
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Screen is dark

Prolonged exposure to direct sunlight may cause your HP Jornada screen to
temporarily darken. This is a normal occurrence with LCD screens and is not
permanent.

Resetting
Occasionally, you will need to reset your HP Jornada, for example, after you
restore data from your desktop PC or when the operating system stops
responding. There are two methods of resetting:

• Soft reset—A soft reset (also called “warm boot”) is similar to restarting
your desktop PC. It restarts the operating system and preserves any
saved data.

• Full reset—A full reset (also called “hard reset”) restores your
HP Jornada to its original state, erasing all information you have entered.

To ensure the safety of your information in case a full reset is necessary, you
should regularly back up your data to your desktop PC (using Windows CE
Services) or to a CompactFlash or PC Card (using the HP Jornada backup
application). For more information on backing up data, see the Backing up
and restoring data section in chapter 5.

Soft reset

Perform a soft reset after restoring data from a backup file or when your
HP Jornada appears to be frozen or locked up.

To perform a soft reset

1. Disconnect the sync cable and/or the telephone line from your
HP Jornada.

2. Use the stylus to press the Reset button.

When you perform a soft reset you will lose unsaved data in all open documents or
programs.
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Full reset

Perform a full reset only when your HP Jornada does not respond to a soft
reset. A full reset will erase all data you have entered, including all files,
system settings, and programs you have installed. If you have forgotten
your password, you will also need to perform a full reset.

Performing a full reset erases all files, programs, and appointments you have entered. You
can restore only data that has been backed up to your desktop PC or to a PC Card or
CompactFlash Card. (For more information, see the Backing up and Restoring data
section in chapter 5.)

To perform a full reset

1. Disconnect all cables, including the AC adapter from your
HP Jornada.

2. Remove the main battery.

3. Remove the backup battery. For more information, see the Replacing
the backup battery section in chapter 7.)

4. Wait at least 5 minutes, and then reinstall the batteries and reconnect
the AC adapter. (For more information, see the Setting up your
HP Jornada section in chapter 2.) Your HP Jornada should turn on
automatically and display the Windows CE Welcome Wizard. For
more information about this wizard, see the Completing the Welcome
Wizard  section in chapter 2.

5. Restore data to your HP Jornada from your most recent backup file.
For more information, see the Backing up and Restoring data
section in chapter 5.
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Warranty, support,
and service

Limited one-year warranty
Your HP Jornada H/PC comes with a limited one-year warranty.

What is covered

Your HP Jornada H/PC (except for the coin-cell backup battery, or damage
caused by this battery) and accessories are warranted by Hewlett-Packard
against defects in materials and workmanship for one year from the date of
original purchase. If you sell your unit or give it as a gift, the warranty is
automatically transferred to the new owner and remains in effect for the
original one-year period beginning at the time of purchase. During the
warranty period, we will repair or, at our option, replace at no charge a
product that proves to be defective, provided you return the product,
shipping prepaid, to a Hewlett-Packard service center. (Replacement may be
made with a new or re-conditioned device, or with a newer model of equal or
better functionality.)

This warranty gives you specific legal rights, and you may also have other
rights that vary from state to state, province to province, or country to
country.

What is not covered

Backup battery and damage caused by the battery are not covered by the
Hewlett-Packard warranty. Check with the battery manufacturer about battery
and battery leakage.

This warranty does not apply if the product has been damaged by accident or
misuse, or as the result of service or modification by other than an authorized
Hewlett-Packard service center.
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No other express warranty is given. The repair or replacement of a product is
your exclusive remedy. ANY OTHER IMPLIED WARRANTY OR MER-
CHANTABILITY OR FITNESS IS LIMITED TO THE ONE-YEAR DURATION
OF THIS WRITTEN WARRANTY. Some states, provinces, or countries do
not allow limitations on how long an implied warranty lasts, so the above
limitation may not apply to you. IN NO EVENT SHALL HEWLETT-PACK-
ARD COMPANY BE LIABLE FOR CONSEQUENTIAL DAMAGES. Some
states, provinces, or countries do not allow the exclusion or limitation of
incidental or consequential damages, so the above limitation or exclusion
may not apply to you.

Products are sold on the basis of specifications applicable at the time of
manufacture. Hewlett-Packard shall have no obligation to modify or update
products, once sold.

Consumer transactions in Australia,
New Zealand, and the United Kingdom
The preceding disclaimers and limitations shall not apply to consumer
transactions in Australia, New Zealand and the United Kingdom, and shall
not affect the statutory rights of consumers.

For consumers in Australia

The above warranty terms and any other warranty statement enclosed with
this product, except to the extent lawfully permitted, do not exclude, restrict,
or modify and are in addition to the statutory rights implied by the Trade
Practices Act of 1974 or any corresponding State or territory legislation
applicable to the sale of this product to you. If you have any queries about
your rights, contact the Hewlett-Packard Customer Care Center at
61-3-88778000.

For consumers in New Zealand

The above warranty terms or any other warranty statement enclosed with this
product, except to the extent lawfully permitted, do not exclude, restrict, or
modify and are in addition to the statutory rights implied by the Consumer
Guarantees Act of 1993 applicable to the sale of this product to you. If you
have any queries about your rights contact the Hewlett-Packard End User
Support line at 0800-733547.
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Year 2000 warranty
Subject to all of the terms and limitations of the HP Limited Warranty Statement
provided with this HP product, HP warrants that this HP product will be able to
accurately process date data (including, but not limited to, calculating, compar-
ing, and sequencing) from, into, and between the twentieth and twenty-first
centuries, and the year 1999 and 2000, including leap year calculations, when
used in accordance with the Product documentation provided by HP (including
any instructions for installing patches or upgrades), provided that all other
products (e.g. hardware, software, firmware) used in combination with such HP
product(s) properly exchange date data. The duration of the Year 2000 warranty
extends through January 31, 2001.

HP makes no representation or warranty respecting the accuracy or reliability
of information about non–HP products. Such information is provided by the
manufacturers of those products, and customers are urged to contact the
manufacturer directly to verify Year 2000 readiness.

Customer support
If you have questions that this User Guide does not answer (after checking the
contents and index), you can contact Hewlett-Packard Worldwide Support and
Services for Handheld Products at the telephone numbers listed in the follow-
ing table. If your HP Jornada requires service, contact Hewlett-Packard for
service information, shipping instructions, and out-of-warranty service charges
before you send your unit to HP for repair. In countries not listed in the table,
contact your Hewlett-Packard authorized dealer or sales office.

Service

For diagnostic instructions and other service information, contact one of the
technical support numbers listed. Please do not ship your unit for service
without first contacting a Hewlett-Packard office. If your unit qualifies for in-
warranty service, be ready to supply a dated proof of purchase.

In countries not listed in the following table, contact your Hewlett-Packard
authorized dealer or sales office.

Before you contact us for help, be sure to:

1. Review the manuals whenever possible.
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2. Have the following information about the product:
• Model number
• Serial number
• Purchase date

3. Have your product ready to use. The support personnel may ask
you to run tests and other operations.

4. Organize your question or problem. The more detailed information
you can provide, the quicker the support personnel can help you.

Web site

You can also obtain product information as well as tips and hints on how to
get more from your handheld product at our worldwide Web site. This
computer service is provided free of charge; you pay only for telephone
charges and Internet service fees. To connect to this Web site from a com-
puter via the Internet, go to www.hp.com/jornada.

Contacting Hewlett-Packard worldwide
You will be pleased to know that our commitment to quality does not stop at

personal telephone service should you need it.

Argentina 54-11-47788380

Australia 61-3-88778000

Austria 43-711-4201080

Belgium (Dutch) 32-2-6268806

Belgium (French) 32-2-6268807

Brazil 55-11-8296612

Canada 1-905-2064663

Chile 56-800-360999

China 86-10-65645959

Czech Republic 420-2-61307310

Denmark 45-39-294099

Country/Region Telephone

the sale. Our worldwide customer support network is available to give you

http://www.hp.com/jornada
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Finland 358-20347288

France 33-1-43623434

Germany 49-1-805258143

Greece 30-1-6896411

Hong Kong 800-967729

Hungary 36-1-3430310

India 91-11-6826035

Indonesia 62-21-3503408

Ireland 353-1-6625525

Israel 972-9-9524848

Italy 39-2-26410350

Japan 81-3-33358333

Korea 82-2-32700700

Malaysia 60-03-2952566

Mexico 52-1800-4726684

Netherlands 31-20-6068751

New Zealand 64-9-3566640

Norway 47-22-116299

Philippines 63-2-8673551

Poland 48-22-8659999

Portugal 351-1-3180065

Russia 7-095-9169821

Singapore 65-2725300

South Africa 27-11-8061030

Spain 34-91-7820109

Sweden 46-8-6192170

Switzerland (German) 41-1-4332728

Switzerland (French) 41-1-4332729

Country/Region Telephone
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Taiwan 886-2-27170055

Thailand 66-2-6614000

Turkey 90-212-2245925

UK 44-870-6083003

USA
Pre-sales Information 1-800-443-1254

(toll-free, no operator is available)
Support & Service 1-970-635-1000

Palmtops & Organizers (toll call)

Venezuela 58-800-47888 or
58-2-2078488

Vietnam 84-0-8823-4530

All Customer Care Centers are available during office hours. Pre-sales
Information in the USA is available 24 hours per day, 7 days per week.
Support & Service in the USA can be contacted from 5 am to 5 pm Pacific
Time, Monday through Friday.

Country/Region Telephone
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Appendix A
Ergonomics

This chapter provides guidance and hints to help you work in a comfortable
and ergonomically low-risk environment. If you experience pain or discomfort
while using this or any other equipment, you should stop working and
review this chapter. If the discomfort continues, stop using the equipment
and consult a doctor as soon as possible.

Setting up and using equipment
Some people experience physical discomfort while using computers. Some-
times this discomfort leads to Repetitive Strain Injury (RSI), also known as
cumulative trauma disorder or repetitive motion injury. Setting up and using
equipment properly can help minimize this discomfort. Well-designed and
properly adjusted equipment may not be sufficient to eliminate all potential
problems. How you perform your computer activities is also important.

What is RSI?
RSI is a type of injury caused by the irritation or inflammation of soft tissues
such as muscles, nerves, or tendons. In extreme cases, this irritation can lead
to permanent tissue damage. RSI has been a documented problem for
workers performing specific tasks such as assembly line work, meatpacking,
sewing, playing musical instruments, and working with a computer. It may
also result from other activities, such as tennis.

What causes RSI?
RSI is caused by certain demanding activities that exceed the body’s ability.
Common factors associated with RSI include too many uninterrupted
repetitions of an activity or motion, performing an activity in an awkward or
unnatural posture, maintaining static posture for prolonged periods, failing
to take frequent short breaks, and stress. Certain medical conditions, such as
rheumatoid arthritis and diabetes, may contribute to RSI.
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RSI symptoms
By following the guidelines on proper setup and use of equipment and work
environment, the risk of developing RSI can be minimized. However, if you
experience any discomfort, seek professional advice immediately. Typically,
the earlier a problem is diagnosed and treated, the easier it may be to resolve.

Avoiding RSI
Recent literature suggests that there may be a relationship between injury to
soft tissues, especially in the hands and arms, and the prolonged use of
keyboards or other equipment requiring repeated motion of the hands and
forearms. Literature also suggests that there are many other risk factors that
may increase the chances of such soft-tissue injury. You can minimize the
risk of suffering from RSI by following the guidelines detailed in this chapter.

Setting up your working environment
You must have enough space to move around and vary your position. To
avoid eye strain, the ceiling, walls, and floors should have a medium level of
reflectance (approximately 75 percent of ceiling reflectance, 40 percent of wall
reflectance, and 30 percent of floor reflectance). Try to avoid excessive
contrast between the screen and its surroundings. The work environment
should be as quiet and distraction-free as possible, with background noise
below 58 dBA. Where possible, relative air humidity should be in the range
of 40 to 60 percent. Recommended room temperature is 19 to 23 ºC (66 to
73 ºF). If possible, adjust the temperature to a comfortable level. The work-
place should be well ventilated.

Pay attention to your posture; relax your shoulders and keep your wrists
straight. This is easier when your keyboard can be positioned right under
your hands while bending your elbows at 90º. Pull your chin in to look down,
and try to lean back in the chair. The backrest should support you in the
hollow of your back.

Reducing eye strain
Have your eyes checked on a regular basis and ensure your eyeglass
prescription is suitable for working on a computer screen. Look away from
the screen from time to time. Focus on distant objects briefly. Blinking
periodically helps to lubricate the eyes.
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Preventing muscle stiffness
Avoid holding your muscles tense for long periods of time. Keep your
fingers and body relaxed. Changing tasks frequently helps prevent muscle
stiffness. Alternating between typing, writing, filing, and moving around in
your work environment helps to keep muscles loose.

Taking frequent short breaks
When you are required to work on your computer for prolonged periods of
time, take short breaks frequently. As a general rule, a 5- and 10-minute break
every hour is a good idea. It is better to take short breaks frequently than
longer breaks less frequently. Data shows that people who work for long
periods of time without a break are more prone to injury. Occasionally stretch
the muscles in your hands, arms, shoulders, neck, and back. You should
stretch at least once an hour.
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Glossary

AC adapter  A connector that provides external power (not battery power) to
your HP Jornada. For information about installing and using the AC
adapter, see the Setting up your HP Jornada section in chapter 2.

ActiveSync  A feature of Windows CE Services that manages data synchroni-
zation between your HP Jornada and desktop PC. You can specify the type
of data you want to synchronize.

backup file  A duplicate copy of your HP Jornada files and data that is stored
on your desktop PC or on a PC Card. This file does not include your
HP Jornada settings and information stored in ROM, such as factory-
installed software. Use your backup file to restore your HP Jornada to its
previous state if your device data is damaged or destroyed or if you have
performed a full reset.

cache  A special high-speed storage mechanism that saves temporary copies
of Web pages and other file types as you view them. Your computer can
quickly display Web pages you have recently visited, because Pocket
Internet Explorer can open them from cache instead of having to load them
again from the Web. Increasing the space designated for your cache folder
increases how quickly recently visited files are displayed, but decreases
the amount of space available for other files on your HP Jornada. You can
choose to empty your cache upon exiting Pocket Internet Explorer. This
saves space on your device.

cookies  A packet of messages a Web server passes to your Web browser.
When you enter a Web site that uses cookies, you may be asked to fill out
a form with information such as your name and interests. This information
is passed to your Pocket Internet Explorer browser as a cookie (in the form
of a text file called cookie.txt). The next time you visit that Web site, your
Pocket Internet Explorer will pass the cookie back to the Web server, and
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the server will use this information to present you, for instance, with custom
Web pages filled with information of interest to you. For example, instead of
being presented with a generic welcome page, you might receive a welcome
page with your name on it.

dial-up connection  A connection between your HP Jornada and another
computer by modem. You can have a dial-up connection with an ISP, a
network, or with a modem attached to a PC.

direct connection  A connection between your HP Jornada and another
computer by means of the sync cable or IR port.

docking cradle  Place your HP Jornada in the docking cradle for instant
connectivity with your PC partner. Once you have seated your HP Jornada
into the docking cradle you can sync with your PC partner, transfer docu-
ments, and send e-mail.

DNS (Domain Name System)  An Internet service that translates domain
names into IP addresses. For example, the domain name www.jornada.com
might translate as 198.125.247.4.

expansion module  An expandable slot located on the bottom of your
HP Jornada that allows use of both PC Card and CompactFlash Card
accessories in a compact, portable package. (For more information on the
accordion module, see the Using PC Cards and CompactFlash Cards
section in chapter 7.)

full reset  A process that returns your HP Jornada to its original state by
removing all power, thereby erasing all files and data you have saved. For
more information, see the Resetting section in chapter 8. (Also called
“hard reset.”)

hard icons The icons located along the right side of your touch screen are hard
icons. Tap these icons to scroll up or down, open the HP settings applica-
tion, show or hide the task bar, and switch between open applications.

Internet service provider (ISP)  A company that provides access to the
Internet.

IP (Internet Protocol)  specifies the format of packets, also called datagrams,
and the addressing scheme of the Web. Much like a postal system, IP
allows you to address a package and drop it into the system, but your
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package is not delivered instantly to your recipient. The packets are simply
delivered to a server until the recipient downloads them by logging onto the
ISP server.

LAN (Local area network)  A group of computers, usually in close proximity
(either in the same building or in buildings in close proximity), that are
linked together to share files and exchange data.

MIME (Multipurpose Internet Mail Extensions )  A standard that allows binary
data (such as graphics or documents) to be transmitted over the Internet
without first being translated into ASCII text. Many e-mail programs use
MIME to allow files to be sent or received as attachments to e-mail mes-
sages.

NIC  (Network interface card)  A card that is installed in a computer so that it
can be connected to a network. Network interface cards can provide a
dedicated, full-time connection to a network.

ODBC (Open DataBase Connectivity)  A standard database access method.
The goal of ODBC is to make it possible to access any data from any
application, regardless of which database management system is handling
the data.

partnership  An established relationship between your HP Jornada and your
PC for the purpose of synchronizing and transferring data. Your HP Jornada
can have partnerships with up to two desktop computers.

PCT (Private Communication Technology)  A protocol that maintains the
security and integrity of Internet communications by using encryption,
authentication, and message-authentication codes. The protocol is applica-
tion independent, and is used by Web browsers and e-mail clients to send
data via the Internet. PCT is able to negotiate encryption keys as well as
authenticate a server before data is exchanged by the higher level application.

POP (Post Office Protocol)  The first protocol used to retrieve e-mail from a
mail server. Most e-mail applications (sometimes called e-mail clients) use
the POP protocol, although some may use the newer IMAP (Internet
Message Access Protocol).

PPP (Point-to-Point Protocol)  The default method your HP Jornada uses to
communicate with the ISP network server.
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RAS (Remote Access Service) account   A network account that enables your
HP Jornada to access your Windows NT network remotely.

remote connection   A connection between your HP Jornada and a remote
computer or server.

reset  A process that either causes your HP Jornada to restart (soft reset) or
causes all data stored in RAM to be erased (full reset). For more informa-
tion, see the Resetting section in chapter 8.

restore  A process that returns your device to the state it was in when last
backed up. This involves copying your backup data to your HP Jornada.

SLIP (Serial Line Internet Protocol)  An older and simpler protocol than PPP.
Connecting to the Internet via SLIP is very similar to connecting via PPP.

soft reset  The process of restarting your HP Jornada and reinitializing the
Windows CE operating system. Performing a soft reset will erase any
unsaved data in open documents, but will preserve data that has been
saved. (Also called “warm boot.”)

stylus  A pen-like utensil designed for navigating on a touch screen.

touch screen  A touch-sensitive screen that allows you to open files, launch
programs, and select text by touching or tapping the screen with the
stylus.
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Symbols
*.dbb file  69
*.dbe file  69
*.exe file type  103
.2bp files  105
.bmp files  105
.doc file  96
.fon files  105
.pwd file  96
.rtf file  96
.ttf files  105
.txt file  96
.wav files  105
56K V.90 modem  75
9-pin serial port  29

A
AC adapter  29, 30, 147

connecting  14
traveling with  123

AC power cable  14
AC power outlet  15
Access numbers  123
Accessing

computer not on network  41
corporate networks  41

Accessories  106
ActiveSync options  32, 38, 39
ActiveSync Options dialog box  38, 39
ActiveSync, overview  7
Adding or removing programs  104
Addresses, managing. See Contacts
Alarms, setting  105

Application Manager  104
Appointment Book Translation Note

screen  46
Appointment data, translating  46
Appointment notification LED  10
Asterisk .dbe file  69
Asterisk .exe file  103
Asterisk.dbb file  69
Attachments

MIME encoding  96
saving on storage cards  96

Audio buttons
described  10
locking  124

Audio speaker, described  12
Audio, voice memos  58
Auto Connect option  41
Auto Disconnect  85
Auto run feature  109
Auto run file, creating  110
Auto suspend failure  129
Auto-suspend, setting  115
AutoDial  85
AutoDial tab  98
AutoDisconnect  78
Autorun.inf file  109, 110

B
Background tab  106
Backing up and restoring data

68, 69, 150
Backup battery compartment, descrip-

tion  12
Backup battery warning, troubleshooting

129

Index
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Backup file  147
Battery

backup  15, 113
installing main  13
main  112

Battery charging LED, described  10
Battery drain, troubleshooting  129
Battery power

auto-suspend  115
conserving  115
managing  112
status  114

Battery, replacing main  113
Baud rate, checking  32
Benefits, overview  4
bFax Pro  70

bView  70
described  7
starting  70

bFind  71
described  8
starting  71

bFind dialog box  71
Bitmap images (.bmp files)  105
bmp files  105
Breakage  128
Brightness and contrast, adjusting  16
Browsing

on HP Jornada desktop  36
the Web  97

C
Cables

HP parallel printer  67
sync  29, 30
telephone  30

Caching  85, 147
Calculator, described  8
Calendar

creating appointments  50
organizing appointments  50
overview  6
scheduling meetings  50
viewing  54

Command bars, using  20
Communication, ActiveSync  147
Communications command  32
Communications control panel  117
Communications icon  32

CompactFlash Card
installing  107, 109
overview  106
removing  109
when traveling  123

CompactFlash Type I card slot  11
Configuring

HP Jornada for infrared connection  35
Windows CE Services for infrared

connection  35
Confirm Password box  122
Conflict resolution, default conflict  39
Connecting

AC adapter  14
by serial connection  29
HP Jornada to a PC  25
HP Jornada to alternate PC  35

Connecting to Internet, personal
accounts

modems  74
PPP (Point-to-Point Protocol)

Account  75
SLIP (Serial Line Internet Protocol)

Account  75
Connecting to PC

9-pin serial port  29
with docking cradle  29
without docking cradle  30

Connection profile, creating  79
Connection Status dialog box  32, 34
Connections  148. See connecting

dialup  75, 79
network

creating without HP dialup  91
modifying with HP Dialup  91

partnership
automatic  34
infrared  34
manual  34

Contacts
creating new contacts  52
managing  51
overview  6
viewing  55

Contrast and brightness, adjusting  16
Control panel  32

opening  117
regional settings  118

Cookies  85, 147
Corporate networks, remote access  41
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Cumulative trauma. See Repetitive
Strain Injury (RSI)

Cumulative trauma disorder  143. See
also Repetitive Strain Injury (RSI)

Customizing
general options  117
HP hard icons  119
HP hot keys  119

D
Data

synchronizing general  37
synchronizing selected  38
transferring personal information

(PIM)  44
Data, migrating  44

with non–Windows CE palmtops  45
with older Windows CE palmtop PCs

44
Data, PIM (Personal Information

Management)
translation  46

Data Translation Progress screen  46
Databases, creating  65
DC jack  10, 15, 29, 30
Default conflict  39
Default conflict resolution  39
Desktop, HP Jornada

browsing  36
files, working with  36
opening files  37

Desktop Wallpaper  105
Device connection via network option

41
Dial dialog box  99
Dialing control panel  117
Dialing locations, setting  42
Dialup application, starting  79
Dialup connection  75, 148
Dialup Connection dialog box  42
Dialup connections

modifying  91
multiple  90

Dialup Networking components  41
Dialup options  79
Dimming, automatic, setting  116
Dimming Control, setting  116
Dimming Control tab  116

Display Control Panel  117
Display difficulties  134
Display Owner Identification check box

19
DNS

address  76
address setting  83
server address  88

DNS address  148
doc file  96
Docking cradle  29
Drivers

Proxim 7400 cards  88
Socket LP-E Lan cards  88

E
E-mail

connecting to service provider from
Inbox  95

sending, receiving, processing  94
service, choosing  76

E-mail account, personal
entering information  77

E-mail accounts, corporate
connecting with installed modem  81
no offsite access  88
offsite access  82
setting up  93

E-mail accounts, corporate offsite  81
access  82
connecting with installed modem  82
dialup connections  82
telephone lines  82

E-mail accounts, personal
setting up  77
UserID and password  77

E-mail attachments  96
E-mail connection options, personal  74
E-mail connections, options  73
E-mail messages

deleting  97
retrieval difficulties  131
sending difficulties  131
synchronizing  40
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Editing
changing device name  31
HP hard icons  119
HP hot keys  119
HP Jornada for infrared connection  35
memory locations  111
Windows CE Services for infrared

connection  35
Electrical interference  128
Enable Address Issue dialog box  94
Enable Password Protection check box

122
Ergonomics

equipment  143
eye strain, reducing  144
muscle stiffness, preventing  145
taking breaks from work  145
work environment  144

Ethernet Components  27
Expansion module  107
Eye strain, reducing  144

F
FastIR file transfer protocol  134
FAX

bFAX Pro  70
sending and receiving  70
viewing with bView  70

Features, hardware  10
Field mapping, Phone Book  47
File attachments

MIME encoding  96
saving on storage cards  96

File Conversion Properties dialog box  43
File formats, Microsoft Pocket Word  62
File types

.rtf file  96

.txt file  96
Pocket Word files (.pwd)  96
Word file (.doc)  96

filename.exe  110
Files

accessing on a network  90
arranging on desktop  36
attachments  96
conversion options  43
opening from desktop  37
transferring  43

fon files  105
Fonts, adding  105

TrueType (.ttf files)  105
Windows (.fon files)  105

Full reset  148

G
Guest privileges, network  89

H
Hard reset. See full reset
Help

HP settings  23
using  21

Home and Search pages  78, 85
Home City tab  18
Hot keys tab  119
HP Backup  69
HP Backup control panel  118
HP Backup, overview  7
HP CompactFlash Card  68
HP dialup  85

creating additional connections  91
modifying network connections  91
setting up Inbox service  93

HP Dialup dialog box  81
HP dialup, overview  7
HP Dialup window  80, 86
HP F1228A  68, 123
HP F1233A  106
HP F1227A  106
HP F1252A  106
HP F1274A  106
HP F1275A  106
HP F1281A  112, 123
HP F1282A  106, 112
HP F1284  106
HP F1295A  106
HP hard icons

customizing  119
described  11
restoring default assignment  120



Index  |  155

HP hot keys
customizing  119
described  11
failure  131
overview  8
restoring default assignment  120
starting  119

HP hot keys control panel  118
HP Jornada Backup application  68
HP Jornada for infrared connection,

setting up  35
HP Jornada Viewer

overview  53
starting  53
switching to Pocket Outlook  54

HP Macro
overview  8
starting  125

HP Macro programming language  125
HP parallel printer cable (F1274A)  67
HP PIM Translation Utility  102
HP quick pad  56, 57
HP quick pad, overview  7
HP settings

changing profiles  121
opening  120
overview  120

HP settings, overview  8
HP Viewer

launching difficulties  131
overview  7

I
Identification tab  122
Image Expert CE from Sierra Imaging

102
IMAP4 host  76
IMAP4 Mail  93
IMAP4 protocol  84
Inbox

connecting to ISP (Internet Service
Provider) from  95

managing e-mail  53
sending failure  131
setting up from within Inbox  93
setting up with HP Dialup  93
settings  95
synchronizing e-mail messages  50
using  93

Inbox, overview  6
Information, sources  2
Infrared connection, establishing  35
Infrared port  11, 34, 67
Infrared port (SIR IrDA-compliant

transceiver)  11
Infrared transfer difficulties  134
Infrared-equipped PCL printer  67
Installing

applications  102, 103
Microsoft Pocket Outlook  26
Microsoft Schedule+  26
Microsoft Windows CE Services  28

Interference, electrical  128
Internet connections

corporate account with no offsite access
88

options for personal account  74
options, general  73

Intranet connections  93
IP (Internet Protocol)

address  76
address setting  83

IP (Internet Protocol) address  148
IrDA port option, printing  67
ISP (Internet Service Provider)  148

J
Java for Windows CE from Microsoft

Corporation  102

K
Keyboard

described  11
using  22

Keyboard control panel  22, 117

L
LAN (Local Area Network)  88, 149
Location settings  79
Locking up, troubleshooting  130

M
Macro List  125
Macros

starting HP Macro  125
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Mail General Preferences dialog box  94
Mail Inbox Preferences dialog box  94
Mail Service Definition dialog box  93
Maintenance, HP Jornada  127
Make New Connection dialog box  42
Mapping

additions  48
changes  48
name  47
removal  48

Meetings, reminder options  51
Memory

conserving  111
displaying information  121
insufficient  130
locations, adjusting  111
managing  110
refreshing  111

Memory tab  111
Memos, voice

recording and playing  58
Microphone, described  11
Microsoft Exchange Update, defined  27
Microsoft InkWriter

described  8
creating a document with  67
overview  67

Microsoft Internet Explorer version 4.01
27

Microsoft Pocket Access
creating a database in  65
creating a table in  65
overview  65

Microsoft Pocket Excel
creating a workbook in  65
overview  64
starting  65

Microsoft Pocket Exchange Update  27
Microsoft Pocket Office  5

overview  62
Microsoft Pocket Outlook  6

installing  26
overview  49
starting  50
synchronizing with Outlook  49

Microsoft Pocket PowerPoint
overview  63
starting  63

Microsoft Pocket PowerPoint presenta-
tions  63

Microsoft Pocket Streets, described  27
Microsoft Pocket Word

creating a document in  63
overview  62

Microsoft Schedule+ 7.0a  27
Microsoft Voice Recorder, described  8
Microsoft Windows  CE Services

Help  127
Microsoft Windows 95 Dial-Up

Networking version  27
Microsoft Windows 95 Infrared Drivers

version 2.0  27
Microsoft Windows CE Services

communications trouble  33
overview  27
setting up for infrared connections  35

Microsoft Windows NT Service  Pack 3
27

Migrating data
how to  44
with non-Windows CE palmtops  45
with older Windows CE palmtop PCs

44
MIME formatting (Multipurpose

Internet Mail Extensions)  84
Mobile Channels Viewer, defined  27
Mobile Devices window  37, 103
Modem card and cable  123
Modem list options  42
Modem, setting location  124
Modems

configuring for your country  19
connection difficulties  133
dialing difficulties  133
installing and configuring  75

Monitor, viewing difficulties  134
Muscle stiffness, preventing  145
My Handheld PC folder  107

N
Name mapping  47
Navigation tips, Stylus  16
Network

accessing computer not on network  41
guest privileges  89

Network (LAN) connection  88
Network Configuration dialog box  89
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Network connections
accessing corporate accounts  41
choosing e-mail or Web service  83
creating with HP dialup  91
creating without HP dialup  91
ISP (Internet Service Provider)  83
modifying with HP dialup  91
onsite logon  89
remote locations  83
service providers  83
setting up  83
settings  84

Network control panel  118
Network interface card (NIC)  88
New Mobile Device dialog box  31
New Partnership Wizard  31
NIC (Network interface card)  149

configuring  89
No converter selected dialog box  103
Notes tab  122

O
Office documents, printing  66
OmniSolve from Landware

described  8
overview  69
starting  70

Open File dialog box  46
Open Presentation dialog box  64
Options dialog box  98
Owner control panel  118
Owner properties, altering  122

P
Part numbers

HP F1228A  68, 123
HP F1233A  106
HP F1252A  106
HP F1274A  106
HP F1275A  106
HP F1281A  112, 123
HP F1282A  106, 112
HP F1284  106
HP F1295A  106
HPF1248A  106

Partnership between PC and HP Jornada
149

automatic connections  34
future connections  33
manual connections  34
overview  31
troubleshooting  32
using New Partnership Wizard  31

Password control panel  118, 122
Password delay timer, setting  123
Password, setting  122
Password settings tab  122
Password tab  123
PC card  68

installing  107, 108
overview  106
removing  108

PC card adapters, recommended  107
PC card detection

difficulties with  130
PC Card release tab  12
PC Card Type II card slot  12
PC Connection

difficulties with  131
PC Link, described  7
PCT (Private Communication Technol-

ogy)  149
Performance, fine-tuning  117
Personal Information (PIM), transferring

44
Phone Book

field mapping  47
translating  47

PIM (Personal Information Manage-
ment)

data translation  46
Pocket Access, overview  6
Pocket Excel, overview  6
Pocket Internet Explorer  6. See also

Microsoft Pocket Internet Explorer
browsing the Web  97
connection  98
setting up AutoDial  98

Pocket PowerPoint, overview  6
Pocket Word, overview  5
POP3  149
POP3 Mail  93
POP3 mailbox  100
POP3 protocol  84



158  |  HP Jornada 600 Series User’s Guide

Ports
9-pin serial  29
infrared  34

Power
displaying information about  121
troubleshooting  128
turning off and on  21

Power control panel  21, 118
description  118
opening  114
overview  114

Power Off tab  115
Power on options, setting  116
PPP (Point-To-Point protocol)  133
PPP (Point-to-Point Protocol)

75, 84, 149
Printing

IrDA port option  67
Microsoft Pocket Office documents  66
via infrared  67

Programs
available from HP Web site  103
installing  102
on HP Jornada CD  102

Programs, adding or removing  104
Programs, additional  28
Programs from HP Jornada CD

minimum system requirements  102
Proxim 7400 card  88
Proxy server  78, 85
pwd.file  96

Q
Quick pad, HP  56

R
Radiation  128
Recording LED, description  10
Recording, voice memos  58
Recycle Bin, options  111
Regional Settings control panel

description  118
Reinstating or removing applications

104
Reminder options (meetings and tasks)

51

Remote Access Services (RAS)  150
Remote connections

creating  42
dialing location set up  42
overview  150

Remote locations
synchronizing from  40

Remote Networking, described  7
Remote Networking folder  42
Remove command  104
Remove Programs control panel  118
Repetitive motion injury  143. See also

Repetitive Strain Injury (RSI)
Repetitive Strain Injury (RSI)  143

avoiding  144
cause  143
defined  143
symptoms  144

Reset button, described  11
Resetting  135

full  135, 148
soft  135, 150

Resolve Conflicts dialog box  39
Restore  69
Restore function  36
Restore PIM databases  69
Restoring data  68, 69, 150
Retrieving data  71
Rich Ink technology  67
rtf file  96

S
Safety precautions  128
Schedule+ version 7.0a, installing  26
Screen, viewing difficulties  134
Security  121
Security cable slot, described  12
Security settings  85
Select Primary Key dialog box  56
Send using MIME format check box  96
Serial Port (RS-232C)  12
Setting Alarms  105
Settings tab  115, 120, 121
Settings, using  22
Short cuts, quick pad  56
Shutting down, troubleshooting  129
SIR IrDA–compliant transceiver. See

Infrared port, description
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Slide presentations
creating with Microsoft Pocket

PowerPoint  63
showing on VGA-compatible monitors

64
SLIP (Serial Line Internet Protocol)

75, 133
SLIP (Serial Line Internet Protocol)

account  84
SMTP  84
SMTP host  76
Socket LP-E LAN card  88
Software drivers, installing  106
Sound

adding  105
adjusting  117

Stabilizer  11
Start menu, using  20
Stylus and Stylus slot  10
Stylus control panel  118

adjusting tap rates and distance  17
described  118

Stylus navigation tips  16
Suspend  116
SVGA 256-color  28
Sync cable  29, 30, 123
Synchronization  26

reducing data and time  38
Resolve Conflicts dialog box  39
resolving conflicts  39
with ActiveSync  26

Synchronize command  31
Synchronizing

data  37
e-mail messages  38, 40
files  38
from a remote location  40
Microsoft Pocket Outlook data  38
selected data  38

System control panel  118
System tab  121
System values  125

T
Tables, creating  65
Taskbar, using  20

Tasks
creating new tasks  53
overview  6, 52
viewing  56

Telephone cable  30
Telephone connector (RJ-11)  10
Telephone connector (RJ-11), descrip-

tion  10
Telephone lines

access  75
clicking sounds on line  132
connecting for corporate accounts  86
connecting to modems  80

Temperature moderation  128
Terminal  7
ToolTips, using  21
Touch screen

calibrating  17
troubleshooting diminished tap accuracy

17
Transferring data

difficulties  134
Personal Information (PIM)  44

Transferring files  43
Translating

appointment data  46
phone book  47

Traveling with HP Jornada  123
ttf files  105
TTY terminal emulation  7
txt file  96

U
Unicode Text Document  110
Use Server-assigned IP Address check

box  42
Using the HP settings application  23

V
VGA-compatible monitor  64
Viewing

Calendar information  54
Calendar, Tasks, and Contacts  54
Contacts information  55
difficulties  134
Tasks  56
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Viewing Pocket Outlook
information. See HP Jornada
Viewer

Voice memos  58
playing without opening HP Jornada  59
recording and playing within Voice

Recorder  59
recording without opening HP Jornada

58
Voice Recorder, voice  memos  59
Volume & Sound control panel  118, 121

W
Waiting for mobile device to disconnect

message  41
Warm boot. See soft reset
wav files  105
Wave sounds (.wav files)  105
Web, browsing  97
Web service, choosing  76
Web service, corporate accounts

connecting to  87
disconnecting from  88

Web service information, inputting
78, 85, 86

Web service information, personal
account  79

Web sites
additional applications  28
incorrect display  131

Welcome Wizard  16
WestTek JetCet color printing utilities

102
Windows  95

Dial-Up Networking version 1.2
upgrade  27

Windows 95
infrared drivers version 2.0  27

Windows CE
address bar  90
Application Manager  104
bitmaps (.2bp files)  105

Windows CE based devices
infrared transferring difficulties  134

Windows CE Services
about  27
backing up and restoring on PC  68
Communications Troubleshooter  33
installing  28
Properties dialog box  32, 41
setting up  26
Setup Wizard

about  26
Inbox extensions, adding  26
requirements  28
transferring messages  26

Windows Explorer, overview  6
Windows folder  105
Windows NT Service Pack 3  27
WINS address setting  83
WINS server address  88
Workbooks, creating  65
World Clock

control panel  118
described  8
setting  18



License agreement  |  161

Important: Please carefully read this License Agreement before operating the
equipment. Rights to the software are offered only on the condition that the
Customer agrees to all terms and conditions of the License Agreement.
Operating the equipment indicates your acceptance of these terms and
conditions. If you do not agree to the License Agreement, you may return the
unopened package for a full refund. In return for payment of the applicable
fee, HP grants the Customer a license to the software, until terminated, subject
to the following:

Use:

• Customer may use the software on any one computer.

• Customer may not reverse, assemble, or decompile the software.

Copies and adaptations:

• Customer may make copies or adaptations of the software:
- for archival purposes, or

- when copying or adaptation is an essential step in the use of the
software with a computer so long as the copies and adaptations are
used in no other manner.

• Customer has no other rights to copy unless Customer acquires an
appropriate license to reproduce which is available from HP for some
software.

• Customer agrees that no warranty, free installation, or free training is
provided by HP for any copies or adaptations made by Customer.

• All copies and adaptations of the software must bear the copyright
notice(s) contained in or on the original.

Ownership:

• Customer agrees that they do not have any title or ownership of the
software, other than ownership of the physical media.

HP software product
license agreement
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• Customer acknowledges and agrees that the software is copyrighted and
protected under the copyright laws.

• Customer acknowledges and agrees that the software may have been
developed by a third-party software supplier named in the copyright
notice(s) included with the software, who shall be authorized to hold the
Customer responsible for any copyright infringement or violation of this
License Agreement.

Transfer of rights in software:

• Customer may transfer rights to the software to a third party only as part of
the transfer of all their rights and only if Customer obtains the prior
agreement of the third party to be bound by the terms of this License
Agreement.

• Upon such a transfer, Customer agrees that their rights to the software are
terminated and that they will either destroy their copies and adaptations or
deliver them to the third party.

• Transfer to a U.S. government department or agency or to a prime or lower
tier contractor in connection with a U.S. government contract shall be
made only upon prior written agreement to terms required by HP.

Sublicensing and distribution: Customer may not sublicense the software or
distribute copies or adaptations of the software to the public in physical
media or by telecommunication without the prior written consent of HP.

Termination:  HP may terminate this software license for failure to comply with
any of these terms, provided HP has requested Customer to cure the failure
and Customer has failed to do so within thirty (30) days of such notice.

Updates and upgrades: Customer agrees that the software does not include
updates and upgrades that may be available from HP under a separate
support agreement.

Export clause: Customer agrees not to export or re-export the software or any
copy or adaptation in violation of the U.S. Export Administration regulations
or other applicable regulations.

HP shrink-wrap license terms

The following License Terms govern your use of the accompanying Software
unless you have a separate signed agreement with HP.

License grant: HP grants you a license to use one copy of the Software.
“Use” means storing, loading, installing, executing or displaying the Software.
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You may not modify the Software or disable any licensing or control features
of the Software. If the Software is licensed for “concurrent use”, you may not
allow more than the maximum number of authorized users to use the software
concurrently.

Ownership: The Software is owned and copyrighted by HP or its third party
suppliers. Your license confers no title to, or ownership in, the Software and is
not a sale of any rights in the Software. Third party suppliers to HP may
protect their rights in the event of any violation of these License Terms.

Copies and adaptations: You may only make copies or adaptations of the
Software for archival purposes or when copying or adaptation is an essential
step in the authorized Use of the Software. You must reproduce all copyright
notices in the original Software on all copies or adaptations. You may not
copy the Software onto any public network.

No disassembly or decryption: You may not disassemble or decompile the
Software unless prior written consent is obtained from HP. In some jurisdic-
tions, consent from HP may not be required for limited disassembly or
decompilation. Upon request, you will provide HP with reasonably detailed
information regarding any disassembly or decompilation. You may not
decrypt the Software unless decryption is a necessary part of the operation of
the Software.

Transfer: Your license will automatically terminate upon any transfer of the
Software. Upon transfer, you must deliver the Software, including any copies
and related documentation, to the transferee. The transferee must accept
these License Terms as a condition to the transfer.

Termination:  HP may terminate your license upon notice for failure to comply
with any of these License Terms. Upon termination, you must immediately
destroy the Software, together with all copies, adaptations, and merged
portions in any form.

Export requirements: You may not export or re-export the Software or any
copy or adaptation in violation of any applicable laws or regulations.

U.S. government restricted rights: The Software and Documentation have
been developed entirely at private expense. They are delivered and licensed
as “commercial computer software” as defined in DFARS 252.227-7013
(Oct 1988), DFARS 252.211-7015 (May 1991) or DFARS 252.227- 7014 (Jun
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1995), as “commercial item” as defined in FAR 2.101 (a), or as “Restricted
computer software” as defined in FAR 52.227-19 (Jun 1987) (or any equivalent
agency regulation or contract clause), whichever is applicable. You have only
those rights provided for such Software and Documentation by the applicable
FAR or DFARS clause or the HP standard software agreement for the product
involved.
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